Kentico CMS 6.0 Controls
# Table of Contents

**Kentico CMS Controls**

- Overview ......................................................... 8
- Configuring your project for Kentico CMS Controls ......................................................... 8
- Using ASPX page templates .......................................................... 10
- Transformations .................................................................................. 12
- Controls hierarchy .................................................................................. 15

**Generic Controls** .................................................................................. 16

- Overview .......................................................................................... 16
- UniView .......................................................................................... 17
  - Overview .................................................................................. 17
  - Getting started ........................................................................... 17
  - Configuration ............................................................................. 21
  - Appearance and styling .............................................................. 22
- Paging controls .................................................................................. 23
  - Overview .................................................................................. 23
  - Paging controls - common properties ........................................... 23
  - DataPager .................................................................................. 24
    - Overview .................................................................................. 24
    - Getting started ........................................................................ 24
    - Configuration ........................................................................... 25
    - Appearance and styling .......................................................... 27
  - TemplateDataPager ..................................................................... 28
    - Overview .................................................................................. 28
    - Getting started ........................................................................ 28
    - Configuration ........................................................................... 31
    - Appearance and styling .......................................................... 31
  - UniPager .................................................................................. 32
    - Overview .................................................................................. 32
    - Getting started ........................................................................ 33
    - Configuration ........................................................................... 35
    - Structure ................................................................................ 36
    - Appearance and styling .......................................................... 38
    - Implementing the IUniPageable interface .................................. 39
- Basic Controls .................................................................................. 42
  - Overview .................................................................................. 42
  - Navigation ................................................................................ 42
    - Overview .................................................................................. 42
    - BasicTabControl ..................................................................... 42
      - Overview ................................................................................ 42
      - Getting started ....................................................................... 43
      - Configuration ......................................................................... 45
      - Appearance and styling .......................................................... 46
- Listings and viewers ........................................................................ 46
  - Overview .................................................................................. 46
  - BasicCalendar ........................................................................ 47
<table>
<thead>
<tr>
<th>CMS Controls</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>65</td>
</tr>
<tr>
<td>Path specification in controls and web parts</td>
<td>65</td>
</tr>
<tr>
<td>Caching</td>
<td>66</td>
</tr>
<tr>
<td>CMS controls - common properties</td>
<td>69</td>
</tr>
<tr>
<td>Navigation</td>
<td>72</td>
</tr>
<tr>
<td>Overview</td>
<td>72</td>
</tr>
<tr>
<td>Document menu settings</td>
<td>72</td>
</tr>
<tr>
<td>Using the CSSPrefix property</td>
<td>75</td>
</tr>
<tr>
<td>CMS navigation - common properties</td>
<td>76</td>
</tr>
<tr>
<td>CMSSiteMap</td>
<td>91</td>
</tr>
<tr>
<td>Overview</td>
<td>91</td>
</tr>
<tr>
<td>BasicDataGrid</td>
<td>50</td>
</tr>
<tr>
<td>Overview</td>
<td>50</td>
</tr>
<tr>
<td>Getting started</td>
<td>50</td>
</tr>
<tr>
<td>Configuration</td>
<td>52</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>53</td>
</tr>
<tr>
<td>BasicDataList</td>
<td>53</td>
</tr>
<tr>
<td>Overview</td>
<td>53</td>
</tr>
<tr>
<td>Getting started</td>
<td>53</td>
</tr>
<tr>
<td>Configuration</td>
<td>56</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>57</td>
</tr>
<tr>
<td>BasicRepeater</td>
<td>57</td>
</tr>
<tr>
<td>Overview</td>
<td>57</td>
</tr>
<tr>
<td>Getting started</td>
<td>58</td>
</tr>
<tr>
<td>Configuration</td>
<td>60</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>61</td>
</tr>
<tr>
<td>BasicUniView</td>
<td>61</td>
</tr>
<tr>
<td>Overview</td>
<td>61</td>
</tr>
<tr>
<td>Getting started</td>
<td>62</td>
</tr>
<tr>
<td>Configuration</td>
<td>64</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>64</td>
</tr>
<tr>
<td>CMSListMenu</td>
<td>80</td>
</tr>
<tr>
<td>Overview</td>
<td>80</td>
</tr>
<tr>
<td>Getting started</td>
<td>80</td>
</tr>
<tr>
<td>Configuration</td>
<td>81</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>83</td>
</tr>
<tr>
<td>General</td>
<td>83</td>
</tr>
<tr>
<td>Creating a horizontal drop-down menu using CSS styles</td>
<td>84</td>
</tr>
<tr>
<td>Creating a vertical drop-down menu using CSS styles</td>
<td>85</td>
</tr>
<tr>
<td>CMSMenu</td>
<td>86</td>
</tr>
<tr>
<td>Overview</td>
<td>86</td>
</tr>
<tr>
<td>Getting started</td>
<td>87</td>
</tr>
<tr>
<td>Configuration</td>
<td>89</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>91</td>
</tr>
<tr>
<td>CMSSiteMap</td>
<td>91</td>
</tr>
<tr>
<td>Overview</td>
<td>91</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Getting started</td>
<td>92</td>
</tr>
<tr>
<td>Configuration</td>
<td>93</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>94</td>
</tr>
<tr>
<td>CMSTabControl</td>
<td>95</td>
</tr>
<tr>
<td>Overview</td>
<td>95</td>
</tr>
<tr>
<td>Getting started</td>
<td>95</td>
</tr>
<tr>
<td>Configuration</td>
<td>97</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>98</td>
</tr>
<tr>
<td>CMSTreeMenu</td>
<td>98</td>
</tr>
<tr>
<td>Overview</td>
<td>98</td>
</tr>
<tr>
<td>Getting started</td>
<td>98</td>
</tr>
<tr>
<td>Configuration</td>
<td>99</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>101</td>
</tr>
<tr>
<td>CMSTreeView</td>
<td>103</td>
</tr>
<tr>
<td>Overview</td>
<td>103</td>
</tr>
<tr>
<td>Getting started</td>
<td>104</td>
</tr>
<tr>
<td>Configuration</td>
<td>104</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>106</td>
</tr>
<tr>
<td>Listings and viewers</td>
<td>107</td>
</tr>
<tr>
<td>Overview</td>
<td>107</td>
</tr>
<tr>
<td>Standard listings and viewers</td>
<td>107</td>
</tr>
<tr>
<td>Overview</td>
<td>107</td>
</tr>
<tr>
<td>Using nested controls</td>
<td>107</td>
</tr>
<tr>
<td>Displaying related documents</td>
<td>110</td>
</tr>
<tr>
<td>CMSCalendar</td>
<td>115</td>
</tr>
<tr>
<td>Overview</td>
<td>115</td>
</tr>
<tr>
<td>Getting started</td>
<td>116</td>
</tr>
<tr>
<td>Configuration</td>
<td>117</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>117</td>
</tr>
<tr>
<td>CMSDataGrid</td>
<td>117</td>
</tr>
<tr>
<td>Overview</td>
<td>117</td>
</tr>
<tr>
<td>Getting started</td>
<td>118</td>
</tr>
<tr>
<td>Configuration</td>
<td>119</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>120</td>
</tr>
<tr>
<td>CMSDataList</td>
<td>120</td>
</tr>
<tr>
<td>Overview</td>
<td>120</td>
</tr>
<tr>
<td>Getting started</td>
<td>121</td>
</tr>
<tr>
<td>Configuration</td>
<td>122</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>123</td>
</tr>
<tr>
<td>CMSDocumentValue</td>
<td>123</td>
</tr>
<tr>
<td>Overview</td>
<td>123</td>
</tr>
<tr>
<td>Getting started</td>
<td>123</td>
</tr>
<tr>
<td>Configuration</td>
<td>124</td>
</tr>
<tr>
<td>CMSRepeater</td>
<td>124</td>
</tr>
<tr>
<td>Overview</td>
<td>124</td>
</tr>
<tr>
<td>Getting started</td>
<td>125</td>
</tr>
<tr>
<td>Configuration</td>
<td>126</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>127</td>
</tr>
<tr>
<td>CMSUnView</td>
<td>127</td>
</tr>
<tr>
<td>Overview</td>
<td>127</td>
</tr>
<tr>
<td>Getting started</td>
<td>128</td>
</tr>
<tr>
<td>Configuration</td>
<td>129</td>
</tr>
<tr>
<td>Using hierarchical transformations</td>
<td>133</td>
</tr>
<tr>
<td>Appearance and styling</td>
<td>134</td>
</tr>
</tbody>
</table>

© 2012 Kentico Software
Getting started.................................................................................................................................................................................. 163
Configuration.................................................................................................................................................................................. 163
Appearance and styling................................................................................................................................................................................. 165

Search Controls .......................................................................................................................................................................................... 165
Overview .................................................................................................................................................................................. 165
CMSSearchDialog .................................................................................................................................................................................. 166
Overview .................................................................................................................................................................................. 166
Getting started.................................................................................................................................................................................. 166
Configuration.................................................................................................................................................................................. 167
Structure.................................................................................................................................................................................. 168
Appearance and styling................................................................................................................................................................................. 169
CMSSearchResults .................................................................................................................................................................................. 170
Overview .................................................................................................................................................................................. 170
Configuration.................................................................................................................................................................................. 170
Structure.................................................................................................................................................................................. 173
Appearance and styling................................................................................................................................................................................. 174

UI Controls .......................................................................................................................................................................................... 175
Overview .................................................................................................................................................................................. 175
UniGrid .......................................................................................................................................................................................... 175
Overview .................................................................................................................................................................................. 175
Getting started.................................................................................................................................................................................. 175
Implementing custom functionality.................................................................................................................................................................. 178
Configuration.................................................................................................................................................................................. 181
UniGrid definition.................................................................................................................................................................................. 184
UniSelector .......................................................................................................................................................................................... 196
Overview .................................................................................................................................................................................. 196
Getting started.................................................................................................................................................................................. 196
Configuration.................................................................................................................................................................................. 198

© 2012 Kentico Software
Part I

Kentico CMS Controls
1 Kentico CMS Controls

1.1 Overview

Kentico CMS Controls are standard ASP.NET server controls that can be used in Visual Studio 2005, 2008 or 2010. You can place them in your user control .ascx files that implement custom web parts, on ASPX page templates and pages that do not use the portal engine. Some of them can also be used outside of Kentico CMS.

Kentico CMS Controls work on the .NET 3.5 SP1 and 4.0 Frameworks.

Before you start using them, please make sure your project is configured as described in Configuring your project for Kentico CMS Controls.

As mentioned, ASPX page templates are a common place to use controls. The Using ASPX page templates topic contains a guide describing how a new page template can be created and prepared to fully utilize CMS controls.

Many controls use transformations to customize the way they display data. More information about this can be found in the Transformations topic.

To learn more about the various types and inheritance hierarchy of Kentico CMS controls, please see the Controls hierarchy topic.

Corporate Site sample website required

The examples found in topics describing individual controls further in this guide assume that your Kentico CMS database contains data for the sample Corporate Site website.

1.2 Configuring your project for Kentico CMS Controls

Before you start using Kentico CMS Controls in your ASP.NET project, you need to add the controls to the Toolbox:

1. Open the website project in Visual Studio and open an ASPX page.

2. Right-click the Toolbox and choose Add tab from the context menu.

3. Type the name of the new tab (e.g. CMS) and press Enter:
4. Right-click the new tab and choose **Choose Items...** from the context menu.

5. In the **Choose Toolbox Items** dialog, click **Browse** and locate the **CMS.Controls.dll** library in the **Bin** folder under your website. Click **Open** and then click **OK**.

6. The controls are now added to the **Toolbox**:
7. Now you can easily drag and drop the controls onto your Web forms.

1.3 Using ASPX page templates

Placing controls on ASPX page templates is one of their most common uses. For additional information about page templates, please refer to Developer’s Guide -> Development -> Web development overview - > ASPX page template development.

The following is a step-by-step tutorial showing how a new ASPX page template can be created and registered in the system.

1. Open your Kentico CMS web project in Visual Studio using File -> Open -> Web Site... in the menu.

2. Now right-click the CMSTemplates/CorporateSite folder in the Solution Explorer and select Add New Item.

3. Choose to create a new Web Form (.aspx page) and check the Select master page box. Click Add.

4. The Select a Master Page dialog appears. Choose a master page file and click OK. You can use the default ASPX master page in the CMSTemplates/CorporateSite folder named root.master.
5. Switch to the Source view of the newly created web form. Add the following line under the `<%@ Page %>` directive:

```csharp
%@ Register Assembly="CMS.Controls" Namespace="CMS.Controls" TagPrefix="cms" %>
```

You can now add any HTML code inside the `<asp:Content>` element, including any CMS controls and their definitions.

6. Switch to the code behind. You need to add a reference to the CMS.UIControls namespace:

[C#]

```csharp
using CMS.UIControls;
```

7. The last step is to modify the class from which the page is inherited. Change the following code:

[C#]

```csharp
public partial class CMSTemplates_CorporateSiteAspx_Example : System.Web.UI.Page
```

to this:

[C#]

```csharp
public partial class CMSTemplates_CorporateSiteAspx_Example : TemplatePage
```

Now the page can be correctly used as a page template in Kentico CMS.

Please keep in mind that the name of the class must be identical to the value of the Inherits attribute of the `<%@ Page %>` directive on the ASPX page. This is case sensitive.

**Registering the ASPX page as a page template**

Now that we have created a new ASPX page, we need to register it in Kentico CMS as a page template so that it can be used.

8. Sign in to Site Manager (we recommend doing this on the sample Corporate Site when following this tutorial for the controls in this guide) and go to Development -> Page templates. Select a folder, for example Corporate Site/Examples, click New template and enter a display and code name.

Click OK. Now use the Select button to choose the .aspx file created in the previous steps located in the ~/CMSTemplates/CorporateSite folder.

Click Save.

9. Now switch to the Sites tab, assign the page template to the websites where you wish for it to be
available using the Add sites button and click OK.

Creating a page based on the new page template

10. Go to Kentico CMS Desk -> Content. Create a New document of type Page (menu item). Enter a Page name and select the Use existing page template option. Select the page template created in the previous steps and click Save to create the page.

Now you have a page using an ASPX page template. Any changes made to the source .aspx file will now be automatically reflected by this page.

1.4 Transformations

Transformations are pieces of code that determine how Kentico CMS documents, or certain parts of them, are rendered by listing web parts and controls. They take raw data from the Kentico CMS database and transform it into the form you wish it to appear in. This makes them a crucial tool when displaying documents and document related data on the pages of your website.

Their functionality is very similar to that of templates used by standard ASP.NET list controls such as the Repeater, which can be defined within the tags of a control through various ItemTemplate properties. The main difference is that our transformations are stored separately in the database and can easily be used repeatedly. They are assigned to web parts or controls through the appropriate TransformationName properties. The use of transformations is supported by all web parts that display document data, as well as by those listing controls that are designed to work directly with Kentico CMS documents, such as those in the CMS Controls -> Listings and viewers section of this guide.

There are several different approaches that can be used to write transformations. You can choose how a transformation's code should be rendered by setting the appropriate type. The following are available:

- **ASCX** - with this option, the code of the transformation will support ASCX markup, i.e. the same syntax that you would use to edit a standard web form or user control, including inline code, embedded controls, standard ASP.NET data binding expressions and special methods designed for use in transformations. Document fields can be accessed using expressions in format: `<%# Eval("ColumnName") %>`

- **Text/XML** - the code will only be processed as basic HTML. This means that any ASCX markup, such as controls or inline code, will not be functional when the transformation is rendered. You may use Kentico CMS Macro expressions and methods to insert dynamic values into the content. Expressions in the following format allow you to easily get the values of the given document's fields: `{%ColumnName%}`

- **HTML** - works the same way as the Text/XML option, but editing is done through the WYSIWYG editor. The rendered output of HTML code will be shown inside the editor.

- **XSLT** - this option can be selected for transformations that use XSL elements to render the data. The code must be in valid XML format.

Please note that for security reasons, the code of ASCX type transformations may only be edited by users who have the Edit ASCX code permission for the Design module. This permission can only be assigned by global administrators.

Since text-based transformations (Text/XML or HTML types) are only processed as basic HTML, they
cannot be used to compromise the security of the website. Another advantage of these transformation types is that they do not need to be compiled, which means they may be used and modified even if the Virtual path provider is not available, such as in a precompiled or medium trust environment.

Transformations are categorized under the document types or custom tables that they are supposed to display. They can be managed in the Kentico CMS administration interface at Site Manager -> Development -> Document types or Custom tables -> ... Edit (edics) document type or custom table ... -> Transformations. Some document types do not represent an object but serve only as a container for transformations and queries.

The sample sites include many transformations for all document types and you can modify them or write new transformations to suit any of your requirements.

For more information about transformations and document types, please refer to Developer’s Guide -> Development -> Document types and transformations.

Example

The code of an ASCX transformation used to display a list of products could look like this:
When this transformation is assigned to a listing control or web part that has products (SKUs) in its data source, the output code of individual products will contain the values returned by the methods and data binding expressions, like in the following example:

```html
<div class="ProductPreview">
  <div class="ProductBox">
    <div class="ProductImage">
      <a href="/KenticoCMS/Products/Smartphones/Apple-iPhone-3GS.aspx" style="display:block;">
        %# EcommerceFunctions.GetProductImage(Eval("SKUImagePath"), 180, Eval("SKUName")) %>
      </a>
    </div>
    <a href="/KenticoCMS/Products/Smartphones/Apple-iPhone-3GS.aspx">
      <span class="ProductTitle textContent">
        %# HTMLEncode(ResHelper.LocalizeString(Convert.ToString(Eval("SKUName")))) %>
      </span>
    </a>
    <div class="ProductFooter">
      <div class="productPrice">
        %# EcommerceFunctions.GetFormatedPrice(Eval("SKUPrice"), Eval("SKUDepartmentID"), null, 0, true, ValidationHelper.GetInteger(Eval("SKUSiteID"), 0) == 0) %>
      </div>
    </div>
  </div>
</div>
```

The final output of this product on the website will then look like this:
1.5 Controls hierarchy

Kentico CMS Controls make use of the object-oriented nature of the .NET Framework and many of them are derived either from standard ASP.NET controls or from each other. This means that controls with similar functionality have many common properties and learning to use them is made easier due to this fact.

The following categories and controls are available:

- **Generic Controls** - these controls either serve as base controls that others are derived from or provide additional functionality, such as paging
  - UniView
  - **Paging controls**
    - DataPager
    - TemplateDataPager
    - UniPager

- **Basic Controls** - these controls do not use the Kentico CMS database or API and can be used with any type of bindable data; most of them are derived from either intrinsic ASP.NET control or Generic controls
  - Navigation
    - BasicTabControl
  - **Listings and viewers**
    - BasicCalendar
    - BasicDataGrid
    - BasicDataList

Please note

The CSS stylesheet used by the page is applied to the output of the transformation. This example uses the classes from the default **Corporate Site** stylesheet.
• BasicRepeater
• BasicUniView

• **CMS Controls** - these controls are designed to work exclusively with Kentico CMS documents and data; many of them are derived from Basic Controls with similar fundamental functionality
  
  • **Navigation**
  - CMSBreadCrumbs
  - CMSSiteMenu
  - CMSTabControl
  - CMSTreeMenu
  - CMSTreeView

  • **Listings and viewers**
    
    • **Standard listings and viewers**
    - CMSCalendar
    - CMSDataGrid
    - CMSDataList
    - CMSDocumentValue
    - CMSRepeater
    - CMSUniView
    - CMSViewer

    • **Listings and viewers with a custom query**
    - QueryDataGrid
    - QueryDataList
    - QueryRepeater
    - QueryUniView

  • **Edit mode buttons**
    - CMSEditModeButtonAdd
    - CMSEditModeButtonEditDelete

  • **Editable regions for ASPX page templates**
    - CMSEditableImage
    - CMSEditableRegion
    - CMSPageManager

  • **Search controls**
    - CMSSearchDialog
    - CMSSearchResults

• **UI Controls** - these controls are different from the others; they are user controls that are utilized in the interface of Kentico CMS, but can also be used for custom purposes
  
  • UniGrid
  • UniSelector

### 1.6 Generic Controls

#### 1.6.1 Overview

The controls in this section have various functionality, and often serve as base controls that others are derived from or provide additional functionality, such as paging.

**Available controls:**
1.6.2 UniView

1.6.2.1 Overview

The UniView control is a universal templated data viewer with support for the displaying of hierarchical
data from grouped data sources.

Grouped data sources

Grouped data sources are represented by the GroupedDataSource class, which takes a
standard data source, such as a DataSet, and categorizes the data items into groups
according to a specified column. It can also determine the hierarchical level of data items
depending on the value of a given column.

An example of using this class with the UniView control can be found in the following
topic.

UniView can be used with any bindable data source - it doesn't use Kentico CMS database or API.

Please note

If you want to display documents from Kentico CMS, please use the CMSUniView
control that provides a more convenient way.

The following topics are available to help you familiarize yourself with the UniView control:

- Getting started - contains a step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control
- Appearance and styling - describes how the design of the control can be modified

1.6.2.2 Getting started

The following is a step-by-step tutorial that will show you how to display all pages (CMS.MenuItem
documents) from the sample Corporate Site using the UniView control:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop the UniView control from the toolbox onto the form.

3. Add the code marked by the UniView templates comments between the <cms:UniView> tags. The overall code of the UniView control should look like this:
This sets the templates used when displaying the menu items. The control dynamically replaces the `<% # ... %>` tags with values of the currently displayed record. This is then repeated for every record in the data source.

4. Add the following references to the beginning of the web form code-behind:

[C#]

```csharp
using System.Data;
using CMS.CMSHelper;
using CMS.GlobalHelper;
```

5. Now add the following code to the **Page_Load** method:

[C#]

```csharp
//Create DataSet containing all menu item documents in the system
```
DataSet ds = TreeHelper.SelectNodes("%/", false, "CMS.MenuItem", ",", "NodeLevel, NodeOrder", -1, true);

    //Check that the DataSet isn't empty
     if (!DataHelper.DataSourceIsEmpty(ds))
    {
        //Bind the DataSet to the UniView control
        this.UniView1.DataSource = ds;
        this.UniView1.DataBind();
    }

This code reads documents from the database and provides them to the UniView control as a DataSet.

6. Save the changes to the web form and its code behind file. Now right-click it in the Solution explorer
and select View in Browser. The resulting page should look like this:

- Home
- Services
- Products
- News
- Partners
- Community
- Company
- Media
- Examples
- Mobile
- Other
- Services/Web-design
- Products/Smartphones
- Partners/Silver-partners
- Company/Careers
- Community/Forums
- Media/Images
- Mobile/Home

As you can see, this displays all page (menu item) documents in the system, but a flat list is far from
ideal for such a purpose. The following steps will show you how to modify the code to display a
hierarchical structure.

7. Add another reference to the beginning of the web form code-behind:

[C#]

using CMS.SettingsProvider;

8. Modify the code of the Page_Load method to look like this:

[C#]
//Create DataSet containing all menu item documents in the system
DataSet ds = TreeHelper.SelectNodes("/\%", false, "CMS.MenuItem", ",", "NodeLevel,
NodeOrder", -1, true);

//Check that the DataSet isn't empty
if (!DataHelper.DataSourceIsEmpty(ds)) {

    //Create GroupedDataSource from the ds DataSet
    GroupedDataSource gpd = new GroupedDataSource(ds, "NodeParentID",
    "NodeLevel");

    //Set RelationColumnID property of the UniView control
    this.UniView1.RelationColumnID = "NodeID";

    //Bind the DataSet to the UniView control
    this.UniView1.DataSource = gpd;
    this.UniView1.DataBind();
}

This code takes the DataSet containing the documents, groups them according to the **NodeID** of their
parent document and determines their level in the hierarchy according to their **NodeLevel**.

9. Save the changes and refresh the page in your browser. It should now look like this:
### 1.6.2.3 Configuration

The following properties of the UniView control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingRange</td>
<td>Indicates how often the <strong>AlternatingItemTemplate</strong> should be used.</td>
<td></td>
</tr>
<tr>
<td>AlternatingStartPosition</td>
<td>Indicates the item number from which the <strong>AlternatingItemTemplate</strong> should start being used.</td>
<td></td>
</tr>
<tr>
<td>DataSource</td>
<td>The object from which the list of data items is retrieved.</td>
<td></td>
</tr>
<tr>
<td>HideHeaderAndFooterForSingleItem</td>
<td>Indicates whether the content of the <strong>HeaderTemplate</strong> and <strong>FooterTemplate</strong> should be hidden if only a single item is displayed.</td>
<td></td>
</tr>
</tbody>
</table>
| HierarchicalDisplayMode             | Sets the hierarchical display mode. *Inner* generates sub-levels inside the level above, *Separate* | *Inner* "Separate"
Separate generates sub-levels outside of the upper levels.

<table>
<thead>
<tr>
<th>OuterData</th>
<th>Data generated in the <strong>HeaderTemplate</strong> and <strong>FooterTemplate</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PagerDataItem</td>
<td>Gets or sets the pager data item object.</td>
</tr>
<tr>
<td>PagerForceNumberOfResults</td>
<td>If set, the DataSet containing paged items is not modified by the pager, but the pager itself behaves as if the amount of paged items were identical to this value. The value must be set to -1 for the property to be disabled.</td>
</tr>
<tr>
<td>RelationColumnID</td>
<td>The name of the column that specifies the value of the current hierarchy level of items.</td>
</tr>
<tr>
<td>SelectedItemColumnName</td>
<td>The name of the column that should be used for to find out which item is currently selected.</td>
</tr>
<tr>
<td>SelectedItemValue</td>
<td>The item whose column specified by the <strong>SelectedItemColumn</strong> property matches the value of this property will be designated as the currently selected item. Typically, you will need to insert a Macro expression in order to dynamically retrieve the appropriate value from the current context.</td>
</tr>
<tr>
<td>UseNearestItemForHeaderAndFooter</td>
<td>Indicates whether data from the nearest data item should be used for the header or footer item. This value is ignored if the <strong>OuterData</strong> property is set.</td>
</tr>
</tbody>
</table>

### 1.6.2.4 Appearance and styling

The appearance of the UniView control is determined by the code of its templates and by certain other properties.

The following templates can be defined within the tags of the UniView control:

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingItemTemplate</td>
<td>Code of the template used for alternating items.</td>
<td><code>&lt;font color=&quot;#999999&quot;&gt;&lt;# HTMLHelper.HTMLEncode(Convert.ToString(Eval(&quot;NodeAliasPath&quot;)))&gt;&lt;/font&gt;</code></td>
</tr>
<tr>
<td>FirstItemTemplate</td>
<td>Code of the template used for the first item on every level.</td>
<td></td>
</tr>
</tbody>
</table>
1.6.3 Paging controls

1.6.3.1 Overview

The controls in this section provide paging support to other controls that display data. This means they divide the displayed items into groups (pages) and provide an easy way to navigate between them.

The newest, most flexible and easiest to use is the UniPager control. It provides most of the functionality of the other two and more, so we recommend using it whenever possible.

Available controls:

- DataPager
- TemplateDataPager
- UniPager

1.6.3.2 Paging controls - common properties

All of the pager controls have the following properties in common:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentPage</td>
<td>The current page number.</td>
<td></td>
</tr>
<tr>
<td>MaxPages</td>
<td>Maximum number of pages that can be viewed.</td>
<td></td>
</tr>
<tr>
<td>PageCount</td>
<td>The current number of pages (read only).</td>
<td></td>
</tr>
<tr>
<td>PageSize</td>
<td>The number of displayed items per page.</td>
<td></td>
</tr>
</tbody>
</table>
1.6.3.3 DataPager

1.6.3.3.1 Overview

The DataPager control can ensure paging for the following CMSControls:

- CMSDataList
- CMSRepeater
- CMSSearchResults
- QueryDataList
- QueryRepeater

This control doesn't need to be used separately, it is built into the above controls and can be enabled or disabled by using their EnablePaging property.

See also: TemplateDataPager - this is a paging control that can be used to customize the data paging format

Please note

If possible, we recommend that you use the newer UniPager control instead.

The following topics are available to help you familiarize yourself with the DataPager control:

- Getting started - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control
- Appearance and styling - describes and explains additional properties that can be used to customize the appearance of the control

1.6.3.3.2 Getting started

The following is a step-by-step tutorial that will show you how use the DataPager control with a CMSRepeater control that displays all pages (menu items) in the system:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSRepeater control from the toolbox onto the form and set its following properties:

   - ClassNames: cms.menuitem
   - EnablePaging: True

   This tells the control which document types to read and enables the DataPager.

3. Switch to the Source tab and add the code marked by the CMSRepeater templates comments between the <cms:CMSRepeater> tags. The overall code of the CMSRepeater control should look like this:
This sets the templates used by the CMSRepeater to display the pages (menu items). The control dynamically replaces the `<%# ... %>` tags with values of the currently displayed record. This is then repeated for every record in the data source.

6. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should look like this:

```
1.6.3.3.3      Configuration
The properties of the DataPager control can be accessed through the **PagerControl** property of the paged controls, like for example:

[C#]

CMSRepeater1.PagerControl.BackText = "<-";
In addition to the properties from [Paging controls - common properties](#), the following properties can be set in your code behind files:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataSource</td>
<td>Can be used to access the object of the pager's data source.</td>
<td></td>
</tr>
<tr>
<td>BackNextDisplay</td>
<td>Back/Next display mode.</td>
<td>&quot;Buttons&quot; &quot;Hyperlinks&quot;</td>
</tr>
<tr>
<td>BackNextLocation</td>
<td>Back/Next location.</td>
<td>&quot;Right&quot; &quot;Left&quot; &quot;Split&quot; &quot;None&quot;</td>
</tr>
<tr>
<td>BackText</td>
<td>Back button/hyperlink text.</td>
<td></td>
</tr>
<tr>
<td>FirstText</td>
<td>First button/hyperlink text.</td>
<td></td>
</tr>
<tr>
<td>HideOnSinglePage</td>
<td>If true, the pager is hidden if only one page is displayed.</td>
<td></td>
</tr>
<tr>
<td>IgnoreQueryString</td>
<td>Indicates whether querystring parameters should be ignored.</td>
<td></td>
</tr>
<tr>
<td>InsertKeys</td>
<td>Adds keys to the querystring.</td>
<td></td>
</tr>
<tr>
<td>InsertToUrl</td>
<td>Indicates whether inserting querystring keys is enabled.</td>
<td></td>
</tr>
<tr>
<td>LabelText</td>
<td>Label text.</td>
<td></td>
</tr>
<tr>
<td>LastText</td>
<td>Last text.</td>
<td></td>
</tr>
<tr>
<td>NextText</td>
<td>Next button/hyperlink text.</td>
<td></td>
</tr>
<tr>
<td>PagedData</td>
<td>Gets the data to be paged.</td>
<td></td>
</tr>
<tr>
<td>PageNumbersDisplay</td>
<td>Page numbers display mode.</td>
<td>&quot;Numbers&quot; &quot;Results&quot;</td>
</tr>
<tr>
<td>PagerPosition</td>
<td>The position of the pager relative to the paged data.</td>
<td>&quot;Bottom&quot; &quot;Top&quot; &quot;TopAndBottom&quot;</td>
</tr>
<tr>
<td>PagingMode</td>
<td>Determines the type of the used paging parameter. It can either be passed through the URL (QueryString) or through postback (PostBack).</td>
<td>PostBack QueryString</td>
</tr>
<tr>
<td>QueryStringKey</td>
<td>Query parameter name for the page index.</td>
<td>&quot;pagenumber&quot;</td>
</tr>
<tr>
<td>RecordEnd</td>
<td>Index of the last record on the current page.</td>
<td></td>
</tr>
<tr>
<td>RecordStart</td>
<td>Index of the first record on the current page.</td>
<td></td>
</tr>
<tr>
<td>RemoveFromUrl</td>
<td>Indicates whether removing querystring keys is enabled.</td>
<td></td>
</tr>
<tr>
<td>Property Name</td>
<td>Description</td>
<td>Sample Value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>RemoveKeys</td>
<td>Removes keys from the querystring.</td>
<td></td>
</tr>
<tr>
<td>ResultsFormat</td>
<td>Results text format.</td>
<td>&quot;Displaying results [0]-[1] (of (2))&quot;</td>
</tr>
<tr>
<td>ResultsLocation</td>
<td>Results location.</td>
<td>&quot;Top&quot; &quot;Bottom&quot; &quot;None&quot;</td>
</tr>
<tr>
<td>ShowFirstLast</td>
<td>Indicates whether first/last buttons should be displayed.</td>
<td></td>
</tr>
<tr>
<td>ShowLabel</td>
<td>Indicates whether labels should be displayed.</td>
<td></td>
</tr>
<tr>
<td>ShowPageNumbers</td>
<td>Indicates whether page numbers should be displayed.</td>
<td></td>
</tr>
<tr>
<td>SliderSize</td>
<td>Slider size.</td>
<td></td>
</tr>
<tr>
<td>TotalRecords</td>
<td>Total amount of data source records.</td>
<td></td>
</tr>
<tr>
<td>UseSlider</td>
<td>Indicates whether the slider should be used.</td>
<td></td>
</tr>
</tbody>
</table>

1.6.3.3.4 Appearance and styling

The appearance of the DataPager control can additionally be modified by its following properties and the CSS classes that they specify:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BackNextButtonStyle</td>
<td>Back/Next button style.</td>
<td></td>
</tr>
<tr>
<td>BackNextLinkSeparator</td>
<td>Back/Next link separator.</td>
<td></td>
</tr>
<tr>
<td>BackNextStyle</td>
<td>Back/Next style.</td>
<td></td>
</tr>
<tr>
<td>ControlCssClass</td>
<td>CSS class of the pager control.</td>
<td></td>
</tr>
<tr>
<td>LabelStyle</td>
<td>Label style.</td>
<td></td>
</tr>
<tr>
<td>PageNumbersStyle</td>
<td>Page numbers style.</td>
<td></td>
</tr>
<tr>
<td>PageNumbersSeparator</td>
<td>Page numbers separator.</td>
<td>&quot;,,&quot;</td>
</tr>
<tr>
<td>PagerControlStyle</td>
<td>Pager control style.</td>
<td></td>
</tr>
<tr>
<td>PagerHTMLAfter</td>
<td>HTML code to be rendered after the pager.</td>
<td></td>
</tr>
<tr>
<td>PagerHTMLBefore</td>
<td>HTML code to be rendered before the pager.</td>
<td></td>
</tr>
<tr>
<td>PagerNumberAreaClass</td>
<td>CSS class of the number area.</td>
<td></td>
</tr>
<tr>
<td>ResultsStyle</td>
<td>Results style.</td>
<td></td>
</tr>
<tr>
<td>SectionPadding</td>
<td>Section padding.</td>
<td></td>
</tr>
<tr>
<td>SelectedClass</td>
<td>CSS class of the selected page.</td>
<td></td>
</tr>
</tbody>
</table>
1.6.3.4 TemplateDataPager

1.6.3.4.1 Overview

The TemplateDataPager control can be used to set a custom format for data paging. It can work with the same controls as the DataPager. It automatically renders the list of numbers, but some code needs to be written to bind it to a control that ensures the displaying of content (e.g. CMSRepeater, CMSSDataList or other).

Please note

We recommend that you use the newer UniPager control, which can also be customized and is much easier to use, instead.

The following topics are available to help you familiarize yourself with the TemplateDataPager control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn how to use the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

1.6.3.4.2 Getting started

The following is a step-by-step tutorial that will show you how to add a custom pager to a CMSRepeater control that displays Smartphones (CMS.Smartphone documents) using the TemplateDataPager control:

1. Create a new Web form somewhere in your website installation directory.
2. Now add the following code to the page, inside the <form> element:

```xml
<ajaxToolkit:ToolkitScriptManager ID="manScript" runat="server" EnableViewState="false" />
<table style="border: solid 1px #CCCCCC; margin-left: auto; margin-right: auto;">
  <tr>
    <td style="border-bottom: solid 1px #CCCCCC; padding: 10px; text-align: center;">
      <cms:CMSRepeater ID="CMSRepeater1" runat="server" Path="/" ClassNames="CMS.Smartphone" TransformationName="Ecommerce.Transformations.Product_Default">
      </cms:CMSRepeater>
    </td>
  </tr>
  <tr>
    <td style="padding: 10px; background-color: #D9D9D9;">
      <cms:TemplateDataPager ID="TemplateDataPager1" runat="server">
        <NumberTemplate>
          <a href="?Page=#{Eval("PageNumber")}" >#{Eval("PageNumber")}</a>
        </NumberTemplate>
      </cms:TemplateDataPager>
    </td>
  </tr>
</table>
```
As you can see, the control uses a standard CMSRepeater control to display data. The pager format is specified using the templates defined between the tags of the `<cms: TemplateDataPager>` element.

The `ToolkitScriptManager` control included at the top is required by the transformation used to display smartphone documents. It is only there to ensure that the example is functional by itself and will usually be included on your website's master page.

3. Modify the code-behind so that it looks like this (the class name and type may be different):

[C#]

```csharp
using CMS.GlobalHelper;

public partial class CMSControlsExamples_TemplateDataPager : System.Web.UI.Page
{
    public string pageCount = "1";
    public string previousPage = "1";
    public string nextPage = "";

    /// <summary>
    /// OnInit override
    /// </summary>
    /// <param name="e"></param>
    protected override void OnInit(EventArgs e)
    {
        // Disable repeater pager and databindbydefault
        CMSRepeater1.EnablePaging = false;
        CMSRepeater1.DataBindByDefault = false;
    }

    <NumberTemplate>
    <SelectedNumberTemplate>
        <b>
            <%# Eval("PageNumber") %>
        </b>
    </SelectedNumberTemplate>
    <SeparatorTemplate>-</SeparatorTemplate>
    <FirstItemTemplate>
        <a href="?Page=1">First</a>&nbsp;|&nbsp;
    </FirstItemTemplate>
    <LastItemTemplate>
        &nbsp;&nbsp;<a href="?Page=<# pageCount %>">Last</a>
    </LastItemTemplate>
    <PreviousItemTemplate>
        <a href="?Page=<# previousPage %>">Previous</a> &nbsp;|&nbsp;
    </PreviousItemTemplate>
    <NextItemTemplate>
        &nbsp;&nbsp;<a href="?Page=<# nextPage %>">Next</a>&nbsp;
    </NextItemTemplate>
</cms:TemplateDataPager>
```
protected void Page_Load(object sender, EventArgs e) {
    // Get repeater datasource
    TemplateDataPager1.DataSource = CMSRepeater1.DataSource;

    // Set page size
    TemplateDataPager1.PageSize = 1;

    // Set current page from query string
    TemplateDataPager1.CurrentPage = ValidationHelper.GetInteger(Request.QueryString["Page"], 1);

    // Get page number for last link
    pageCount = ((int)(TemplateDataPager1.PageCount - 1)).ToString();

    // Set default next page link
    nextPage = pageCount;

    // Set previous link
    if ((TemplateDataPager1.CurrentPage - 1) >= 1) {
        previousPage = ((int)(TemplateDataPager1.CurrentPage - 1)).ToString();
    }

    // Set next link
    if ((TemplateDataPager1.CurrentPage + 1) <= (TemplateDataPager1.PageCount - 1)) {
        nextPage = ((int)(TemplateDataPager1.CurrentPage + 1)).ToString();
    }

    // Set paged datasource to the repeater and databind it
    CMSRepeater1.DataSource = TemplateDataPager1.PagedData;
    if (!DataHelper.DataSourceIsEmpty(CMSRepeater1.DataSource)) {
        CMSRepeater1.DataBind();
    }
}

This code binds the TemplateDataPager to the CMSRepeater.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should look like this:
1.6.3.4.3 Configuration

In addition to the properties from Paging controls - common properties, the following properties of the TemplateDataPager control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataSource</td>
<td>Can be used to access the object of the pager's data source.</td>
<td></td>
</tr>
<tr>
<td>NumberRepeater</td>
<td>Gets the repeater control used to display page numbers.</td>
<td></td>
</tr>
<tr>
<td>PagedData</td>
<td>Gets the data to be paged.</td>
<td></td>
</tr>
<tr>
<td>PagerPosition</td>
<td>The position of the pager relative to the paged data.</td>
<td>&quot;Bottom&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Top&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;TopAndBottom&quot;</td>
</tr>
<tr>
<td>PagingMode</td>
<td>Determines the type of the used paging parameter. It can either be passed through the URL (QueryString) or through postback (PostBack).</td>
<td>&quot;PostBack&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;QueryString&quot;</td>
</tr>
<tr>
<td>RecordEnd</td>
<td>Index of the last record on the current page.</td>
<td></td>
</tr>
<tr>
<td>RecordStart</td>
<td>Index of the first record on the current page.</td>
<td></td>
</tr>
<tr>
<td>TotalRecords</td>
<td>Total amount of data source records.</td>
<td></td>
</tr>
</tbody>
</table>

1.6.3.4.4 Appearance and styling

The appearance of the TemplateDataPager control is determined by the code in its templates. The following are available:

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FirstItemTemplate</td>
<td>Code of the template used for the link to the first page in the pager.</td>
<td>&lt;a href=&quot;?Page=1&quot;&gt;First &lt;/a&gt;  </td>
</tr>
</tbody>
</table>
The UniPager is a universal paging control that can ensure paging for any control that implements the IUniPageable interface. This includes the following Basic and Generic controls:

- BasicDataList
- BasicRepeater
- BasicUniView
- UniView

As well as the following CMS controls:

- CMSDataList
- CMSRepeater
- QueryDataList
- QueryRepeater

In cases where the UniPager control is placed after the attached listing control, that control must bind its data later in the page life cycle than during the Init event, otherwise paging will not be applied. For the CMSDataList and CMSRepeater controls, this can easily be solved by setting their DelayedLoading property to true.

The QueryDataList and QueryRepeater controls do not have this property, however, you can ensure that paging is applied correctly by setting their DataBindByDefault property to false and manually calling their Databind() method during the Load event.
```csharp
protected void Page_Load(object sender, EventArgs e)
{
    QueryRepeater1.DataBind();
}
```

The UniPager is also built into the CMSUniVarView and QueryUniView controls and can be enabled by their EnablePaging property.

The portal engine equivalent of the UniPager control is the Listings and viewers -> Universal Pager web part.

The following topics are available to help you familiarize yourself with the UniPager control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Structure** - contains a more advanced example of how the control can be configured and demonstrates what individual template properties affect
- **Appearance and styling** - describes how the design of the control can be modified
- **Implementing the IUniPageable interface** - contains a tutorial describing how a custom control that is pageable by the UniPager control can be created

### 1.6.3.5.2 Getting started

The following is a step-by-step tutorial that will show you how to add a simple pager to a CMSRepeater control that displays all pages (menu items) in the system:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSRepeater control from the toolbox onto the form and set its following properties:

   - **ClassNames**: cms.menuitem
   - **DelayedLoading**: True

3. Switch to the Source tab and add the code marked by the CMSRepeater templates comments between the `<cms:CMSRepeater>` tags. The overall code of the CMSRepeater control should look like this:

```xml
<cms:CMSRepeater ID="CMSRepeater1" runat="server" ClassNames="cms.menuitem" DelayedLoading="true">
  <ItemTemplate>
    <# HTMLHelper.HTMLEncode(Convert.ToString(Eval("NodeAliasPath"))) %>
  </ItemTemplate>
</cms:CMSRepeater>
```
This sets the templates used by the CMSRepeater to display the pages (menu items). The control dynamically replaces the `<%# ... %>` tags with values of the currently displayed record. This is then repeated for every record in the data source.

4. Switch back to the Design tab, drag and drop a UniPager control from the toolbox onto the form one line below the CMSRepeater and set its PageControl property to CMSRepeater1.

5. Switch to the Source tab and add the code marked by the UniPager templates comments between the `<cms:UniPager>` tags. The overall code of the UniPager control should look like this:

```xml
<cms:UniPager ID="UniPager1" runat="server" PageControl="CMSRepeater1">
  <%-- UniPager templates ---------------------------------- --%>
  <PageNumbersTemplate>
    <a href="<%# Eval("PageURL") %>" <%# Eval("Page") %>></a>
  </PageNumbersTemplate>
  <%-- UniPager templates ---------------------------------- --%>
</cms:UniPager>
```

This sets the minimum required template that enables the UniPager with a very simple design. Please see the Structure topic to learn about the more advanced templates.

6. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should look like this:
1.6.3.5.3 Configuration

In addition to the properties from [Paging controls - common properties](#), the following properties of the UniPager control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataSourceItemsCount</td>
<td>The amount of items in the data source.</td>
<td></td>
</tr>
<tr>
<td>DirectPageControlID</td>
<td>The ID of the control used for direct page changing.</td>
<td></td>
</tr>
<tr>
<td>DisplayFirstLastAutomatically</td>
<td>If enabled, the first and last buttons of the pager will be displayed only when there is no other way of accessing the first or last page through the pager.</td>
<td></td>
</tr>
<tr>
<td>DisplayPreviousNextAutomatically</td>
<td>If enabled, the previous and next buttons of the pager will be displayed only when there is no other way of accessing the previous or next page through the pager.</td>
<td></td>
</tr>
<tr>
<td>EnvelopeTag</td>
<td>The current envelope tag.</td>
<td></td>
</tr>
<tr>
<td>GroupSize</td>
<td>The amount of page links displayed in one group.</td>
<td></td>
</tr>
<tr>
<td>HidePagerForSinglePage</td>
<td>If true, the pager is hidden if only one page is displayed.</td>
<td></td>
</tr>
<tr>
<td>HTMLEnvelopeRenderingMode</td>
<td>The HTML envelope rendering mode for the current page.</td>
<td>&quot;Always&quot; &quot;Never&quot; &quot;OnlyForUpdatePanel&quot;</td>
</tr>
<tr>
<td>PageControl</td>
<td>The ID of the control to be paged.</td>
<td></td>
</tr>
<tr>
<td>PagedControl</td>
<td>The object of the control to be paged.</td>
<td></td>
</tr>
<tr>
<td>PagerMode</td>
<td>Determines the type of the used paging parameter. It can either be passed through the URL (QueryString) or through postback (PostBack).</td>
<td>&quot;PostBack&quot; &quot;QueryString&quot;</td>
</tr>
<tr>
<td>QueryStringKey</td>
<td>Name of the query string parameter that contains the current page number. This is</td>
<td>&quot;pagenumber&quot;</td>
</tr>
</tbody>
</table>
useful if there are multiple UniPager controls on the same page.

| RelatedData | Custom data connected to the object. |

1.6.3.5.4 Structure

This topic shows an example of how the UniPager control looks when all of its template properties are defined. If you wish to create this example for yourself, please follow the tutorial in the Getting started topic up to and including step 4, then continue with the following steps:

1. Add the code marked by the UniPager templates comments between the `<cms:UniPager>` tags. The overall code of the UniPager control should look like this:

```
<cms:UniPager ID="UniPager1" runat="server" PageControl="CMSRepeater1">
    <%-- UniPager templates ------------------------------------------------------ --%>
    <PageNumbersTemplate>
        <a href="<%# Eval("PageURL") %>"><%# Eval("Page") %></a>
    </PageNumbersTemplate>
    <CurrentPageTemplate>
        <strong><%# Eval("Page") %></strong>
    </CurrentPageTemplate>
    <PageNumbersSeparatorTemplate>
        &nbsp;&nbsp;
    </PageNumbersSeparatorTemplate>
    <FirstPageTemplate>
        <a href="<%# Eval("FirstURL") %>">|&lt;</a>
    </FirstPageTemplate>
    <LastPageTemplate>
        <a href="<%# Eval("LastURL") %>">&gt;|</a>
    </LastPageTemplate>
    <PreviousPageTemplate>
        <a href="<%# Eval("PreviousURL") %>">&lt;</a>
    </PreviousPageTemplate>
    <NextPageTemplate>
        <a href="<%# Eval("NextURL") %>">&gt;</a>
    </NextPageTemplate>
    <PreviousGroupTemplate>
        <a href="<%# Eval("PreviousGroupURL") %>">...</a>
    </PreviousGroupTemplate>
    <NextGroupTemplate>
        <a href="<%# Eval("NextGroupURL") %>">...</a>
    </NextGroupTemplate>
    <DirectPageTemplate>
        Page
        <asp:TextBox ID="DirectPageControl" runat="server" Style="width: 25px;" />
        of
        <%= Eval("Pages") %>
    </DirectPageTemplate>
    <LayoutTemplate>
        <asp:PlaceHolder runat="server" ID="plcFirstPage"></asp:PlaceHolder>
        <asp:PlaceHolder runat="server" ID="plcPreviousPage"></asp:PlaceHolder>
```
This sets all the templates of the UniPager control.

2. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should contain a pager like in the following diagram (without the descriptions), which shows the structure of the UniPager control. Individual areas are described below.

- **Layout Template** - determines the overall design of the displayed pager. To place the locations of individual templates into the layout, use PlaceHolder controls with their ID properties set exactly like in the example, e.g. plcFirstPage for the FirstPageTemplate etc. The content of individual pages is dependant on the control that the UniPager is ensuring paging for. The maximum amount of displayed items can be set through the UniPager control's PageSize property.
- **Page** - this area is defined by the code of the PageNumbersTemplate. It is usually used to display the general page links of the pager. The amount of displayed page links can be set by the UniPager control's GroupSize property.
- **Current page** - this area is defined by the code of the CurrentPageTemplate. It is usually used to display the number of the currently selected page.
- **Direct page** - this area is defined by the code of the DirectPageTemplate. It is usually used to display a control that allows direct switching between pages. The ID property of the used control must be set to DirectPageControl as in the example.
- **Separator** - this area is defined by the code of the PageNumbersSeparatorTemplate. It is placed between every page number in the pager.
- **First/Last page** - these areas are defined by the code of the FirstPageTemplate and LastPageTemplate. They are usually used to display links to the first and last page of the pager. If the UniPager control's DisplayFirstLastAutomatically property is set to true, this area is only shown...
when there is no other way of accessing the first or last page through the pager.

- **Next/Previous page** - these areas are defined by the code of the `NextPageTemplate` and `PreviousPageTemplate`. They are usually used to display links to the next and previous page of the pager. If the UniPager control's `DisplayPreviousNextAutomatically` property is set to `true`, this area is only shown when there is no other way of accessing the previous or next page through the pager.

- **Next/Previous group** - these areas are defined by the code of the `NextGroupTemplate` and `PreviousGroupTemplate`. They are usually used to display links to the next and previous group of pages.

### Appearance and styling

The appearance of the UniPager control is determined by the code of its templates and by certain other properties.

The following templates can be defined within the tags of the UniPager control. Please refer to the Structure topic to see what individual templates represent.

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentPageTemplate</td>
<td>Code of the template used for the current page in the pager. Use <code>&lt;%# Eval(&quot;Page&quot;) %&gt;</code> to get the current page number, <code>&lt;%# Eval(&quot;PageURL&quot;) %&gt;</code> to get page the URL or <code>&lt;%# Eval(&quot;PageLink&quot;) %&gt;</code> to get the page link.</td>
<td><code>&lt;strong&gt;&lt;%# Eval(&quot;Page&quot;) %&gt;&lt;/strong&gt;</code></td>
</tr>
<tr>
<td>DirectPageTemplate</td>
<td>Code of the template used for direct page changing. Use a TextBox or DropDownList control with ID <code>DirectPageControl</code> to register the page change event.</td>
<td><code>&lt;asp:TextBox ID=&quot;DirectPageControl&quot; runat=&quot;server&quot; Style=&quot; width: 25px;&quot; /&gt;</code></td>
</tr>
<tr>
<td>FirstPageTemplate</td>
<td>Code of the template used for the link to the first page in the pager. Use <code>&lt;%# Eval(&quot;FirstURL&quot;) %&gt;</code> to get the link to the first page.</td>
<td>`&lt;a href=&quot;&lt;%# Eval(&quot;FirstURL&quot;) %&gt;&quot;&gt;&lt;strong&gt;</td>
</tr>
<tr>
<td>LastPageTemplate</td>
<td>Code of the template used for the link to the last page in the pager. Use <code>&lt;%# Eval(&quot;LastURL&quot;) %&gt;</code> to get the link to the last page.</td>
<td>`&lt;a href=&quot;&lt;%# Eval(&quot;LastURL&quot;) %&gt;&quot;&gt;&gt;</td>
</tr>
<tr>
<td>LayoutTemplate</td>
<td>Code of the template used for the overall pager layout.</td>
<td></td>
</tr>
<tr>
<td>NextGroupTemplate</td>
<td>Code of the template used for the link to the next group of pages. Use <code>&lt;%# Eval(&quot;NextGroupURL&quot;) %&gt;</code> to get link to the next group.</td>
<td><code>&lt;a href=&quot;&lt;%# Eval(&quot;NextGroupURL&quot;) %&gt;&quot;&gt;...&lt;/a&gt;</code></td>
</tr>
<tr>
<td>NextPageTemplate</td>
<td>Code of the template used for the link to the next page. Use <code>&lt;%# Eval(&quot;NextURL&quot;) %&gt;</code> to get the link to the next page.</td>
<td><code>&lt;a href=&quot;&lt;%# Eval(&quot;NextURL&quot;) %&gt;&quot;&gt;&amp;gt;&lt;/a&gt;</code></td>
</tr>
</tbody>
</table>
### 1.6.3.5.6 Implementing the IUniPageable interface

The following is a step-by-step tutorial that will show you how to create a custom control that displays users, and have it implement the IUniPageable interface to allow it to be paged by the UniPager control:

1. Create a new **Web User Control** called *UniPageable_Repeater.ascx* inside a folder called *IUniPageableExample* in your website installation directory.

2. Now add the following code to the user control:

   ```csharp
   using CMS.SiteProvider;
   using CMS.Controls;
   
   using CMS.SiteProvider;
   using CMS.Controls;
   
   <asp:Repeater ID="Repeater1" runat="server">
      <ItemTemplate>
         <div>
            <%# Eval("UserName") %>
         </div>
      </ItemTemplate>
   </asp:Repeater>
   
   This adds a standard .NET Repeater control that will be used to display user names.

3. Switch to the code behind of the control and add the following code into it. Please keep in mind that the name of the class will be different according to the location of your web user control.

   ```csharp
   using CMS.SiteProvider;
   using CMS.Controls;
   
   using CMS.SiteProvider;
   using CMS.Controls;
   
   using CMS.SiteProvider;
   using CMS.Controls;
   ```
public partial class IUniPageableExample_UniPageable_Repeater : System.Web.UI.UserControl, IUniPageable
{
    // Private variable containing the value of the PagerForceNumberOfResults property
    private int mPagerForceNumberOfResults = -1;

    // Private variable used to contain the data source of the control
    private object dataSource = null;

    protected void Page_Load(object sender, EventArgs e)
    {
        // Loads all users from the database into the data source
        dataSource = UserInfoProvider.GetAllUsers();

        // Call page binding event
        if (OnPageBinding != null)
        {
            OnPageBinding(this, null);
        }

        // Assigns the data source to the encapsulated Repeater control
        Repeater1.DataSource = dataSource;
        Repeater1.DataBind();
    }

    /// <summary>
    /// Occurs when the control binds page data
    /// </summary>
    public event EventHandler<EventArgs> OnPageBinding;

    /// <summary>
    /// Occurs when the pager changes the page and the current PagerMode is set to postback
    /// </summary>
    public event EventHandler<EventArgs> OnPageChanged;

    /// <summary>
    /// Exposes the data object for the pager
    /// </summary>
    public object PagerDataItem
    {
        get
        {
            return dataSource;
        }

        set
        {
            dataSource = value;
            Repeater1.DataSource = value;
        }
    }

    /// <summary>
    /// If set, the DataSet containing paged items is not modified by the pager,
    /// but the pager itself behaves as if the amount of paged items were
This code causes the control to implement the IUniPageable interface and adds the implementation for all its required members.

4. Save the changes to both files. Now the newly created control is pageable by the UniPager control. Create a new Web form somewhere in your website installation directory, where this functionality will be demonstrated.

5. Add the following directive to the beginning of the code of the new web form to register the custom UniPageable_Repeater control:

```xml
<%@ Register src="~/IUniPageableExample/UniPageable_Repeater.ascx" tagname ="UniPageableRepeater" tagprefix="asp1" %>
```

6. Now add the following code into the content area of the page (by default between the `<div>` tags inside the `<form>` element):

```xml
<asp1:UniPageableRepeater ID="UPRepeater1" runat="server" />
<cms:UniPager ID="UniPager1" runat="server" PageControl="UPRepeater1" PageSize ="5">
    <PageNumbersTemplate>
```
This adds the custom control you created in the previous steps and a UniPager that is assigned to page it.

7. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a list of user names with a simple pager like in the following image:

```
administrator
public
silver
gold
Andy
1234
```

## 1.7 Basic Controls

### 1.7.1 Overview

Basic Controls are a set of controls that provide the same functionality as many standard ASP.NET controls, but extend them with some additional configuration options. Their main purpose is to provide a way to display external data that doesn't use Kentico CMS architecture.

The following control categories are available:

- [Navigation](#)
- [Listings and viewers](#)

### 1.7.2 Navigation

#### 1.7.2.1 Overview

This section contains controls that provide basic navigation functionality.

**Available controls:**

- [BasicTabControl](#)

#### 1.7.2.2 BasicTabControl

1.7.2.2.1 Overview

The BasicTabControl control displays a tab menu according to data provided by a two dimensional array. BasicTabControl doesn't use Kentico CMS database or API and can be used to navigate to pages outside of Kentico CMS websites.
If you want to display a tab menu based on data from Kentico CMS, please use the CMSTabControl control.

The following topics are available to help you familiarize yourself with the BasicTabControl control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - lists which CSS classes can be used with the control and how its appearance can be modified

### 1.7.2.2.2 Getting started

The following is a step-by-step tutorial that will show you how to display a simple tab menu using the BasicTabControl control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **BasicTabControl** control from the toolbox onto the form.

3. Switch to the **Source** tab. The code of the BasicTabControl control should look like this:

   ```html
   <cms:BasicTabControl ID="BasicTabControl1" runat="server" />
   ```

   Now add the following code between the tags of the `<head>` element:

   ```html
   <style type="text/css">
   /* Tab menu class definitions */
   .TabControlTable { FONT-SIZE: 14px; FONT-FAMILY: Arial, Verdana }  
   .TabControlRow { }  
   .TabControl { BORDER-RIGHT: black 1px solid; BORDER-TOP: black 1px solid; FONT-WEIGHT: bold; BACKGROUND: #e7e7ff; BORDER-LEFT: black 1px solid; CURSOR: hand; COLOR: black }  
   .TabControlSelected { BORDER-RIGHT: black 1px solid; BORDER-TOP: black 1px solid; FONT-WEIGHT: bold; BACKGROUND: #4a3c8c; BORDER-LEFT: black 1px solid; CURSOR: default; COLOR: white }  
   .TabControlLinkSelected { COLOR: white; TEXT-DECORATION: none }  
   .TabControlLink { COLOR: black; TEXT-DECORATION: none }  
   .TabControlLeft { WIDTH: 1px }  
   .TabControlRight { WIDTH: 0px }  
   .TabControlSelectedLeft { WIDTH: 1px }  
   .TabControlSelectedRight { WIDTH: 0px }  
   </style>
   ```

   This sets the CSS styles that will modify the appearance of the tab menu. The BasicTabControl control renders tabs even without any CSS classes specified, but they are extremely basic and not very user-friendly.
friendly. You can find out what individual CSS classes affect in the Appearance and styling topic.

The classes are defined in the <head> element only for this quick example, if you wish to use the control on a Kentico CMS website, it is recommended to define these classes in the used stylesheet in the administration interface at Site Manager -> Development -> CSS stylesheets.

4. Add the following code just after the <cms:BasicTabControl> element. It will display a stripe under the tabs.

```html
<hr style="width:100%; height:2px; margin-top:0px;" />
```

5. Switch to the code behind of the page and add the following code to the Page_Load method:

[C#]

```csharp
string[,] tabs = new string[3, 7];
tabs[0, 0] = "&nbsp;Home&nbsp;";
tabs[0, 1] = "alert('It is very simple!');";
tabs[0, 2] = "http://www.kentico.com";
tabs[1, 0] = "&nbsp;Features&nbsp;";
tabs[2, 0] = "&nbsp;Downloads&nbsp;";
tabs[2, 3] = "Some tooltip";
BasicTabControl1.Tabs = tabs;
BasicTabControl1.SelectedTab = 0;
BasicTabControl1.UrlTarget = "_blank";
BasicTabControl1.UseClientScript = true;
```

[VB.NET]

```vbnet
Dim tabs(2, 6) As String

tabs(0, 0) = "&nbsp;Home&nbsp;"
tabs(0, 1) = "alert('It\'s very simple!');"
tabs(0, 2) = "http://www.kentico.com"
tabs(1, 0) = "&nbsp;Features&nbsp;"
tabs(1, 2) = "http://www.kentico.com/free-cms-asp-net.aspx"
tabs(2, 0) = "&nbsp;Downloads&nbsp;"
tabs(2, 2) = "http://www.kentico.com/download/trial-version.aspx"
tabs(2, 3) = "Some tooltip"
BasicTabControl1.Tabs = tabs
BasicTabControl1.SelectedTab = 0
BasicTabControl1.UrlTarget = "_blank"
BasicTabControl1.UseClientScript = True
```

This creates an array of tab items and assigns it to the BasicTabControl control. It also selects the first tab, sets the target frame to "_blank" and enables client script.
6. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a tab menu like this:

   ![Home | Features | Download]

### 1.7.2.2.3 Configuration

The following properties of the BasicTabControl control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HideControlForZeroRows</td>
<td>Hides the control when no data is loaded. Default value is False.</td>
<td></td>
</tr>
<tr>
<td>RenderedHTML</td>
<td>Allows you to get or set the HTML code rendered by the control.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You need to set this property before the Render event - e.g. in the OnLoad event.</td>
<td></td>
</tr>
<tr>
<td>RenderLinkTitle</td>
<td>Specifies if the TITLE tag of links should be rendered.</td>
<td></td>
</tr>
<tr>
<td>SelectedTab</td>
<td>Index of the selected tab.</td>
<td></td>
</tr>
<tr>
<td>SelectFirstItemByDefault</td>
<td>Indicates whether the first tab should be selected by default.</td>
<td></td>
</tr>
<tr>
<td>TabControlIDPrefix</td>
<td>Prefix that will be used for all IDs in the HTML code rendered by the BasicTabControl. It's useful if you need to place multiple tab controls on the same page.</td>
<td>&quot;FirstTab&quot;</td>
</tr>
<tr>
<td>TabControlLayout</td>
<td>Specifies the layout of the tab control.</td>
<td>&quot;Horizontal&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Vertical&quot;</td>
</tr>
<tr>
<td>Tabs</td>
<td>A 2 dimensional string array where each row represents a tab and the columns represent the following:</td>
<td></td>
</tr>
<tr>
<td>tabs[0, 0] = title</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tabs[0, 1] = OnClick JavaScript</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tabs[0, 2] = URL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tabs[0, 3] = tooltip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tabs[0, 4] = left image URL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tabs[0, 5] = center image URL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tabs[0, 6] = right image URL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Please note:**

1. The image URLs in columns 4, 5 and 6 are optional.
1.7.2.2.4 Appearance and styling

The appearance of the BasicTabControl control is determined by the CSS classes it uses and by some of its properties.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TabControlTable</td>
<td>Table that contains the tabs (&lt;TABLE&gt; tag).</td>
</tr>
<tr>
<td>TabControlRow</td>
<td>Table row (&lt;TR&gt; tag).</td>
</tr>
<tr>
<td>TabControl</td>
<td>Tab item (&lt;TD&gt; tag).</td>
</tr>
<tr>
<td>TabControlSelected</td>
<td>Selected tab item (&lt;TD&gt; tag).</td>
</tr>
<tr>
<td>TabControlLink</td>
<td>Tab item link - if a URL is specified (&lt;A&gt; tag).</td>
</tr>
<tr>
<td>TabControlLinkSelected</td>
<td>Selected tab item link - if a URL is specified (&lt;A&gt; tag).</td>
</tr>
<tr>
<td>TabControlLeft</td>
<td>Left side of the tab item (&lt;TD&gt; tag).</td>
</tr>
<tr>
<td>TabControlRight</td>
<td>Right side of the tab item (&lt;TD&gt; tag).</td>
</tr>
<tr>
<td>TabControlSelectedLeft</td>
<td>Left side of the selected tab item (&lt;TD&gt; tag).</td>
</tr>
<tr>
<td>TabControlSelectedRight</td>
<td>Right side of the selected tab item (&lt;TD&gt; tag).</td>
</tr>
</tbody>
</table>

1.7.3 Listings and viewers

1.7.3.1 Overview

The controls in this section provide various ways to display data from a specified data source. Options include different types of lists, tables and calendars. Most of them are derived from standard ASP.NET list controls.

These controls can work with any bindable data source, not just Kentico CMS documents. They are also the best option for plain displaying of data from Kentico CMS data sources, because their performance
is better than that of the more complex CMS controls.

**Available controls:**

- BasicCalendar
- BasicDataGrid
- BasicDataList
- BasicRepeater
- BasicUniView

**1.7.3.2 BasicCalendar**

**1.7.3.2.1 Overview**

The BasicCalendar control allows you to display a calendar with events, news and other date-based documents specified by a data source. It is derived from the intrinsic ASP.NET Calendar control, which means it provides advanced formatting capabilities and it allows you to display additional information for appropriate days.

The BasicCalendar can be used with any bindable data source - it doesn't use Kentico CMS database or API.

---

**Please note**

The **CMSCalendar** control provides a more convenient way to display data from the Kentico CMS Database in a calendar.

---

The following topics are available to help you familiarize yourself with the BasicCalendar control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

**1.7.3.2.2 Getting started**

The following is a step-by-step tutorial that will show you how to display a calendar that contains links to news items (CMS.News documents) on days when news items were released using the BasicCalendar control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **BasicCalendar** control from the toolbox onto the form.

3. Switch to the **Source** tab and add the code marked by the **BasicCalendar templates** comments between the `<cms:BasicCalendar>` tags. The overall code of the BasicCalendar control should look like this:
<cms:BasicCalendar ID="BasicCalendar1" runat="server">

<%-- BasicCalendar templates
------------------------------------------ --%>

<ItemTemplate>
    <br/>
    <a href='
    <%= ResolveUrl(CMS.CMSHelper.CMSContext.GetUrl(Convert.ToString(Eval("NodeAliasPath")), Convert.ToString(Eval("DocumentUriPath")))) %>
    <%= Eval("NewsTitle") %>
    </a>
</ItemTemplate>

<NoEventsTemplate>
    <br>
    No Event
</NoEventsTemplate>

<%-- BasicCalendar templates
------------------------------------------ --%>

</cms:BasicCalendar>

This sets the template used to specify the layout of days with and without news releases. For days with news releases, the control dynamically replaces the <# ... #> tags with values of the current news document from the data source.

4. Switch to the code behind of the page and add the following reference to the beginning of the code:

[C#]

using CMS.CMSHelper;

[VB.NET]

Imports CMS.CMSHelper

5. Now add the following code to the Page_Load method:

[C#]

BasicCalendar1.DataSource = TreeHelper.SelectNodes("/\", false, "cms.news", null, "NewsReleaseDate", -1, true);

BasicCalendar1.DayField = "NewsReleaseDate";
BasicCalendar1.DataBind();

[VB.NET]

© 2012 Kentico Software
This retrieves all news items from the Kentico CMS database as a DataSet and assigns it as the data source of the BasicCalendar control. It also fills the **DayField** property, which tells the control which field it should get date/time values from.

6. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a calendar like this:

<p>| | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sun</strong></td>
<td><strong>Mon</strong></td>
<td><strong>Tue</strong></td>
<td><strong>Wed</strong></td>
<td><strong>Thu</strong></td>
<td><strong>Fri</strong></td>
<td><strong>Sat</strong></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>30</td>
<td>31</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>New Consultant Services</td>
<td>New Event</td>
<td>New Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>Community Website Section</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td>No Event</td>
<td></td>
</tr>
</tbody>
</table>

### 1.7.3.2.3 Configuration

The following properties of the BasicCalendar control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CustomTimeZone</td>
<td>A custom time zone to be used represented by a TimeZoneInfo object.</td>
<td></td>
</tr>
<tr>
<td>DataMember</td>
<td>Name of the table when a DataSet is used as a DataSource.</td>
<td></td>
</tr>
<tr>
<td>DataSource</td>
<td>Data source with calendar events - either a DataSet or DataTable object.</td>
<td></td>
</tr>
<tr>
<td>DayField</td>
<td>Name of the field in the data source that contains the date/time value.</td>
<td>&quot;NewsReleaseDate&quot;</td>
</tr>
<tr>
<td>DayWithEventsStyle</td>
<td>Style of days that have an event.</td>
<td></td>
</tr>
<tr>
<td>DisplayOnlySingleDayItem</td>
<td>Indicates whether only one item is displayed in a single day item.</td>
<td></td>
</tr>
<tr>
<td>HideDefaultDayNumber</td>
<td>Indicates whether the day number should be displayed or if the day cell should be fully filled by the used template.</td>
<td></td>
</tr>
</tbody>
</table>
As this control is inherited from the ASP.NET Calendar control, it also has all of its standard properties.

### Appearance and styling

You can modify the appearance of the BasicCalendar control by setting the standard properties inherited from the ASP.NET Calendar control. You can find more details on particular properties in the .NET Framework documentation for the `Calendar` class.

A common way to set the appearance of this control is to assign a skin through the `SkinID` property. Skins can be defined in `.skin` files under individual themes in the `App_Themes` folder. More information can be found in the .NET Skins and Themes documentation.

The design of day cells is determined by the code of the templates defined within the tags of the BasicCalendar control. The following are available:

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ItemTemplate</td>
<td>Template for displaying a day with an event.</td>
<td></td>
</tr>
<tr>
<td>NoEventsTemplate</td>
<td>Template for displaying a day without any event.</td>
<td></td>
</tr>
</tbody>
</table>

### BasicDataGrid

#### Overview

The BasicDataGrid control allows you to display items from a data source in a customizable table. It is derived from the intrinsic ASP.NET DataGrid control, so it automatically provides paging and sorting support. You can use the standard DataGrid designer to set up BasicDataGrid style and behavior.

The BasicDataGrid can be used with any bindable data source - it doesn't use Kentico CMS database or API.

**Please note**

The `CMSDataGrid` control provides a more convenient way to display data from the Kentico CMS Database in a table.

The following topics are available to help you familiarize yourself with the BasicDataGrid control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the
Getting started

The following is a step-by-step tutorial that will show you how to display a table that contains laptops (CMS.Laptop documents) from the sample Corporate Site using the BasicDataGrid control:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a BasicDataGrid control from the toolbox onto the form.

3. Right-click the BasicDataGrid on the form, select AutoFormat... and choose a scheme.

4. Right-click the BasicDataGrid on the form, select Show Smart Tag and then Property Builder...; the BasicDataGrid1 Properties dialog will be displayed.

On the General tab, check the Allow sorting box.

Now switch to the Columns tab, where you can specify the columns that will be displayed, and uncheck the Create columns automatically at run time box.

Add a new Bound Column from the Available columns list to the Selected columns list. Enter the following values into the appropriate fields:

- **Header text:** Name
- **Data Field:** LaptopName
- **Sort expression:** LaptopName

Add another Bound column. Enter the following values in the appropriate fields:

- **Header text:** Price
- **Data Field:** SKUPrice
- **Sort expression:** SKUPrice

Click OK.

5. Switch to the code behind of the page and add the following references to the beginning of the code:

[C#]

```csharp
using System.Data;
using CMS.CMSHelper;
```

[VB.NET]

```vbnet
Imports System.Data
```
6. Now add the following code to the `Page_Load` method:

[C#]

```csharp
DataSet ds = TreeHelper.SelectNodes("/\%", false, "CMS.Laptop", ",", "LaptopName", -1, true);
BasicDataGrid1.DataSource = ds;
BasicDataGrid1.DataBind();
```

[VB.NET]

```vbnet
Dim ds As DataSet = TreeHelper.SelectNodes("/\%", False, "CMS.Laptop", ",", "LaptopName", -1, True)
BasicDataGrid1.DataSource = ds
BasicDataGrid1.DataBind()
```

This retrieves all CMS.Laptop documents from the Kentico CMS database as a `DataSet` and assigns it as the data source of the `BasicDataGrid` control.

7. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a table similar to the following (depending on the chosen scheme):

<table>
<thead>
<tr>
<th>Name</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPad 2</td>
<td>510.99</td>
</tr>
<tr>
<td>Apple MacBook Pro MC723LL/A</td>
<td>2199</td>
</tr>
<tr>
<td>Dell XPS 15z</td>
<td>1596.99</td>
</tr>
<tr>
<td>HP EliteBook 8440p WJ681AW</td>
<td>1899</td>
</tr>
</tbody>
</table>

1.7.3.3.3 Configuration

The following properties of the `BasicDataGrid` control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataBindByDefault</td>
<td>Indicates whether data binding should be performed by default during the init event.</td>
<td></td>
</tr>
<tr>
<td>HideControlForZeroRows</td>
<td>Indicates whether the control should be hidden when no data is loaded. The default value is False.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>ProcessSorting</td>
<td>Indicates whether sorting should be processed in the DataView instead of sorting on the SQL level.</td>
<td></td>
</tr>
<tr>
<td>RelatedData</td>
<td>Custom data connected to the object.</td>
<td></td>
</tr>
<tr>
<td>SetFirstPageAfterSortChange</td>
<td>Indicates if the page index should be set to the first page when sorting is changed.</td>
<td></td>
</tr>
<tr>
<td>SortAscending</td>
<td>Indicates whether sorting should be ascending. Default value is True.</td>
<td></td>
</tr>
<tr>
<td>SortField</td>
<td>Gets or sets the sort field. It can be used for setting the default sort field.</td>
<td></td>
</tr>
<tr>
<td>ZeroRowsText</td>
<td>Text to be shown when the control is hidden by the HideControlForZeroRows property.</td>
<td></td>
</tr>
</tbody>
</table>

As this control is inherited from the ASP.NET DataGrid control, it also has all of its standard properties.

1.7.3.4 Appearance and styling

You can modify the appearance of the BasicDataGrid control by setting the standard properties inherited from the ASP.NET DataGrid control. You can find more details on particular properties in the .NET Framework documentation for the DataGrid class.

A common way to set the appearance of this control is to assign a skin through the SkinID property. Skins can be defined in .skin files under individual themes in the App_Themes folder. More information can be found in the .NET Skins and Themes documentation.

1.7.3.4 BasicDataList

1.7.3.4.1 Overview

The BasicDataList control allows you to display items from a data source in a list based on specified templates. It is derived from the intrinsic ASP.NET DataList control, so standard ASP.NET configuration techniques can be used to set up BasicDataList style and behaviour.

The BasicDataList can be used with any bindable data source - it doesn't use Kentico CMS database or API.

Unlike the BasicRepeater control, the BasicDataList allows you to display data in several columns.

The portal engine equivalent of the BasicDataList control is the Listings and viewers -> Basic datalist web part.

Please note

The CMSDataList control provides a more convenient way to display data from Kentico CMS.
The following topics are available to help you familiarize yourself with the BasicDataList control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

### 1.7.3.4.2 Getting started

The following is a step-by-step tutorial that will show you how to display a list of smartphones (CMS. Smartphone documents) from the sample Corporate Site using the BasicDataList control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **BasicDataList** control from the toolbox onto the form and set its **RepeatColumns** property value to 3. This determines the number of columns that should be displayed.

3. Switch to the **Source** tab and add the code marked by the **BasicDataList template** comments between the `<cms:BasicDataList>` tags. The overall code of the BasicDataList control should look like this:

```xml
<cms:BasicDataList ID="BasicDataList1" runat="server" RepeatColumns="3">
    <itemtemplate>
        <div style="width: 250px">
            <h3>
                <%= Eval("SmartphoneName") %>
            </h3>
            <%= EcommerceFunctions.GetProductImage(Eval("SKUImagePath"), 200, Eval("SmartphoneName")) %>
        </div>
    </itemtemplate>
</cms:BasicDataList>
```

This defines the template used by the BasicDataList to display items. The control dynamically replaces the `<%# ... %>` tags with values of the currently displayed record. This is then repeated for every record in the data source.

4. Switch to the code behind of the page and add the following references to the beginning of the code:

```csharp
using System.Data;
```
5. Now add the following code to the `Page_Load` method:

[C#]

```csharp
DataSet ds = TreeHelper.SelectNodes("/%", false, "CMS.Smartphone", ", "SmartphoneName", -1, true);
BasicDataList1.DataSource = ds;
BasicDataList1.DataBind();
```

[VB.NET]

```vbnet
Dim ds As DataSet = TreeHelper.SelectNodes("/%", False, "CMS.Smartphone", ", "SmartphoneName", -1, True)
BasicDataList1.DataSource = ds
BasicDataList1.DataBind()
```

This retrieves all CMS.Smartphone documents from the Kentico CMS database as a DataSet and assigns it as the data source of the BasicDataList control.

6. Save the changes to the web form. Now right-click it in the Solution explorer and select `View in Browser`. The resulting page should display a list similar to the following:
The following properties of the BasicDataList control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataBindByDefault</td>
<td>Indicates whether data binding should be performed by default during the <strong>init</strong> event.</td>
<td></td>
</tr>
<tr>
<td>HideControlForZeroRows</td>
<td>Indicates whether the control should be hidden when no data is loaded. The default value is False.</td>
<td></td>
</tr>
<tr>
<td>PagerDataItem</td>
<td>Gets or sets the pager data item object.</td>
<td></td>
</tr>
<tr>
<td>PagerForceNumberOfResults</td>
<td>If set, the DataSet containing paged items is not modified by the pager, but the pager itself behaves as if the amount of paged items were identical to this value. The value must be set to -1 for the property to be disabled.</td>
<td></td>
</tr>
<tr>
<td>RelatedData</td>
<td>Custom data connected to the object.</td>
<td></td>
</tr>
<tr>
<td>ZeroRowsText</td>
<td>Text to be shown when the control is hidden by the <strong>HideControlForZeroRows</strong> property.</td>
<td>&quot;No records found.&quot;</td>
</tr>
</tbody>
</table>

As this control is inherited from the ASP.NET DataList control, it also has all of its standard properties.
1.7.3.4 Appearance and styling

You can modify the appearance of the BasicDataList control by setting the standard properties and templates inherited from the ASP.NET DataList control. You can find more details on particular properties in the .NET Framework documentation for the DataList class.

The following templates can be defined:

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingItemTemplate</td>
<td>Code of the template applied to alternating items.</td>
<td></td>
</tr>
<tr>
<td>EditItemTemplate</td>
<td>Code of the template applied to the item selected for editing.</td>
<td></td>
</tr>
<tr>
<td>FooterTemplate</td>
<td>Code of the template used for the footer of the list.</td>
<td></td>
</tr>
<tr>
<td>HeaderTemplate</td>
<td>Code of the template used for the header of the list.</td>
<td></td>
</tr>
</tbody>
</table>
| ItemTemplate             | Code of the template applied to standard items.                             | <div style="width: 100%">
                                                                         |   <h3>
                                                                         |     <%= Eval("CellName") %>
                                                                         |   </h3>
                                                                         |     <%= EcommerceFunctions.GetProductImage(Eval("SKUImagePath"), 200) %>
                                                                         |   </div>                                                                              |
| SelectedItemTemplate     | Code of the template applied to the selected item.                          |                                                                              |
| SeparatorTemplate        | Code of the template used for separating items.                             |                                                                              |

1.7.3.5 BasicRepeater

1.7.3.5.1 Overview

The BasicRepeater control allows you to display items from a data source in a list based on specified templates. It is derived from the intrinsic ASP.NET Repeater control, so standard ASP.NET configuration techniques can be used to set up BasicRepeater style and behaviour.

BasicRepeater can be used with any bindable data source - it doesn’t use the Kentico CMS database or API.

The portal engine equivalent of the BasicRepeater control is the Listings and viewers -> Basic repeater web part.

Please note
The CMSRepeater control provides a more convenient way to display data from Kentico CMS.

The following topics are available to help you familiarize yourself with the BasicRepeater control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

### 1.7.3.5.2 Getting started

The following is a step-by-step tutorial that will show you how to display a list of laptops (CMS.Laptop documents) from the sample Corporate Site using the BasicRepeater control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **BasicRepeater** control from the toolbox onto the form.

3. Switch to the **Source** tab and add the code marked by the **BasicRepeater template** comments between the `<cms:BasicRepeater>` tags. The overall code of the BasicRepeater control should look like this:

```xml
<cms:BasicRepeater ID="BasicRepeater1" runat="server">
    <itemtemplate>
        <h3>
            <%= Eval("LaptopName") %>
        </h3>
        <%= EcommerceFunctions.GetProductImage(Eval("SKUImagePath"), 200, Eval("LaptopName")) %>
    </itemtemplate>
</cms:BasicRepeater>
```

This defines the template used by the BasicRepeater to display items. The control dynamically replaces the `<%# ... %>` tags with values of the currently displayed record. This is then repeated for every record in the data source.

4. Switch to the code behind of the page and add the following references to the beginning of the code:

```csharp
[C#]
```
5. Now add the following code to the `Page_Load` method:

[C#]

```csharp
dataSet ds = TreeHelper.SelectNodes("/\%", false, "CMS.Laptop", ",", "LaptopName", -1, true);
BasicRepeater1.DataSource = ds;
BasicRepeater1.DataBind();
```

[VB.NET]

```vbnet
dim ds as dataSet = treehelper.selectnodes("/\", false, "CMS.Laptop", ",", "LaptopName", -1, true)
BasicRepeater1.DataSource = ds
BasicRepeater1.DataBind()
```

This retrieves all CMS.Laptop documents from the Kentico CMS database as a `DataSet` and assigns it as the data source of the `BasicRepeater` control.

6. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a list similar to the following:
The following properties of the BasicRepeater control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataBindByDefault</td>
<td>Indicates whether data binding should be performed by default during the init event.</td>
<td></td>
</tr>
<tr>
<td>HideControlForZeroRows</td>
<td>Indicates whether the control should be hidden when no data is loaded. The default value is False.</td>
<td></td>
</tr>
<tr>
<td>PagerDataItem</td>
<td>Gets or sets the pager data item object.</td>
<td></td>
</tr>
<tr>
<td>PagerForceNumberOfResults</td>
<td>If set, the DataSet containing paged items is not modified by the pager, but the pager itself behaves as if the amount of paged items were identical to this value. The value must be set to -1 for the property to be disabled.</td>
<td></td>
</tr>
<tr>
<td>RelatedData</td>
<td>Custom data connected to the object.</td>
<td></td>
</tr>
<tr>
<td>ZeroRowsText</td>
<td>Text to be shown when the control is hidden by the HideControlForZeroRows property.</td>
<td>&quot;No records found.&quot;</td>
</tr>
</tbody>
</table>
As this control is inherited from the ASP.NET Repeater control, it also has all of its standard properties.

1.7.3.5.4 Appearance and styling

You can modify the appearance of the BasicRepeater control by setting the standard properties and templates inherited from the ASP.NET Repeater control. You can find more details on particular properties in the .NET Framework documentation for the Repeater class.

The following templates can be defined:

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingItemTemplate</td>
<td>Code of the template applied to alternating items.</td>
<td></td>
</tr>
<tr>
<td>FooterTemplate</td>
<td>Code of the template used for the footer of the list.</td>
<td></td>
</tr>
<tr>
<td>HeaderTemplate</td>
<td>Code of the template used for the header of the list.</td>
<td></td>
</tr>
</tbody>
</table>
| ItemTemplate       | Code of the template applied to standard items.   | `<div style="width: 100%">
|                   |                                                  | <h3>..<%# Eval("CellName") %>..<%# EcommerceFunctions.GetProductImage(Eval("SKUImagePath"), 200) %>..<h3></div>` |
| SeparatorTemplate  | Code of the template used for separating items.   |                                                                              |

1.7.3.6 BasicUniView

1.7.3.6.1 Overview

The BasicUniView control allows you to display items from a data source in a hierarchical structure based on specified templates. It is derived from the UniView control, but is extended to include several more properties.

BasicUniView can be used with any bindable data source - it doesn't use Kentico CMS database or API.

The portal engine equivalent of the BasicUniView control is the Listings and viewers -> Basic universal viewer web part.

Please note

If you want to display documents from Kentico CMS, please use the CMSUniView control that provides a more convenient way.
The following topics are available to help you familiarize yourself with the BasicUniView control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

### 1.7.3.6.2 Getting started

The following is a step-by-step tutorial that will show you how to display all pages (CMS.MenuItem documents) from the sample Corporate Site in a hierarchical structure using the BasicUniView control:

1. Create a new **Web form** somewhere in your website installation directory.
2. Switch to its **Design** tab, drag and drop the **BasicUniView** control from the toolbox onto the form.
3. Add the code marked by the **BasicUniView templates** comments between the `<cms:BasicUniView>` tags. The overall code of the BasicUniView control should look like this:

```xml
<cms:BasicUniView ID="BasicUniView1" runat="server">
  <!-- BasicUniView templates -->
  <ItemTemplate>
    <%= HTMLHelper.HTMLEncode(Convert.ToString(Eval("NodeAliasPath"))) %>
  </ItemTemplate>
  <AlternatingItemTemplate>
    <font color="#999999"><%= HTMLHelper.HTMLEncode(Convert.ToString(Eval("NodeAliasPath"))) %></font>
  </AlternatingItemTemplate>
  <SeparatorTemplate>
    <li></li>
  </SeparatorTemplate>
  <HeaderTemplate>
    <ul>
      <li></li>
    </ul>
  </HeaderTemplate>
  <FooterTemplate>
    </li>
  </FooterTemplate>
  <!-- BasicUniView templates -->
</cms:BasicUniView>
```

This sets the templates used when displaying the menu items. The control dynamically replaces the `<% # ... %>` tags with values of the currently displayed record. This is then repeated for every record in the data source.
4. Add the following references to the beginning of the web form code-behind:

[C#]

```csharp
using System.Data;
using CMS.CMSHelper;
using CMS.GlobalHelper;
using CMS.SettingsProvider;
```

5. Now add the following code to the `Page_Load` method:

[C#]

```csharp
//Create DataSet containing all menu item documents in the system
DataSet ds = TreeHelper.SelectNodes("/%", false, "CMS.MenuItem", ",", "NodeLevel, NodeOrder", -1, true);

    //Check that the DataSet isn't empty
    if (!DataHelper.DataSourceIsEmpty(ds))
    {
        //Create GroupedDataSource from the ds DataSet
        GroupedDataSource gpd = new GroupedDataSource(ds, "NodeParentID", "NodeLevel");

        //Set RelationColumnID property of the UniView control
        this.BasicUniView1.RelationColumnID = "NodeID";

        //Bind the DataSet to the UniView control
        this.BasicUniView1.DataSource = gpd;
        this.BasicUniView1.DataBind();
    }
```

This code reads documents from the database, saves them in a DataSet and then groups them according to the `NodeID` of their parent document and determines their level in the hierarchy according to their `NodeLevel`. This grouped data source is then provided to the BasicUniView control.

6. Save the changes to the web form and its code-behind file. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should look like this:
As it is inherited from the UniView control, the BasicUniView control has all of its properties (including templates). These can be found in the UniView -> Configuration topic. In addition, it has the following properties that can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataBindByDefault</td>
<td>Indicates whether data binding should be performed by default during the init event.</td>
<td></td>
</tr>
<tr>
<td>DataSource</td>
<td>The object from which the list of data items is retrieved.</td>
<td></td>
</tr>
<tr>
<td>HideControlForZeroRows</td>
<td>Indicates whether the control should be hidden when no data is loaded. The default value is False.</td>
<td></td>
</tr>
<tr>
<td>RelatedData</td>
<td>Custom data connected to the object.</td>
<td></td>
</tr>
<tr>
<td>ZeroRowsText</td>
<td>Text to be shown when the control is hidden by the HideControlForZeroRows property.</td>
<td>&quot;No records found.&quot;</td>
</tr>
</tbody>
</table>

1.7.3.6.4 Appearance and styling

The appearance of the BasicUniView control is determined by the code of its templates (inherited from the UniView control).
1.8 CMS Controls

1.8.1 Overview

CMS Controls are a set of controls that were designed to work within the Kentico CMS system. This means they are meant to be used only with data from Kentico CMS database and documents. They automatically perform many routine tasks, which makes them easier to work with, as common use does not require the writing of any additional code.

As they work with CMS documents, most of the controls in this section have a Path property that allows the selection of the documents that should be affected. The Path specification in controls and web parts topic explains the way this property should be filled.

To optimize the performance of the websites they are used on, CMS controls provide caching support. To learn more about this subject and how related configuration can be done, please see the Caching topic.

The following control categories are available:

- Navigation
- Listings and viewers
- Edit mode buttons
- Editable regions for ASPX templates
- Search Controls

1.8.2 Path specification in controls and web parts

Many web parts and controls use a Path property that allows you to specify which documents should be displayed. This is the AliasPath property of the document. You can use either an exact path or utilize special characters for specifying multiple selection or relative paths:

Using wildcard characters % and _

You can use % as a wildcard character for any number of characters, which allows you to select all documents under the specified site section.

Examples:

/ - only root
/% - all documents

/Products - only the Products document.
/Products%/ - all documents under the Products document.

You can also use the _ character (underscore) as a wildcard character for a single character.

Examples:

/Product_ - selects documents /ProductA, /Product1, etc.
Leaving the Path value empty

In many cases, the Path value can be left empty.

For navigation controls/web parts, such as CMSMenu/Drop-down menu, this causes the path to be set to all documents - /%.

In the case of listing controls/web parts, such as CMSRepeater/Repeater or CMSDataGrid/Grid, the path is set to display all child documents of the page containing the control or web part - <current alias path>/%

Using a formatting string to get parts of the path

You can also use special expressions that extract parts of the current path, such as this.

Examples:

/{0}/{1}/% - all documents under the second document level of the current path
/{0}/{1}/Details - document Details under the second document level of the current path

Using relative paths

You can use relative path expressions to specify sub-documents or parent documents:

Examples:

./Product - document Product under the current path
../Product - document Product under the parent document of the current path
. - current path
.. - parent document of the current path
./% - all documents under the current path
../% - all documents under the parent document of the current path

1.8.3 Caching

What is Caching

Caching allows you to minimize the number of performed database queries. The server can store the data in the application's memory and the next time a user requests the content, the server will return it from the memory instead of performing a resource-intensive database query. Caching can improve the performance of your website significantly, depending on the specifics of your application.

The content expires after the specified time span and must be retrieved from the database again. Each cached item has its name and the cache memory is common for all pages in your web application.

Caching Support in Kentico CMS

You can manage the caching either by yourself in your code (please see the .NET Framework SDK documentation for more details) or you can leverage caching features of the following Kentico CMS Controls that are also used in CMS web parts:

- Controls in the CMS Controls -> Navigation section
• Controls in the CMS Controls -> Listings and viewers section
  • CMSPageManager
  • CMSSearchResults

All of these controls offer the following properties, that allow you to set up caching:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CacheDependencies</td>
<td>List of the cache keys on which the cached data depends.</td>
<td>cms.user</td>
</tr>
<tr>
<td>CacheItemName</td>
<td>Name of the cache item the control will use.</td>
<td>&quot;products_&quot; &amp; request. querystring(&quot;categoryid&quot;)</td>
</tr>
<tr>
<td>CacheMinutes</td>
<td>Number of minutes the retrieved content is cached for.</td>
<td>&quot;10&quot;</td>
</tr>
</tbody>
</table>

**Cache Expiration Time**

By setting the **CacheMinutes** property to a value higher than zero, the control starts to cache its source data. You can configure caching for all Kentico CMS content using the **Cache content (minutes)** setting in the **Site Manager -> Settings -> System -> Performance** section. If you set any particular value to the CacheMinutes property of a control/web part, it overrides the global settings. If you leave the value empty or set it to -1 (minus one), the global settings apply.

The caching mechanism of Kentico CMS Controls uses absolute expiration time instead of sliding expiration. It means that the cache item expires after a specified period of time regardless of if it was requested or not. It ensures that content is updated from the database at a regular interval.

**Overriding the site-level caching settings**

If you need to cache most of the content on your website, but still want to have a single control/web part that doesn't use cache, you can configure caching as described in the previous paragraph and set the value 0 (zero) to the **CacheMinutes** property of the particular control. It will override the site-level settings and disable caching for the single control/web part.

**Cache Item Name**

It's important to understand the **CacheItemName** property: Since the cache is common for all pages in your application, the cache item name should be unique not only for all pages, but also inside one page (in case you use several Kentico CMS Controls with caching on one page).

When you leave the **CacheItemName** property empty, the control automatically generates a name in this form: **URL including parameters|control ID**

If the content displayed on the page depends on some parameter, such as a URL parameter or the role of the current user, you need to adjust the **CacheItemName** value accordingly.

**Example:**

Your page products.aspx displays products according to the category that is passed through the URL parameter **category**. You will need to use code like this to ensure that the content will be cached "per
category"

[C#]

```csharp
CMSDataGrid.CacheItemName = "products_grid1_" + Request.QueryString("category");
```

[VB.NET]

```vbnet
CMSDataGrid.CacheItemName = "products_grid1_" & Request.QueryString("category")
```

### Cache dependencies

Using the **CacheDependencies** property, you can specify which object changes cause the control/web part's cache to get cleared. Below, you can find a table showing which dummy cache keys get touched when some object gets changed, including some examples. By entering the appropriate dummy keys, one per line, you can specify that when the object gets changed, the cache gets cleared.

If you leave the property empty, default settings will be used. The default settings are configured for each control and include all possible object changes that the content of the web part could depend on.

<table>
<thead>
<tr>
<th>Object</th>
<th>Touched keys</th>
<th>Sample values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document</strong> (TreeNode)</td>
<td>node</td>
<td>&lt;sitename&gt;</td>
</tr>
<tr>
<td><strong>Any object</strong> (except documents)</td>
<td>&lt;classname&gt;</td>
<td>all &lt;classname&gt;</td>
</tr>
<tr>
<td>Metafile</td>
<td>metafile</td>
<td>&lt;guid&gt;</td>
</tr>
<tr>
<td>Document attachment</td>
<td>attachment</td>
<td>&lt;guid&gt;</td>
</tr>
<tr>
<td>Forum attachment</td>
<td>forumattachment</td>
<td>&lt;guid&gt;</td>
</tr>
<tr>
<td>Avatar</td>
<td>avatarfile</td>
<td>&lt;guid&gt;</td>
</tr>
<tr>
<td>Media file</td>
<td>mediafile</td>
<td>&lt;guid&gt; mediafile</td>
</tr>
</tbody>
</table>
Example:

1. Let's presume that you have a control/web part displaying some information about users. Therefore, whenever some user gets their details modified, the control/web part's cache should be cleared. To ensure this, you need to enter `cms.user|all` into the property, which is the dummy key that would get touched whenever some user's details get changed.

2. Now let's presume that your control/web part is displaying information about one particular user - the administrator. Her user name is `administrator`, her ID is `53` and her GUID is something beginning with `1ced44f3-f2fc`. So if you want to have the cache cleared whenever this user's details are changed, you can use any of the following three keys that specify the user by the previously named properties:

   - `cms.user|byid|53`
   - `cms.user|byname|administrator`
   - `cms.user|byguid|1ced44f3-f2fc-...`

1.8.4 CMS controls - common properties

The following properties provide configuration options for selecting Kentico CMS documents to most of the CMS Navigation and Standard listings and viewers controls. Please be aware that certain controls only use some of these properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckPermissions</td>
<td>Allows you to specify whether check permissions of the current user should be checked. If the value is <code>false</code> (default value) no permissions are checked. Otherwise, only nodes for which the user has read permission are selected.</td>
<td></td>
</tr>
<tr>
<td>ClassNames</td>
<td>Specifies which types of documents should be selected. Document types must be identified through their code names. Several values separated by semicolons (;) can be entered. The * wildcard can be used as a substitute for a random sequence of characters. For example <code>Product.*</code> would include the document types <code>Product.Camera</code>, <code>Product.CellPhone</code>, <code>Product.Computer</code> etc. If the property is left empty, controls retrieve all document types by default. In the case of menu and navigation controls, page (<code>cms.MenuItem</code>) documents are selected by</td>
<td>&quot;cms.news&quot; or &quot;cms.news;cms.article&quot;</td>
</tr>
</tbody>
</table>
default.

Please note: If all document types are loaded (empty value), only the common data columns from the View.CMS_Tree_Joined view will be available in the retrieved data. The specific fields of individual document types will not be included. This should be considered in the code of transformations, WHERE conditions, ORDER BY expressions etc.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CombineWithDefaultCulture</td>
<td>Indicates whether documents from the default culture version should be used if they are not available in the selected culture. This property is applied only if you do not set the TreeProvider property manually.</td>
</tr>
<tr>
<td>CultureCode</td>
<td>Culture code of documents to be selected, such as en-us. If not specified, it's read from the user's session or the default value is used.</td>
</tr>
<tr>
<td>DataSource</td>
<td>Gets or sets a DataSet containing values used to fill the items of the control.</td>
</tr>
<tr>
<td>FilterOutDuplicates</td>
<td>Indicates if duplicated (linked) documents should be filtered out from the data.</td>
</tr>
<tr>
<td>MaxRelativeLevel</td>
<td>Specifies the maximum number of content tree sub-levels from which content should be displayed. This number is relative, i.e. counted from the location of the page that the control is placed on. Entering -1 causes all child documents to be selected.</td>
</tr>
<tr>
<td>Path</td>
<td>Path of the documents to be selected. See Path specification for details.</td>
</tr>
<tr>
<td>SelectOnlyPublished</td>
<td>Indicates whether only published documents should be selected.</td>
</tr>
<tr>
<td>TreeProvider</td>
<td>Tree provider instance used to access data. If no TreeProvider is assigned, a new TreeProvider instance is created automatically.</td>
</tr>
</tbody>
</table>

**CMS base - common properties:**

The following properties provide basic configuration options to most of the CMS Navigation and Listings and viewers controls. Please be aware that certain controls only use some of these properties:
<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CacheDependencies</td>
<td>List of the cache keys on which the cached data depends. When the cache item changes, the cache of the control is cleared. Each item (dependency) must be on one line. If you leave this property empty, default dependencies will be used. Please refer to the Caching topic to learn more.</td>
<td>cms.user</td>
</tr>
<tr>
<td>CacheItemName</td>
<td>Name of the cache item the control will use. By setting this name dynamically, you can achieve caching based on a URL parameter or some other variable - simply enter the value of the parameter. If no value is set, the control stores its content in the item named &quot;URL</td>
<td>ControlID&quot;. Please refer to the Caching topic to learn more.</td>
</tr>
<tr>
<td>CacheMinutes</td>
<td>Number of minutes the retrieved content is cached for. Zero indicates that the content will not be cached. -1 indicates that the site-level settings should be used. This parameter allows you to set up caching of content so that it doesn't have to be retrieved from the database each time a user requests the page. Please refer to the Caching topic to learn more.</td>
<td></td>
</tr>
<tr>
<td>ControlTagKey</td>
<td>Overrides the generation of the SPAN tag with a custom tag.</td>
<td></td>
</tr>
<tr>
<td>FilterControl</td>
<td>Gets or sets the appropriate filter control used to limit the data read by this control.</td>
<td></td>
</tr>
<tr>
<td>FilterName</td>
<td>Gets or sets the code name of the appropriate filter control used to limit the data read by this control.</td>
<td></td>
</tr>
<tr>
<td>OrderBy</td>
<td>Gets or sets the ORDER BY clause of the &quot;NewsReleaseDate DESC&quot;</td>
<td></td>
</tr>
</tbody>
</table>
### 1.8.5 Navigation

#### 1.8.5.1 Overview

The controls in this section provide functionality that helps users find their way around Kentico CMS websites. This includes various types of menus, site maps and other basic navigation tools.

These controls are used by the web parts in the **Navigation** category.

All Kentico CMS documents have settings that influence how they are displayed in menus, which affects the navigation controls in this section as well. Learn more about these settings in the [Document menu settings](#) topic.

Most of the controls in this section use CSS classes to modify their design and several of them contain the **CSSPrefix** property, which can be used to specify the class names. The [Using the CSSPrefix property](#) topic clarifies how this property works.

**Available controls:**

- CMSBreadCrumbs
- CMSListMenu
- CMSMenu
- CMSSiteMap
- CMSTabControl
- CMSTreeMenu
- CMSTreeView

#### 1.8.5.2 Document menu settings

Various navigation related settings can be configured for individual Kentico CMS documents. This can be done in the CMS Desk interface at **Content -> Edit -> ... select document ... -> Properties -> Menu.**

<table>
<thead>
<tr>
<th><strong>SelectedColumns</strong></th>
<th>Database table columns that should be loaded with documents, separated by commas ( , ). Null or empty indicates that all columns should be selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SiteName</strong></td>
<td>Specifies the code name of the site to be used by the control.</td>
</tr>
<tr>
<td><strong>StopProcessing</strong></td>
<td>Indicates if processing of the control should be stopped and the control should not retrieve or display any data.</td>
</tr>
<tr>
<td><strong>TopN</strong></td>
<td>Specifies the maximum amount of rows that should be selected.</td>
</tr>
<tr>
<td><strong>WhereCondition</strong></td>
<td>Gets or sets the WHERE clause of the SQL statement.</td>
</tr>
<tr>
<td></td>
<td>&quot;ProductPrice &gt; 100&quot;</td>
</tr>
</tbody>
</table>
These settings apply to CMS Navigation controls (and web parts) displaying the given document and they override any conflicting property settings of the controls unless a property is set to ignore them.

The following settings are available:

### Basic properties

<table>
<thead>
<tr>
<th>Menu caption</th>
<th>The name of the document as it's displayed in navigation. It may be different compared to the document name. If no value is entered, the document name is used.</th>
</tr>
</thead>
</table>
| Show in navigation | Indicates if the document should be displayed by navigation controls and web parts (in menus).  

**Please note:** the document is displayed in the navigation if all of the following conditions are met:  

1. The **Show in navigation** box is checked.  
2. The document is published.  
3. The type of the document matches the document types configured in the appropriate navigation control (web part) - by default, only **Page**
(menu item) documents are displayed in navigation.

4. If you turn on the Check permissions property of the menu control, the user must be allowed to read the given document so that it appears in the navigation controls.

<table>
<thead>
<tr>
<th>Show in site map</th>
<th>Indicates if the document should be displayed by the CMSSiteMap control (Site map web part) and included in the in the website's Google Sitemap.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please note: the document is displayed in the site map if all of the following conditions are met:</td>
</tr>
<tr>
<td></td>
<td>1. The Show in site map box is checked.</td>
</tr>
<tr>
<td></td>
<td>2. The document is published.</td>
</tr>
<tr>
<td></td>
<td>3. The type of the document matches the document types configured in the Site map control (web part) - by default, only Page (menu item) documents are displayed in navigation.</td>
</tr>
<tr>
<td></td>
<td>4. If you turn on the Check permissions property of the menu control, the user must be allowed to read the given document so that it appears in the navigation controls.</td>
</tr>
</tbody>
</table>

### Menu actions

<table>
<thead>
<tr>
<th>Standard behavior</th>
<th>The menu item redirects the user to the page as expected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive menu item</td>
<td>Clicking the menu item doesn't cause any action - the item is disabled. You can enter the alias path of the page which should be redirected to in the Redirect to URL field.</td>
</tr>
<tr>
<td>Javascript command</td>
<td>If you enter a JavaScript command, it will be run when this menu item is clicked. Example: <code>alert('hello');return false;</code></td>
</tr>
<tr>
<td>URL redirection</td>
<td>The user is redirected to the target location when they try to access the given page. Example: <code>http://www.domain.com</code> or <code>~/products.aspx</code></td>
</tr>
</tbody>
</table>

Macro expressions can be used in the URL redirection and JavaScript command fields. These macros allow you to dynamically replace the given expression with specified values of the current menu item, such as alias path, id path, node name.

You only need to place macros in format `{%ColumnName%}` into the property field. For example, entering:

- `~/products.aspx?show=brand&aliaspath=%{NodeAliasPath%}`

Into the Redirect to URL field of e.g. the `/MobileStore/Products/Nokia` document will cause users to be redirected to:

- `http://<domain>/products.aspx?show=brand&aliaspath=/MobileStore/Products/Nokia`

Please note: All apostrophes (') in the source data are escaped to `\` so that they do not break JavaScript.
Menu design

The menu item design properties are available in three alternatives:

- standard design
- mouse-over design - style used when a user hovers their mouse over the menu item,
- highlighted design - style applied if the page represented by the menu item is currently selected.

These values override the settings of individual navigation controls (web parts) unless their ApplyMenuDesign property is set to false. The CSS styles defined in the CSS stylesheet are overridden as well.

Please note: some of the following properties may not be applied to the menu control depending on the menu control you are using.

<table>
<thead>
<tr>
<th>Menu item style</th>
<th>Style definition of the menu item. Values can be entered the same way as when defining a CSS class in a stylesheet. Sample value: color: orange; font-size: 140%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu item CSS class</td>
<td>CSS class defined in the website's stylesheet. Sample value: h1</td>
</tr>
<tr>
<td>Menu item left image</td>
<td>Image that will be displayed next to the menu caption on the left side. Sample values as below.</td>
</tr>
<tr>
<td>Menu item image</td>
<td>Image that will be displayed in the menu instead of the menu caption. You can enter either an absolute URL or a relative path in the content tree. Sample values: <a href="http://www.domain.com/image.gif">http://www.domain.com/image.gif</a> ~/Images-(1)/icon.aspx</td>
</tr>
<tr>
<td>Menu item right image</td>
<td>Image that will be displayed next to the menu caption on the right side. Sample values as above.</td>
</tr>
</tbody>
</table>

1.8.5.3 Using the CSSPrefix property

The CSSPrefix property allows you to place multiple controls of the same type on the same page and differentiate the CSS classes that they use by adding a prefix to the class names. Additionally, it can also be used to specify the style of menu sub-items at any chosen level.

This property can be set for the following controls:

- CMSListMenu
- CMSMenu
- CMSTreeMenu

Example

Here's an example of how to specify various styles for particular menu levels:

1. First, you need to specify the list of prefixes for particular levels using the CSSPrefix property:
CSSPrefix = "MainMenu;MainMenuSubMenu;MainMenuOtherLevels"

As you can see, the prefixes used for individual levels are separated by semicolons and every prefix
represents a lower level starting from the main one (level 0). The last defined prefix represents all sub-
levels below it as well. If you only wish to differentiate the CSS classes used by multiple controls on the
same page, one prefix is sufficient.

2. Now define the following styles with the specified prefixes:

```
.MainMenuCMSMenu
... for menu control

.MainMenuCMSMenuItem
.MainMenuCMSMenuItemMouseUp
... etc. for the first level of the menu (level 0)

.MainMenuSubMenuCMSMenuItem
.MainMenuSubMenuCMSMenuItemMouseUp
... etc. for the second level of the menu (level 1)

.MainMenuOtherLevelsCMSMenuItem
.MainMenuOtherLevelsCMSMenuItemMouseUp
... etc. for all underlying levels of the menu (level 2 and all remaining sub-levels)
```

1.8.5.4 CMS navigation - common properties

The following properties provide general configuration options to many of the CMS Navigation controls.
Please be aware that certain controls only use some of these properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApplyMenuDesign</td>
<td>Indicates whether the document menu settings for Menu design should be applied to this control. True by default.</td>
<td></td>
</tr>
<tr>
<td>Columns</td>
<td>Contains the names of columns which should be loaded with the documents (menu items). Only the columns contained in the DefaultColumns property are loaded by default. If you need some other column to be loaded as well, please add its name into this property.</td>
<td>&quot;DocumentPageTitle, DocumentPageKeywords&quot;</td>
</tr>
<tr>
<td>CSSPrefix</td>
<td>Specifies the prefix of standard navigation control CSS classes. You can also use several values separated by a semicolon (;) for particular levels. Learn more at Using the CSSPrefix property.</td>
<td>&quot;main;submenu1;submenu2&quot;</td>
</tr>
<tr>
<td>HideControlForZeroRow</td>
<td>Indicates whether the control should be hidden when no data is loaded. Default value</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>HighlightAllItemsInPath</td>
<td>Indicates whether all items in the unfolded path should be displayed as highlighted.</td>
<td></td>
</tr>
<tr>
<td>SubmenuIndicator</td>
<td>Contains the path to an image that will be displayed next to every item that contains sub-items.</td>
<td></td>
</tr>
<tr>
<td>UseAlternatingStyles</td>
<td>Indicates whether alternating styles should be used for even and odd items on the same menu level.</td>
<td></td>
</tr>
<tr>
<td>UseItemImageForHighlightedItem</td>
<td>Indicates whether the item image should be used if the highlighted image is not specified.</td>
<td></td>
</tr>
<tr>
<td>WordWrap</td>
<td>Indicates whether text displayed by the control should use word wrapping or be replaced by 'nbsp' entities if it is too long.</td>
<td></td>
</tr>
<tr>
<td>ZeroRowsText</td>
<td>Text to be shown when the control is hidden by the HideControlForZeroRows property.</td>
<td></td>
</tr>
</tbody>
</table>

### 1.8.5.5 CMSBreadCrumbs

#### 1.8.5.5.1 Overview

The CMSBreadCrumbs control allows you to display the current user's position within a website in format:

Item 1 > Item 2 > Item 3

where Item X is the name of the document in the path.

The portal engine equivalent of the CMSBreadCrumbs control is the Navigation -> Breadcrumbs web part.

The following topics are available to help you familiarize yourself with the CMSBreadCrumbs control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - lists which CSS classes can be used with the control and how its appearance can be modified

#### 1.8.5.5.2 Getting started

The following is a step-by-step tutorial that will show you how to display a user's current location within the structure of a website using the CMSBreadCrumbs control:

1. Create a new **Web form** and use it as a page template according to the guide in the Using ASPX page templates topic.
2. Switch to its **Design** tab and drag and drop a **CMSBreadCrumbs** control from the toolbox onto the form.

3. Save the changes to the web form. Now if you look at the page using the created template on some website, the user's position within the website will be displayed as is shown in the following image:

```
Control Examples > CMSBreadCrumbs
```

### 1.8.5.5.3 Configuration

The following properties of the CMSBreadCrumbs control can be set or used in the API:

All of the common properties from:

- [CMS controls - common properties](#)
- [CMS navigation - common properties](#)

In addition, the following properties are available:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BreadCrumbSeparator</td>
<td>Character(s) that separate the bread crumbs. You can use HTML code here.</td>
<td>&quot;&gt;&gt;&quot;</td>
</tr>
<tr>
<td>BreadCrumbSeparatorRTL</td>
<td>Character(s) that separate the bread crumbs in RTL mode. You can use HTML code here.</td>
<td>&quot;&lt;&lt;&quot;</td>
</tr>
<tr>
<td>DefaultPath</td>
<td>Sets a default path that will be displayed in the breadcrumbs if no path is provided from the current page context.</td>
<td>&quot;/home&quot;</td>
</tr>
<tr>
<td>EncodeName</td>
<td>Indicates whether the items in the breadcrumbs should be HTML encoded.</td>
<td></td>
</tr>
<tr>
<td>IgnoreShowInNavigation</td>
<td>The <strong>ShowInNavigation</strong> document property is ignored if this property is true.</td>
<td></td>
</tr>
<tr>
<td>LoadDataAutomatically</td>
<td>Indicates whether data for the control should be loaded automatically. By default, the data is loaded automatically. For example, you can enter a custom DataSet into the <strong>DataSource</strong> property and then call the <strong>ReloadData(false)</strong> method.</td>
<td></td>
</tr>
<tr>
<td>RenderedHTML</td>
<td>Allows you to get or set the HTML code rendered by the control.</td>
<td></td>
</tr>
<tr>
<td>RenderLinkTitle</td>
<td>Specifies if the document name should be rendered as a TITLE tag of links (for better</td>
<td></td>
</tr>
<tr>
<td>Method Name</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>ReloadData(bool forceLoad)</td>
<td>Reloads the data.</td>
<td></td>
</tr>
</tbody>
</table>

If the `forceLoad` parameter is set to false and a value is assigned to the `DataSource` property, the properties of the CMSBreadCrumbs control are not used and only the data from the DataSource is loaded.

### 1.8.5.5.4 Appearance and styling

The appearance of the CMSBreadCrumbs control is determined by the CSS classes it uses and by some of its properties.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSBreadCrumbsLink</td>
<td>Link (A element) in the bread crumbs path.</td>
</tr>
<tr>
<td>CMSBreadCrumbsCurrentItem</td>
<td>Style of the last item representing the current location.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at **Site Manager -> Development -> CSS stylesheets**. These stylesheets can be applied to individual documents (pages) that contain the control in **CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet**.
1.8.5.6 CMSListMenu

1.8.5.6.1 Overview

The CMSListMenu control allows you to create a large variety of menus. It renders <UL> and <LI> tags and the design depends only on your CSS style sheet. This menu control provides several advantages:

- It's based only on CSS styles which makes it highly configurable.
- It renders shorter HTML code than the CMSMenu control.
- It's fully XHTML compliant.
- The list-based menu is better accessible.
- You can create the drop-down menu using the list-based menu and CSS without almost any JavaScript.
- It automatically displays standard UL/LI listing with links if the browser does not support CSS styles so that the user can still navigate on the website.

However, it requires advanced knowledge of CSS as it doesn't render any specific layout by itself.

It allows you to display part of the CMS menu structure specified using its Path, MaxRelativeLevel, ClassNames, CultureCode and WhereCondition properties.

The portal engine equivalent of the CMSListMenu control is the Navigation -> CSS list menu web part.

The following topics are available to help you familiarize yourself with the CMSListMenu control:

- Getting started - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control
- Appearance and styling - describes and shows examples of how CSS styles can be used with the control

1.8.5.6.2 Getting started

The following is a step-by-step tutorial that will show you how to display a simple menu without any styles containing CMS content using the CMSListMenu control:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSListMenu control from the toolbox onto the form.

3. Switch to the Source tab. The code of the CMSListMenu control should look like this:

```xml
<cms:CMSListMenu ID="CMSListMenu1" runat="server" />
```

Now replace the DOCTYPE above the <HTML> element with the following one:

```xml
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1 Strict//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">
```
4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a UL/LI based menu like this:

- Home
- Services
  - Web Design
  - Web Development
  - Network Administration
- Products
  - Smartphones
  - Laptops and Tablets
  - Software
  - E-Books
  - IT Services
  - Memberships
- News
- Partners
  - Silver Partners
  - Gold Partners
- Community
  - Forums
    - Forum search
  - Blog
  - Events
    - Events list
  - Wiki
    - My contributions
- Company
  - Careers
  - Offices
  - Donate us
- Media

To see how more advanced menus can be rendered using different CSS styles, continue this tutorial in one of the following topics:

- Creating a horizontal drop-down menu using CSS styles
- Creating a vertical drop-down menu using CSS styles

1.8.5.6.3 Configuration

The following properties of the CMSListMenu control can be set or used in the API:

All of the common properties from:

- CMS controls - common properties
- CMS navigation - common properties

In addition, the following properties are available:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayHighlightedItemAsLink</td>
<td>Indicates whether the highlighted item should be displayed as a link.</td>
<td></td>
</tr>
<tr>
<td>DisplayOnlySelectedPath</td>
<td>Indicates whether all sub-menus should be displayed or just the sub-menu under the highlighted (selected) item.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default Value</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>EncodeMenuCaption</td>
<td>Indicates whether HTML encoding should be applied to the captions of menu items. Useful only in special cases where the names of the displayed documents contain HTML code.</td>
<td></td>
</tr>
<tr>
<td>FirstItemCssClass</td>
<td>Specifies the CSS class for the first item on every menu level.</td>
<td>&quot;ListMenuFirstItem&quot;</td>
</tr>
<tr>
<td>HighlightedNodePath</td>
<td>Path of the item that should be highlighted as if it were selected. If you omit this value, the control automatically uses the current alias path from the aliaspath querystring parameter.</td>
<td>&quot;/products/PDAs&quot;</td>
</tr>
<tr>
<td>HoverCSSClassName</td>
<td>Name of the surrounding CSS class that is used to define styles for the hover effect if you want to render a drop-down menu.</td>
<td>&quot;Horizontal&quot;</td>
</tr>
<tr>
<td>ItemIdPrefix</td>
<td>Prefix placed before each item ID. You can use it to keep IDs unique if you have several CMSListMenu controls on the same page.</td>
<td>&quot;submenu&quot;</td>
</tr>
<tr>
<td>LastItemCssClass</td>
<td>Specifies the CSS class for the last item on every menu level.</td>
<td>&quot;ListMenuLastItem&quot;</td>
</tr>
<tr>
<td>LoadDataAutomatically</td>
<td>Indicates whether data for the control should be loaded automatically. By default, the data is loaded automatically. If you set this property to false, you can enter a custom DataSet into the DataSource property and then call the ReloadData(false) method.</td>
<td></td>
</tr>
<tr>
<td>OnMouseOutScript</td>
<td>OnMouseOut script for menu items. You can use macro expressions here.</td>
<td></td>
</tr>
<tr>
<td>OnMouseOverScript</td>
<td>OnMouseOver script for menu items. You can use macro expressions here.</td>
<td></td>
</tr>
<tr>
<td>OrderBy</td>
<td>Gets or sets the ORDER BY clause of the SQL statement. Please be aware that it is necessary for the root of the displayed tree (or sub-tree) to be first in the resulting order, otherwise all documents may not be displayed correctly. This can be ensured by having the value of this property start with the NodeLevel column, such as in the sample value.</td>
<td>&quot;NodeLevel, NodeOrder&quot;</td>
</tr>
<tr>
<td>RenderCssClasses</td>
<td>Indicates whether CSS classes should be rendered for every element. If set to false, only the first and last item of a menu level will use a CSS class.</td>
<td></td>
</tr>
</tbody>
</table>
RenderedHTML

Allows you to get or set the HTML code rendered by the control.

You need to set this property before the Render event - e.g. in the OnLoad event.

RenderImageAlt

Indicates whether the ALT attribute should be rendered for images used in the menu (for XHTML compatibility).

RenderItemID

Indicates whether a unique ID should be rendered for every menu item.

RenderLinkTitle

Specifies if the document name should be rendered as a TITLE tag of links (for better accessibility).

UrlTarget

Specifies the target frame for all URLs. "_blank"

Mentioned method:

<table>
<thead>
<tr>
<th>Method Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReloadData(bool forceLoad)</td>
<td>Reloads the data.</td>
</tr>
</tbody>
</table>

If the `forceLoad` parameter is set to false and a value is assigned to the `DataSource` property, the properties of the CMSListMenu control are not used and only the data from the DataSource is loaded.

1.8.5.6.4 Appearance and styling

1.8.5.6.4.1 General

The appearance of the CMSListMenu control is determined by the CSS classes it uses and by some of its properties.

The following properties can be used to specify used CSS classes:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FirstItemCssClass</td>
<td>Specifies the CSS class for the first item on every menu level.</td>
</tr>
<tr>
<td>HoverCSSClassName</td>
<td>Name of the surrounding CSS class that is used to define styles for the hover effect if you want to render a drop-down menu.</td>
</tr>
<tr>
<td>LastItemCssClass</td>
<td>Specifies CSS class for the last item on every menu level.</td>
</tr>
</tbody>
</table>

You can also modify the design using the following CSS classes if the `RenderCssClasses` property is set to true:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSListMenuUL</td>
<td>UL element style</td>
</tr>
</tbody>
</table>
CMSListMenuLI | LI element style
---|---
CMSListMenuLink | A element style
CMSListMenuHighlightedLI | LI element style of a highlighted item

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at **Site Manager -> Development -> CSS stylesheets**. These stylesheets can be applied to individual documents (pages) that contain the control in **CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet**.

Please refer to **Using the CSSPrefix property** to learn how to add prefixes to these classes to customize items at any menu level.

The name of the CSS class used to render a drop-down menu must be identical to the value entered into the **HoverCSSClassName** property. Please be aware that this is case sensitive.

For examples of CSS styles that render a drop-down menu, please see the following topics:

- Creating a horizontal drop-down menu using CSS styles
- Creating a vertical drop-down menu using CSS styles

1.8.5.6.4.2 Creating a horizontal drop-down menu using CSS styles

This topic shows an example of how the CMSListMenu control can render a horizontal drop-down menu. If you wish to create this example for yourself, please follow the tutorial in the **Getting started** topic, then continue with the following steps:

1. Set the **HoverCSSClassName** property value to: **Horizontal**

The code of the CMSListMenu control should look like this:

```xml
<cms:CMSListMenu ID="CMSListMenu1" runat="server" HoverCSSClassName="Horizontal" />
```

2. Add the following style definitions inside the `<head>` element:

```html
<style type="text/css" media="screen">
/* Horizontal menu class definitions*/
.Horizontal { BORDER-RIGHT: #c2c2c2 1px solid; BORDER-TOP: #c2c2c2 1px solid; FONT-SIZE: 12px; FLOAT: left; BORDER-LEFT: #c2c2c2 1px solid; WIDTH: 100%; BORDER-BOTTOM: #c2c2c2 1px solid; FONT-FAMILY: Arial; BACKGROUND-COLOR: #e2e2e2 }
.Horizontal UL { PADDING-RIGHT: 0px; PADDING-LEFT: 0px; PADDING-BOTTOM: 0px; MARGIN: 0px; WIDTH: 100%; PADDING-TOP: 0px; LIST-STYLE-TYPE: none }
.Horizontal LI { BORDER-RIGHT: #e2e2e2 1px solid; PADDING-RIGHT: 0px; BORDER-LEFT: #e2e2e2 1px solid; DISPLAY: inline; PADDING-LEFT: 0px; FLOAT: left; PADDING-BOTTOM: 0px; BORDER-LEFT: #e2e2e2 1px solid; PADDING-TOP: 0px; BORDER-BOTTOM: #e2e2e2 1px solid }
.Horizontal A { PADDING-RIGHT: 3px; DISPLAY: block; PADDING-LEFT: 3px; PADDING-BOTTOM: 2px; MARGIN: 0px; WIDTH: 112px; COLOR: black; PADDING-TOP: 2px; }
</style>
```
This modifies the CSS style of the menu so that it displays a horizontal drop-down menu.

The classes are defined in the <head> element only for this quick example, if you wish to use the control on a Kentico CMS website, it is recommended to define these classes in the stylesheet used by the website or specific page via the administration interface in Site Manager -> Development -> CSS stylesheets.

3. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a menu like this:

1.8.5.6.4.3 Creating a vertical drop-down menu using CSS styles

This topic shows an example of how the CMSListMenu control can render a vertical drop-down menu. If you wish to create this example for yourself, please follow the tutorial in the Getting started topic, then continue with the following steps:

1. Set the HoverCSSClassName property value to: Vertical

The code of the CMSListMenu control should look like this:

```
<cms:CMSListMenu ID="CMSListMenu1" runat="server" HoverCSSClassName="Vertical" />
```

2. Add the following style definitions inside the <head> element:

```
<style type="text/css" media="screen">
/* Vertical menu class definitions*/
```
This modifies the CSS style of the menu so that it displays a vertical drop-down menu.

The classes are defined in the <head> element only for this quick example, if you wish to use the control on a Kentico CMS website, it is recommended to define these classes in the stylesheet used by the website or specific page via the administration interface in Site Manager -> Development -> CSS stylesheets.

3. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a menu like this:

1.8.5.7 CMSMenu
1.8.5.7.1 Overview

The CMSMenu control allows you to display a multi-level DHTML menu based on data from Kentico CMS.

It allows you to display part of the CMS menu structure specified using its Path, MaxRelativeLevel, ClassNames, CultureCode and WhereCondition properties.

The following image is an example of how the CMSMenu control looks with the Horizontal Layout, including how menu item levels are rendered:
The portal engine equivalent of the CMSMenu control is the **Navigation -> Drop-down menu** web part.

The following topics are available to help you familiarize yourself with the CMSMenu control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - lists which CSS classes can be used with the control and how its appearance can be modified

### 1.8.5.7.2 Getting started

The following is a step-by-step tutorial that will show you how to display a simple DHTML menu containing CMS content using the CMSMenu control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **CMSMenu** control from the toolbox onto the form and set its following properties:

   - **Layout**: Horizontal
   - **ClassNames**: CMS.MenuItem;CMS.Software
   - **CSSPrefix**: Main;Sub

   This tells the control to use a horizontal layout and which types of documents (pages) should be included. In this example, the menu will only display standard pages and software product types, but you can specify any other document types as needed. It also sets the CSS classes that should be used for the main menu and sub-menus. These classes will be defined in the next step. Please refer to **Using the CSSPrefix property** for more information.

3. Switch to the **Source** tab. The code of the CMSMenu control should look like this:

   ```xml
   <cms:CMSMenu ID="CMSMenu1" runat="server" Layout="Horizontal" ClassNames="CMS.MenuItem;CMS.Software" CSSPrefix="Main;Sub" />
   ```
Now add the following code between the tags of the `<head>` element:

```
<style type="text/css">
/* horizontal menu - main menu */
.MainCMSMenu { BORDER-RIGHT: 0px; TABLE-LAYOUT: fixed; BORDER-TOP: 0px; BORDER-LEFT: 0px; WIDTH: 100px; BORDER-BOTTOM: 0px; BACKGROUND-COLOR: #b8bafe }
.MainCMSMenuItem { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana }
.MainCMSMenuItemMouseUp { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana }
.MainCMSMenuItemMouseOver { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: white; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #4a3c8c }
.MainCMSMenuItemMouseDown { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana }
.MainCMSMenuHighlightedMenuItem { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }
.MainCMSMenuHighlightedMenuItemMouseUp { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }
.MainCMSMenuHighlightedMenuItemMouseOver { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }
.MainCMSMenuHighlightedMenuItemMouseDown { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }

/* horizontal menu - sub-menus */
.SubCMSMenuItem { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; BACKGROUND: #e7e7ff; PADDING-BOTTOM: 2px; WIDTH: 100px; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana }
.SubCMSMenuItemMouseUp { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana }
.SubCMSMenuItemMouseOver { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: green }
.SubCMSMenuItemMouseDown { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana }
.SubCMSMenuHighlightedMenuItem { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }
.SubCMSMenuHighlightedMenuItemMouseUp { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }
.SubCMSMenuHighlightedMenuItemMouseOver { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }
.SubCMSMenuHighlightedMenuItemMouseDown { PADDING-RIGHT: 15px; PADDING-LEFT: 5px; FONT-SIZE: 10pt; PADDING-BOTTOM: 2px; WIDTH: 100px; CURSOR: hand; COLOR: black; PADDING-TOP: 2px; FONT-FAMILY: verdana; BACKGROUND-COLOR: #ff7315 }
```
```
This sets the CSS styles that will modify the appearance of the menu. The CMSMenu control renders a menu even without any CSS classes specified, but it is extremely basic and not very user friendly. You can find out what individual CSS classes affect in the Appearance and styling topic.

The classes are defined in the <head> element only for this quick example, if you wish to use the control on a Kentico CMS website, it is recommended to define these classes in the stylesheet used by the website or specific page via the administration interface in Site Manager -> Development -> CSS stylesheets.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should look like this:

<table>
<thead>
<tr>
<th>Home</th>
<th>Services</th>
<th>Products</th>
<th>News</th>
<th>Partners</th>
<th>Community</th>
<th>Company</th>
<th>Media</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Software</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-Books</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>IT Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Memberships</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Microsoft Office Professional 2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Microsoft Windows 7 Ultimate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1.8.5.7.3 Configuration

The following properties of the CMSMenu control can be set or used in the API:

All of the common properties from:

- CMS controls - common properties
- CMS navigation - common properties

In addition, the following properties are available:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor</td>
<td>Determines the mouse cursor used when controlling the menu.</td>
<td>&quot;Default&quot; &quot;Pointer&quot;</td>
</tr>
<tr>
<td>EnableMouseUpDownClass</td>
<td>Indicates whether the menu should render different CSS classes for mouse-up and mouse-down events.</td>
<td></td>
</tr>
<tr>
<td>EnableRTLBehaviour</td>
<td>Indicates whether a right-to-left layout should be used on documents displayed in a RTL culture.</td>
<td></td>
</tr>
<tr>
<td>EncodeMenuCaption</td>
<td>Indicates whether HTML encoding should be applied to the captions of menu items. Useful only in special cases where the</td>
<td></td>
</tr>
</tbody>
</table>
names of the displayed documents contain HTML code.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExternalScriptPath</td>
<td>Path of the external .js file with skmMenu scripts. The default path is ~/cmsscripts/skmmenu.js.</td>
</tr>
<tr>
<td>HighlightedMenuItem</td>
<td>This property can be used to get the currently highlighted menu item and set its CSS classes.</td>
</tr>
<tr>
<td>HighlightedNodePath</td>
<td>Path of the item that should be highlighted as if it were selected. If you omit this value, the control automatically uses the current alias path from the aliaspath querystring parameter.</td>
</tr>
<tr>
<td>Layout</td>
<td>Determines the layout of the menu.</td>
</tr>
<tr>
<td>MenuControl</td>
<td>This property can be used to access the menu (skmMenu) control and its CSS classes and properties.</td>
</tr>
<tr>
<td>Padding</td>
<td>Padding of the CMSMenu table.</td>
</tr>
<tr>
<td>RenderImageAlt</td>
<td>Indicates whether the ALT attribute should be rendered for images used in the menu (for XHTML compatibility).</td>
</tr>
<tr>
<td>RenderItemName</td>
<td>Indicates if the ItemName attribute of menu items should be rendered in the output HTML code.</td>
</tr>
<tr>
<td>SeparatorCssClass</td>
<td>CSS class of the separator cell (TD element) for the top menu level.</td>
</tr>
<tr>
<td>SeparatorHeight</td>
<td>Height of the separator placed between menu items of the top menu level.</td>
</tr>
<tr>
<td>SeparatorText</td>
<td>Text of the separator placed between menu items of the first menu level.</td>
</tr>
<tr>
<td>Spacing</td>
<td>Spacing of the CMSMenu table.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Method Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReloadData(bool forceLoad)</td>
<td>Reloads the data. If the forceLoad parameter is set to false and a value is assigned to the DataSource property, the properties of the CMSMenu control are not used and only the data from the DataSource is loaded.</td>
</tr>
</tbody>
</table>
1.8.5.4 Appearance and styling

The appearance of the CMSMenu control is determined by the CSS classes it uses and by some of its properties.

You can also use the following CSS classes:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSMenu</td>
<td>CSS class of the menu table.</td>
</tr>
<tr>
<td>CMSMenuItem</td>
<td>CSS class of menu items.</td>
</tr>
<tr>
<td>CMSMenuItemMouseDown</td>
<td>CSS class of menu items when the mouse button is down.</td>
</tr>
<tr>
<td>CMSMenuItemMouseOver</td>
<td>CSS class of a menu item when a user moves the mouse cursor over it.</td>
</tr>
<tr>
<td>CMSMenuItemMouseUp</td>
<td>CSS class of menu items when the mouse button is released.</td>
</tr>
<tr>
<td>CMSMenuHighlightedMenuItem</td>
<td>CSS class of highlighted menu items.</td>
</tr>
<tr>
<td>CMSMenuHighlightedMenuItemMouseDown</td>
<td>CSS class of highlighted menu items when the mouse button is down.</td>
</tr>
<tr>
<td>CMSMenuHighlightedMenuItemMouseOver</td>
<td>CSS class of a highlighted menu item when a user moves the mouse cursor over it.</td>
</tr>
<tr>
<td>CMSMenuHighlightedMenuItemMouseUp</td>
<td>CSS class of highlighted menu items when the mouse button is released.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at **Site Manager -> Development -> CSS stylesheets**. These stylesheets can be applied to individual documents (pages) that contain the control in **CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet**.

Please refer to [Using the CSSPrefix property](#) to learn how to add prefixes to these classes to customize items at any menu level.

1.8.5.8 CMSSiteMap

1.8.5.8.1 Overview

The CMSSiteMap control allows you to display the whole navigation structure of a website or just its specified part. It reads CMS documents and renders their structure as a site map.

It allows you to display part of the CMS menu structure specified using its **Path**, **MaxRelativeLevel**, **ClassNames**, **CultureCode** and **WhereCondition** properties.

Only documents that have their **Show in sitemap** setting enabled in **CMS Desk -> Content -> Edit -> Properties -> Menu** will be displayed by this control.

The portal engine equivalent of the CMSSiteMap control is the **Navigation -> Site map** web part.

The following topics are available to help you familiarize yourself with the CMSSiteMap control:
Getting started - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
Configuration - describes and explains the properties that can be set for the control
Appearance and styling - describes and shows an example of how CSS styles can be used with the control

1.8.5.8.2 Getting started

The following is a step-by-step tutorial that will show you how to display a site map based on CMS content using the CMSSiteMap control:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSSiteMap control from the toolbox onto the form.

3. Switch to the Source tab. The code of the CMSSiteMap control should look like this:

```xml
<cms:CMSSiteMap ID="CMSSiteMap1" runat="server" />
```

4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should look like this:

- Home
- Services
  - Web Design
  - Web Development
  - Network Administration
- Products
  - Smartphones
  - Laptops and Tablets
  - Software
  - E-Books
  - IT Services
  - Memberships
- News
- Partners
  - Silver Partners
  - Gold Partners
- Community
  - Forums
    - Forum search
  - Blogs
  - Events
    - Events list
  - Wiki
    - My contributions
- Company
  - Careers

Continue this tutorial in the Appearance and styling topic to see how CSS styles can be applied to the CMSSiteMap control.
The following properties of the CMSSiteMap control can be set or used in the API:

All of the common properties from:

- [CMS controls - common properties](#)
- [CMS navigation - common properties](#)

In addition, the following properties are available:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ApplyMenuInactivation</strong></td>
<td>If checked, documents in the site map that are set as <strong>Inactive menu items</strong> will not be rendered as links. This setting can be configured for individual documents in CMS Desk -&gt; Content -&gt; Edit -&gt; Properties -&gt; Menu.</td>
<td></td>
</tr>
<tr>
<td><strong>EncodeMenuCaption</strong></td>
<td>Indicates whether HTML encoding should be applied to the captions of site map items. Useful only in special cases where the names of the displayed documents contain HTML code.</td>
<td></td>
</tr>
<tr>
<td><strong>LoadDataAutomatically</strong></td>
<td>Indicates whether data for the control should be loaded automatically. This is performed by default.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If you set this property to false, you can enter a custom DataSet into the <strong>DataSource</strong> property and then call the <strong>ReloadData(false)</strong> method.</td>
<td></td>
</tr>
<tr>
<td><strong>OrderBy</strong></td>
<td>Gets or sets the ORDER BY clause of the SQL statement.</td>
<td>&quot;NodeLevel, NodeOrder&quot;</td>
</tr>
<tr>
<td></td>
<td>Please be aware that it is necessary for the root of the displayed tree (or sub-tree) to be <strong>first</strong> in the resulting order, otherwise all documents may not be displayed correctly. This can be ensured by having the value of this property start with the <strong>NodeLevel</strong> column, such as in the sample value.</td>
<td></td>
</tr>
<tr>
<td><strong>RenderedHTML</strong></td>
<td>Allows you to get or set the HTML code rendered by the control.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You need to set this property before the Render event - e.g. in the OnLoad event.</td>
<td></td>
</tr>
<tr>
<td><strong>RenderLinkTitle</strong></td>
<td>If enabled, the site map will render document names as <strong>Title</strong> attributes (tooltips) for all links. This can improve the accessibility of</td>
<td></td>
</tr>
</tbody>
</table>
UrlTarget  Specifies the target frame for all links in the site map.  "_blank"

Mentioned method:

<table>
<thead>
<tr>
<th>Method Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReloadData(bool forceLoad)</td>
<td>Reloads the data. If the forceLoad parameter is set to false and a value is assigned to the DataSource property, the properties of the CMSSiteMap control are not used and only the data from the DataSource is used.</td>
</tr>
</tbody>
</table>

1.8.5.8.4 Appearance and styling

The appearance of the CMSSiteMap control is determined by the CSS classes it uses and by some of its properties.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSSiteMapList</td>
<td>The UL element in the site map.</td>
</tr>
<tr>
<td>CMSSiteMapListItem</td>
<td>The LI element in the site map.</td>
</tr>
<tr>
<td>CMSSiteMapLink</td>
<td>Link (A element) in the site map.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at Site Manager -> Development -> CSS stylesheets. These stylesheets can be applied to individual documents (pages) that contain the control in CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet.

Example

The following is an example of how CSS styles can be applied to a CMSSiteMap control. If you wish to create this example for yourself, please follow the tutorial in the Getting started topic, then continue with the following steps:

1. Add the following style definitions inside the <head> element:

```html
<style type="text/css">
/* Site map class definitions */
.CMSSiteMapList { }  
.CMSSiteMapListItem { list-style-type: square; }  
.CMSSiteMapLink { color: #C34C17; text-decoration:none; }
</style>
```
This will modify the appearance of the site map.

2. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should look like this:

- Home
- Services
  - Web Design
  - Web Development
  - Network Administration
- Products
  - Smartphones
  - Laptops and Tablets
  - Software
  - E-Books
  - IT Services
  - Memberships
- News
- Partners
  - Silver Partners
  - Gold Partners
- Community
  - Forums
    - Forum search
    - Blog

1.8.5.9 CMSTabControl

1.8.5.9.1 Overview

The CMSTabControl control allows you to display a one-level tab menu based on data from Kentico CMS. It reads the specified documents and renders the menu according to their values.

It allows you to display part of the CMS menu structure specified using its Path, MaxRelativeLevel, ClassNames, CultureCode and WhereCondition properties.

It is derived from the BasicTabControl control, but it doesn’t require any additional code to work and is extended to contain a set of common properties for CMS navigation controls.

The portal engine equivalent of the CMSTabControl control is the Navigation -> Tab menu web part.

The following topics are available to help you familiarize yourself with the CMSTabControl control:

- Getting started - contains a step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control
- Appearance and styling - describes and shows an example of how CSS styles can be used with the control

1.8.5.9.2 Getting started

The following is a step-by-step tutorial that will show you how to display a tab menu based on CMS content using the CMSTabControl control:

1. Create a new Web form somewhere in your website installation directory.
2. Switch to its **Design** tab, drag and drop a **CMSTabControl** control from the toolbox onto the form and set its following properties:

- **MaxRelativeLevel**: 1
- **SelectFirstItemByDefault**: True

This makes sure that only documents from the first level are displayed and that the first tab is selected by default.

3. Switch to the **Source** tab. The code of the CMSTabControl control should look like this:

```xml
<cms:CMSTabControl ID="CMSTabControl1" runat="server" MaxRelativeLevel="1" SelectFirstItemByDefault="True" />
```

Now add the following code between the tags of the `<head>` element:

```xml
<style type="text/css">
/* Tab menu class definitions */
.TabControlTable { FONT-SIZE: 14px; FONT-FAMILY: Arial,Verdana }
.TabControlRow { }
.TabControl { BORDER-RIGHT: black 1px solid; BORDER-LEFT: black 1px solid; FONT-WEIGHT: bold; BACKGROUND: #e7e7ff; BORDER-TOP: black 1px solid; CURSOR: hand; COLOR: black }
.TabControlSelected { BORDER-RIGHT: black 1px solid; BORDER-LEFT: black 1px solid; FONT-WEIGHT: bold; BACKGROUND: #4a3c8c; BORDER-TOP: black 1px solid; CURSOR: default; COLOR: white }
.TabControlLinkSelected { COLOR: white; TEXT-DECORATION: none }
.TabControlLink { COLOR: black; TEXT-DECORATION: none }
.TabControlLeft { WIDTH: 1px }
.TabControlRight { WIDTH: 0px }
.TabControlSelectedLeft { WIDTH: 1px }
.TabControlSelectedRight { WIDTH: 0px }
</style>
```

This sets the CSS styles that will modify the appearance of the tab menu. The CMSTabControl control renders tabs even without any CSS classes specified, but they are extremely basic. You can find out what individual CSS classes affect in the **Appearance and styling** topic.

The classes are defined in the `<head>` element only for this quick example, if you wish to use the control on a Kentico CMS website, it is recommended to define these classes in the used stylesheet in the administration interface at **Site Manager -> Development -> CSS stylesheets**.

4. Add the following code just after the `<cms:CMSTabControl>` element. It will display a stripe under the tabs.

```xml
<hr style="width:100%; height:2px; margin-top:0px;" />
```

5. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a tab menu like this:
1.8.5.9.3 Configuration

As it is inherited from the BasicTabControl control, the CMSTabControl control has all of its properties. These can be found in the BasicTabControl -> Configuration topic.

In addition, it has the following properties that can be set or used in the API:

Those of the common properties that have meaning for a single level tab menu:

- CMS controls - common properties
- CMS navigation - common properties

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>EncodeMenuCaption</td>
<td>Indicates whether HTML encoding should be applied to the captions of menu items. Useful only in special cases where the names of the displayed documents contain HTML code.</td>
<td></td>
</tr>
<tr>
<td>HighlightedNodePath</td>
<td>Path of the item that should be highlighted as if selected. If you omit this value, the control automatically uses the current alias path from the aliaspath querystring parameter.</td>
<td>&quot;/products/notebooks&quot;</td>
</tr>
<tr>
<td>LoadDataAutomatically</td>
<td>Indicates whether data for the control should be loaded automatically. This is performed by default. If you set this property to false, you can enter a custom DataSet into the DataSource property and then call the ReloadData(false) method.</td>
<td></td>
</tr>
<tr>
<td>RenderImageAlt</td>
<td>Indicates whether the ALT attribute should be rendered for images used in the menu (for XHTML compatibility).</td>
<td></td>
</tr>
</tbody>
</table>

Mentioned method:

<table>
<thead>
<tr>
<th>Method Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReloadData(bool forceLoad)</td>
<td>Reloads the data. If the forceLoad parameter is set to false and a value is assigned to</td>
</tr>
</tbody>
</table>
the **DataSource** property, the properties of the CMSTabControl control are not used and only the data from the DataSource is loaded.

1.8.5.9.4 Appearance and styling

The appearance of the CMSTabControl control is determined by the CSS classes it uses and by some of its properties.

It uses the same CSS classes as the BasicTabControl, which it inherits. These can be found at [BasicTabControl -> Appearance and styling](#).

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at **Site Manager -> Development -> CSS stylesheets**. These stylesheets can be applied to individual documents (pages) that contain the control in **CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet**.

1.8.5.10 CMSTreeMenu

1.8.5.10.1 Overview

The CMSTreeMenu control allows you to display a multi-level tree menu based on data from Kentico CMS.

It allows you to display part of the CMS menu structure specified using its **Path**, **MaxRelativeLevel**, **ClassNames**, **CultureCode** and **WhereCondition** properties.

The portal engine equivalent of the CMSTreeMenu control is the **Navigation -> Tree menu** web part.

The following topics are available to help you familiarize yourself with the CMSTreeMenu control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes and shows an example of how CSS styles can be used with the control

1.8.5.10.2 Getting started

The following is a step-by-step tutorial that will show you how to display a tree menu based on CMS content using the CMSTreeMenu control:

1. Create a new **Web form** and use it as a page template according to the guide in the **Using ASPX page templates** topic.

2. Switch to its **Design** tab, drag and drop a **CMSTreeMenu** control from the toolbox onto the form.

3. Switch to the **Source** tab. The code of the CMSTreeMenu control should look like this:

   ```xml
   <cms:CMSTreeMenu ID="CMSTreeMenu1" runat="server" />
   ```
4. Save the changes to the web form. Now if you look at the page using the created template on the sample Corporate Site, an unstyled tree menu will be displayed.

Continue this tutorial in the **Appearance and styling** topic to see how CSS styles can be applied to the CMSTreeMenu control.

### 1.8.5.10.3 Configuration

The following properties of the CMSTreeMenu control can be set or used in the API:

All of the common properties from:

- [CMS controls - common properties](#)
- [CMS navigation - common properties](#)

In addition, the following properties are available:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CellPadding</td>
<td>Cell padding of the table representing the menu.</td>
<td></td>
</tr>
<tr>
<td>CellSpacing</td>
<td>Cell spacing of the table representing the menu.</td>
<td></td>
</tr>
<tr>
<td>CollapseSelectedNode OnClick</td>
<td>Indicates whether the selected section of the menu should be collapsed when clicked.</td>
<td></td>
</tr>
<tr>
<td>DisplayHighlightedItem AsLink</td>
<td>Indicates whether highlighted items should be displayed as a link.</td>
<td></td>
</tr>
<tr>
<td>EncodeMenuCaption</td>
<td>Indicates whether HTML encoding should be applied to the captions of menu items. Useful only in special cases where the names of the displayed documents contain HTML code.</td>
<td></td>
</tr>
<tr>
<td>GenerateAllSubItems</td>
<td>Indicates whether all sub-items should be generated</td>
<td></td>
</tr>
<tr>
<td>GenerateIndentationInsideLink</td>
<td>Indicates whether indentation spaces should be generated inside hyperlinks (true) or outside (false). This applies only when you do not use images in the menu.</td>
<td></td>
</tr>
<tr>
<td>GenerateOnlyOuterLink</td>
<td>Indicates whether only one outer link should be generated per each menu item.</td>
<td></td>
</tr>
<tr>
<td>HighlightedNodePath</td>
<td>Path of the item that should be highlighted as if it were selected. If you omit this value, the control automatically uses the current alias path from the <strong>aliaspath</strong> querystring parameter.</td>
<td>&quot;/products&quot;</td>
</tr>
<tr>
<td>Indentation</td>
<td>Indentation of menu item levels. Number of</td>
<td></td>
</tr>
</tbody>
</table>

© 2012 Kentico Software
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ItemIDPrefix</td>
<td>Prefix placed before each item ID. You can use it to keep IDs unique if you have several CMSTreeMenu controls on the same page.</td>
<td>&quot;submenu&quot;</td>
</tr>
<tr>
<td>LoadDataAutomatically</td>
<td>Indicates whether data for the control should be loaded automatically. By default, the data is loaded automatically. If you set this property to false, you can enter a custom DataSet into the DataSource property and then call the ReloadData(false) method.</td>
<td></td>
</tr>
<tr>
<td>MenuItemImageUrl</td>
<td>URL address of the image that is displayed next to menu items. It may start with &quot;~/&quot; representing the virtual path of the current application.</td>
<td></td>
</tr>
<tr>
<td>MenuItemOpenImageUrl</td>
<td>URL address of the image that is displayed next to open menu items. It may start with &quot;~/&quot; representing the virtual path of the current application.</td>
<td></td>
</tr>
<tr>
<td>OnMouseOutScript</td>
<td>OnMouseOut script for menu items. You can use macro expressions here.</td>
<td></td>
</tr>
<tr>
<td>OnMouseOverScript</td>
<td>OnMouseOver script for menu items. You can use macro expressions here.</td>
<td></td>
</tr>
<tr>
<td>OrderBy</td>
<td>Gets or sets the ORDER BY clause of the SQL statement. Please be aware that it is necessary for the root of the displayed tree (or sub-tree) to be first in the resulting order, otherwise all documents may not be displayed correctly. This can be ensured by having the value of this property start with the NodeLevel column, such as in the sample value.</td>
<td>&quot;NodeLevel, NodeOrder&quot;</td>
</tr>
<tr>
<td>RenderedHTML</td>
<td>Allows you to get or set the HTML code rendered by the control. You need to set this property before the Render event - e.g. in the OnLoad event.</td>
<td></td>
</tr>
<tr>
<td>RenderImageAlt</td>
<td>Indicates whether the ALT attribute should be rendered for images used in the menu (for XHTML compatibility).</td>
<td></td>
</tr>
<tr>
<td>RenderLinkTitle</td>
<td>Specifies if the document name should be rendered as a TITLE tag of links (for better accessibility).</td>
<td></td>
</tr>
</tbody>
</table>
RenderSubItems | Indicates whether sub-items should be rendered under the selected item.
--- | ---
UrlTarget | Specifies the target frame for all URLs. | "_blank"

Mentioned method:

<table>
<thead>
<tr>
<th>Method Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reloadData(bool forceLoad)</td>
<td>Reloads the data. If the <code>forceLoad</code> parameter is set to false and a value is assigned to the <code>DataSource</code> property, the properties of the CMSTreeMenu control are not used and only the data from the DataSource is loaded.</td>
</tr>
</tbody>
</table>

1.8.5.10.4 Appearance and styling

The appearance of the CMSTreeMenu control is determined by the CSS classes it uses and by some of its properties.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSTreeMenuTable</td>
<td>The main table (TABLE element).</td>
</tr>
<tr>
<td>CMSTreeMenuItem</td>
<td>Tree menu item (TD element).</td>
</tr>
<tr>
<td>CMSTreeMenuItemAlt</td>
<td>Alternating style of the menu item (TD element). It’s used only when you set the <code>UseAlternatingStyles</code> property to true.</td>
</tr>
<tr>
<td>CMSTreeMenuSelectedItem</td>
<td>Selected tree menu item (TD element).</td>
</tr>
<tr>
<td>CMSTreeMenuLink</td>
<td>Link (A element).</td>
</tr>
<tr>
<td>CMSTreeMenuLinkAlt</td>
<td>Alternating style of the link (A element). It’s used only when you set the <code>UseAlternatingStyles</code> property to true.</td>
</tr>
<tr>
<td>CMSTreeMenuSelectedLink</td>
<td>Link of the selected item (A element).</td>
</tr>
<tr>
<td>CMSTreeMenuNestedTable</td>
<td>Nested table (TABLE element). It’s used only when <code>CollapseSelectedNodeOnClick</code> is true.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at Site Manager -> Development -> CSS stylesheets. These stylesheets can be applied to individual documents (pages) that contain the control in CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet.

Please refer to Using the CSSPrefix property to learn how to add prefixes to these classes to customize items at any menu level.

Example
The following is an example of how CSS styles can be applied to a CMSTreeMenu control. If you wish to create this example for yourself, please follow the tutorial in the Getting started topic, then continue with the following steps:

1. Set the following properties of the CMSTreeMenu control:

   - **Indentation**: 5

   This specifies the indentation used for lower menu levels.

   The code of the control should now look like the following:

   ```
   <cms:CMSTreeMenu ID="CMSTreeMenu1" runat="server" Indentation="5" />
   ```

   Save the changes to the web form.

2. Now log in to the sample Corporate Site, go to Site Manager -> Development -> CSS stylesheets, edit the Corporate Site stylesheet and add the following classes:

   ```
   /* Tree Menu design */
   .CMSTreeMenuTable
   {
       width: 100%;
   }

   .CMSTreeMenuTable a
   {
       white-space: nowrap;
   }

   .subCMSTreeMenuTable
   {
       margin-left: 10px;
   }

   .CMSTreeMenuTable a:hover
   {
       text-decoration: underline;
   }

   .CMSTreeMenuItem
   {
       background: #e7e7ff;
       padding: 3px 0px;
   }

   .CMSTreeMenuSelectedItem
   {
       background: #4a3c8c;
       padding: 3px 0px;
       color: white;
   }

   .CMSTreeMenuLink
   ```
This will modify the appearance of the tree menu. The created page should use this stylesheet by default.

3. Now if you look at the page using the created template on the website, the tree menu will have its appearance modified:

The CMSTreeView control allows you to display a multi-level tree menu based on data from Kentico CMS.

It allows you to display part of the CMS menu structure specified using its Path, MaxRelativeLevel, ClassNames, CultureCode and WhereCondition properties.

This control is derived from the intrinsic ASP.NET TreeView control and enhances it to automatically read CMS documents and adds a set of additional properties. Please see the ASP.NET documentation for more details on the properties, behavior and design of the TreeView control.

The portal engine equivalent of the CMSTreeView control is the Navigation -> Tree view web part.

The following topics are available to help you familiarize yourself with the CMSTreeView control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes and shows an example of how CSS styles can be used with the control
1.8.5.11.2 Getting started

The following is a step-by-step tutorial that will show you how to display a tree menu based on CMS content using the CMSTreeView control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **CMSTreeView** control from the toolbox onto the form.

3. Switch to the **Source** tab. The code of the CMSTreeView control should look like this:

```xml
<cms:CMSTreeView ID="CMSTreeView1" runat="server"/>
</cms:CMSTreeView>
```

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a menu like this:

- **Corporate Site**
  - Home
  - Services
    - Web Design
    - Web Development
    - Network Administration
  - Products
  - News
  - Partners
  - Community
  - Company
  - Media
  - Examples
  - Mobile

1.8.5.11.3 Configuration

The following properties of the CMSTreeView control can be set or used in the API:

Most of the common properties from:

- **CMS controls - common properties**
- **CMS navigation - common properties**

In addition, the following properties are available:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayDocumentTypeImages</td>
<td>If true, the images used for items in the tree will be loaded according to the document type of the given item.</td>
<td></td>
</tr>
<tr>
<td>DynamicBehaviour</td>
<td>If true, populate on demand will be enabled. In this case, sub-items will be loaded.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>EncodeMenuCaption</td>
<td>Indicates whether HTML encoding should be applied to the captions of menu items. Useful only in special cases where the names of the displayed documents contain HTML code.</td>
<td></td>
</tr>
<tr>
<td>ExpandAllOnStartup</td>
<td>Indicates whether all nodes in the tree should be expanded by default.</td>
<td></td>
</tr>
<tr>
<td>ExpandCurrentPath</td>
<td>Indicates whether all nodes along the path to the currently selected item should be expanded by default.</td>
<td></td>
</tr>
<tr>
<td>ExpandSubTree</td>
<td>Indicates whether the sub-tree under the currently selected item should be expanded by default.</td>
<td></td>
</tr>
<tr>
<td>FixBrokenLines</td>
<td>Indicates whether broken lines should be fixed.</td>
<td></td>
</tr>
<tr>
<td>HideRootNode</td>
<td>Indicates whether the root node should be hidden.</td>
<td></td>
</tr>
<tr>
<td>HighlightSelectedItem</td>
<td>Indicates whether the currently selected item should be highlighted.</td>
<td></td>
</tr>
<tr>
<td>IgnoreDocumentMenuAction</td>
<td>Indicates whether the Menu actions document menu settings should be ignored. These can be set at CMS Desk -&gt; Content -&gt; ... select document ... -&gt; Properties -&gt; Menu -&gt; Menu actions section. This is necessary if you wish to use an onClick Javascript action defined by the OnClickAction property.</td>
<td></td>
</tr>
<tr>
<td>InactivateAllItemsInPath</td>
<td>If enabled, all nodes on the path of the currently selected document will be inactive (will not perform any action when clicked).</td>
<td></td>
</tr>
<tr>
<td>InactivateSelectedItem</td>
<td>If enabled, the node of the currently selected document will be inactive.</td>
<td></td>
</tr>
<tr>
<td>InactiveNodeImage</td>
<td>Indicates if the images displayed next to nodes should also perform the specified action for the given item when clicked.</td>
<td></td>
</tr>
<tr>
<td>InactiveRoot</td>
<td>Indicates whether the root node should be inactive.</td>
<td></td>
</tr>
</tbody>
</table>
### NodeImageUrl
Gets or sets the path to the image that is displayed next to regular nodes in the tree.  
~App_Themes/Site/Images/treeitem.gif

### OnClickAction
Gets or sets the JavaScript command that will be executed when a user clicks on an item in the tree. If empty, the items in the tree will serve as links to the corresponding documents.

### OrderBy
Gets or sets the ORDER BY clause of the SQL statement.

Please be aware that it is necessary for the root of the displayed tree (or sub-tree) to be first in the resulting order, otherwise all documents may not be displayed correctly. This can be ensured by having the value of this property start with the NodeLevel column, such as in the sample value.

### RootImageUrl
Gets or sets the path to the image that is displayed next to the root node of the tree.  
~App_Themes/Site/Images/root.gif

### RootText
Gets or sets the text caption of the root node in the tree. This text is displayed instead of the document name of the item in the root of the tree.

As this control is inherited from the ASP.NET TreeView control, it also has all of its standard properties.

#### Appearance and styling

You can adjust the appearance of the CMSTreeView control by setting the inherited standard properties of the ASP.NET TreeView control. You can find more details on particular properties in the .NET Framework documentation.

The design of the CMSTreeView control can additionally be modified by its following properties and the CSS classes that they specify:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>InactiveItemClass</td>
<td>CSS class of inactive items.</td>
<td></td>
</tr>
<tr>
<td>InactiveItemStyle</td>
<td>Style of inactive items.</td>
<td></td>
</tr>
<tr>
<td>SelectedItemClass</td>
<td>CSS class of selected items.</td>
<td></td>
</tr>
<tr>
<td>SelectedItemStyle</td>
<td>Style of selected items.</td>
<td></td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at Site Manager -> Development -> CSS stylesheets. These stylesheets can be applied to individual documents (pages) that contain the control in CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet.
1.8.6 Listings and viewers

1.8.6.1 Overview

The controls in this section provide various ways to display documents and their data from the Kentico CMS database.

Available categories:

- Standard listings and viewers
- Listings and viewers with a custom query

1.8.6.2 Standard listings and viewers

1.8.6.2.1 Overview

The controls in this section provide various ways to display document data from the Kentico CMS database. Options include several types of lists, tables, calendars and more.

Most of these controls inherit a corresponding control from the Basic Listings and viewers section and extend it by integrating a data source for Kentico CMS documents.

These controls also support the use of Transformations.

If you wish to display more complex data structures containing multiple hierarchical levels and different document types, you can do so by nesting the controls within each other. For more information about this and an example, please refer to the Using nested controls topic. Alternatively, look into using the CMSUniView control in combination with hierarchical transformations.

Documents in Kentico CMS can be connected to other documents through relationships. Learn more about how the controls in this section can work with relationships in the Displaying related documents topic.

Available controls:

- CMSCalendar
- CMSDataGrid
- CMSDataList
- CMSSDocumentValue
- CMSRepeater
- CMSUniView
- CMSViewer

1.8.6.2.2 Using nested controls

A nested control is one that is defined within a transformation or template used by another control. When utilized with listing controls, this can be employed to display hierarchical data. The following controls may contain other nested controls:

- CMSDataList
- CMSRepeater

© 2012 Kentico Software
Please note

The CMSUniview control provides a way to display hierarchical data without the need for nested controls and using it instead is recommended, as it offers superior performance.

These controls have the NestedControlsID property, which ensures that the correct content Path is dynamically provided to nested controls.

The controls can be combined as required. Other controls, such as the CMSDataGrid for example, may be nested into one of the controls above, but cannot contain nested controls themselves.

If you need to dynamically set the properties of a nested control, it is necessary to set its DelayedLoading property to True.

The same approach can also be used for listing web parts when using the portal engine.

Example: Displaying a nested (hierarchical) repeater/datalist

This tutorial shows how you can use a hierarchical CMSRepeater/CMSDatalist combination to display a list of product categories and a preview of products in each category from the products section of the sample Corporate Site:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSRepeater control from the toolbox onto the form and set its following properties:
   - Path: /products/%
   - ClassNames: cms.menuitem
   - NestedControlsID: CMSDataListNested
   - OrderBy: NodeOrder

   This specifies the Path to the products section, tells the control to read pages (menu item documents) and specifies the ID of the nested control that will be used in the next step. It also orders the retrieved pages according to the order that they have in the CMS Desk content tree.

3. Switch to the Source tab and add the code marked by the CMSRepeater template comments between the <cms:CMSRepeater> tags. The overall code of the CMSRepeater control should look like this:

```xml
<ajaxToolkit:ToolkitScriptManager ID="manScript" runat="server" EnableViewState="false" />

<cms:CMSRepeater ID="CMSRepeater1" runat="server" Path="/products/%" ClassNames="CMS.MenuItem"
NestedControlsID="CMSDataListNested" OrderBy="NodeOrder" >

   <!-- CMSRepeater template -->
   -----------------------------------------------------------

```
This defines the template used by the CMSRepeater to display items. As you can see, it contains a nested CMSDataList control that is configured to display all product types in two columns using the specified transformation and its ID is the same as the value that was entered into the NestedControlsID property of the main CMSRepeater. Please note that its Path property is not specified, as it is dynamically supplied by the main CMSRepeater control.

The same result could also be achieved by placing the CMSDataList into the code of a transformation, and assigning that transformation to the CMSRepeater through its TransformationName property.

The ToolkitScriptManager control included at the top is required by the transformation used to display the product documents. It is only there to ensure that this example is functional by itself and will usually be included on your website's master page.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a hierarchical list as shown below (the image is from a page that uses the Corporate Site stylesheet, which styles the displayed products appropriately).
1.8.6.2.3 Displaying related documents

If a Kentico CMS document is related to some other documents, these can be displayed using one of the following controls:

- CMSCalendar
- CMSDataGrid
- CMSDataList
- CMSRepeater
- CMSUniView
- CMSViewer

All of them have the following three properties that can be set in order to display related documents (besides other properties, such as Path, ClassNames, etc.):

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
</table>

© 2012 Kentico Software
RelatedNodeIsOnTheLeftSide | Indicates whether the related document is on the left or right side of the relationship.
---|---
RelationshipName | Code name of the relationship. | "isrelatedto"
RelationshipWithNodeGUID | If set, only documents related to the document with the entered NodeGUID value will be selected.
| Entering the "11111111-1111-1111-1111-111111111111" value will select documents related to the current document.
| "36f8c4bc-f702-4736-8a25-a82295668794"

More information about related documents can be found at Developer's Guide -> Content management -> Document properties -> Related docs.

Example

The following example shows how to create an ASPX page template that displays news items related to the current page by using the CMSRepeater control:

1. Now open the Kentico CMS web project in Visual Studio and create a new Web form called RelationshipExample.aspx in the CMSTemplates/CorporateSite folder and check the Select master page box. When the Select a Master Page dialog appears, choose the root.master default master page from the CMSTemplates/CorporateSite folder.

2. Switch to the Source view of the newly created web form and add the following line under the < %@ Page % > directive:

```xml
<%@ Register Assembly="CMS.Controls" Namespace="CMS.Controls" TagPrefix="cms" %>
```

3. Switch to the code behind. You need to add a reference to the CMS.UIControls namespace:

```csharp
using CMS.UIControls;
```

4. Modify the class from which the page is inherited. Change the following code:

```csharp
public partial class CMSTemplates_CorporateSiteAspx_RelationshipExample : System.Web.UI.Page
```

to this:

```csharp
public partial class CMSTemplates_CorporateSiteAspx_RelationshipExample : System.Web.UI.Page
```
Now the page can be correctly used as a page template in Kentico CMS.

Please keep in mind that the name of the class must be identical to the value of the Inherits attribute of the %@ Page % directive on the ASPX page. This is case sensitive.

5. Switch to its Design tab, drag and drop a CMSRepeater control from the toolbox onto the form and set its following properties:

- **ClassNames**: CMS.News
- **Path**: /News/%
- **TransformationName**: cms.news.preview
- **RelationshipName**: isrelatedto
- **RelationShipWithNodeGUID**: 11111111-1111-1111-1111-111111111111

This tells the control to read news documents, specifies the path to the News section of the sample Corporate Site, assigns the transformation that should be used to display the news documents and tells the control to display only documents that are in the isrelatedto relationship with the currently selected document.

The overall code of the CMSRepeater control will look like this:

```xml
<cms:CMSRepeater ID="CMSRepeater1" runat="server" ClassNames="CMS.News" Path="/News/%" TransformationName="cms.news.preview" RelationshipName="isrelatedto" RelationShipWithNodeGUID="11111111-1111-1111-1111-111111111111" />
```

6. Save the changes to the web form.

7. Now open the sample Corporate Site, go to Site Manager -> Development -> Page templates, select the Corporate Site/Examples category and create a new template. Enter the following properties:

- **Template display name**: Related news
- **Template code name**: RelatedNews

Click OK. Press the Select button next to the File name field and choose the RelationshipExample.aspx web form from the CMSTemplates/CorporateSite folder.

Click Save.

8. Switch to the Sites tab, press Add sites and select Corporate Site.

9. Switch to CMS Desk, select Services from the content tree and create a new Page (menu item) called under it, enter New Service 1 into the Page name field and select the Corporate Site -> Examples -> Related news page template. Click Save. Now switch to Properties -> Related docs tab of the new page and add a related document by using Add related document, choose is
related to as the **Relationship name** and select the **News -> New Consulting Services** document as the **Right-side document**.

10. Repeat step 9, but call the new page **New Service 2** and select the **News -> Apple iPad2 In Stock** document as the **Right-side document** of the relationship.

11. Now select the **/Services/New Service 1** page from the content tree and switch to **Live site** mode. You will see that the CMSRepeater on the page template is displaying a preview of the news item related to this page:

If you select **/Services/New Service 2** page, you will see the **Apple iPad2 In Stock** news item displayed in the same fashion.

**Using web parts to display related documents**

When using the portal engine, related documents can also be displayed by the following web parts from the **Listings and viewers** category:
This can be done by setting the properties in their Relationships property section as seen in the following image:

Example

The following example shows how to display news items related to a product by using the Repeater web part:

1. Open the sample Corporate Site, go to CMS Desk -> Content, select Products -> Laptops and Tablets -> Apple iPad 2 and switch to Properties -> Related docs. Now add a related document by using Add related document, choose is related to as the Relationship name and select the News -> Apple iPad2 In Stock document as the Right-side document.

2. Switch to the Design tab and add a Listings and viewers -> Documents -> Repeater web part to the Main zone web part zone.

3. The Web part properties (Repeater) dialog will appear. Set the following properties:

- **Content -> Path**: /% (we want to display related news items from the whole website)
- **Content filter -> Document types**: CMS.News
- **Transformations -> Transformation**: CMS.News.Preview
Click **OK** to add the Repeater web part to the page and then drag it above the Image gallery web part.

4. Now switch to **Live site** mode. You will see the news item that was added as a related document in step 1 displayed below the product using the CMS.News.Preview transformation:

The CMSCalendar control allows you to display a calendar with events, news and other date-based documents from the Kentico CMS database without the need to write any additional code.

The content is specified using its **Path**, **MaxRelativeLevel**, **ClassNames**, **CultureCode**, **WhereCondition** and **OrderBy** properties. Data is retrieved using the **SelectDocuments** query of the specified document type. These queries can be found at [Kentico CMS Site Manager -> Development -> Document types -> ... Edit specified document type ... -> Queries](#).

The CMSCalendar is derived from the **BasicCalendar** control.

The portal engine equivalent of the CMSCalendar control is the **Listings and viewers -> Documents -> Calendar** web part.

The following topics are available to help you familiarize yourself with the CMSCalendar control:
1.8.6.2.4.2 Getting started

The following is a step-by-step tutorial that will show you how to display a calendar that contains links to news items (CMS.News documents) on days when news items were released using the CMSCalendar control:

1. Create a new Web form somewhere in your website installation directory.
2. Switch to its Design tab, drag and drop a CMSCalendar control from the toolbox onto the form and set its following properties:
   - **ClassNames**: cms.news
   - **DayField**: NewsReleaseDate
   - **TransformationName**: cms.news.calendarevent
   - **NoEventTransformationName**: cms.news.calendarnoevent

   This tells the control to read news documents, assigns the column it should get date/time values from and specifies the transformations that should be used to display days with and without news releases.

3. Switch to the Source tab. The code of the CMSCalendar control should look like this:

   ```xml
<cms:CMSCalendar ID="CMSCalendar1" runat="server" ClassNames="cms.news" DayField="NewsReleaseDate" TransformationName="cms.news.calendarevent" NoEventTransformationName="cms.news.calendarnoevent">
</cms:CMSCalendar>
```

   There is no need to define templates for day items, since the transformation names have already been specified.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a calendar like this:

<table>
<thead>
<tr>
<th></th>
<th>Sun</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 2011</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
</tr>
<tr>
<td>30</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
</tr>
<tr>
<td>31</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
</tr>
<tr>
<td>1</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
</tr>
<tr>
<td>2</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
</tr>
<tr>
<td>3</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
</tr>
<tr>
<td>4</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
<td>No event</td>
</tr>
</tbody>
</table>

5. New Consulting Services (6/5/2011 12:00:00 AM)

   We are proud to announce that the range of services we provide was extended by web development consulting. The most experienced and skilled employees from our web development department have been promoted to consultants and are now in charge of helping you with your web development projects.

   6
   7
   8

9. Apple iPad 2 In Stock (6/9/2011 12:00:00 AM)

   Today, we have good news for all fans of the awesome Apple iPad. We are glad to announce that its new version, Apple iPad 2, is available in our web shop. Furthermore, we keep our competitive pricing policy, providing the lowest price currently available on the Web.

   10
   11

© 2012 Kentico Software
1.8.6.2.4.3 Configuration

As it is inherited from the BasicCalendar control, the CMSCalendar control has all of its properties (including templates). These can be found in the BasicCalendar -> Configuration topic. In addition, it has the following properties that can be set or used in the API:

In addition, it has most of the following properties that can be set or used in the API:

- CMS controls - common properties
- Displaying related documents

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataSource</td>
<td>Gets or sets a DataSet containing calendar events used to populate the items within the control. This value is not required.</td>
<td></td>
</tr>
<tr>
<td>NoEventTransformationName</td>
<td>Name of the transformation applied to days without any events in format &lt;document type code name&gt;.&lt;transformation name&gt;.</td>
<td>&quot;cms.news.CalendarNoEvent&quot;</td>
</tr>
<tr>
<td>TransformationName</td>
<td>Name of the transformation applied to days with an event in format &lt;document type code name&gt;.&lt;transformation name&gt;.</td>
<td>&quot;cms.news.CalendarEvent&quot;</td>
</tr>
</tbody>
</table>

1.8.6.2.4.4 Appearance and styling

You can modify the appearance of the CMSCalendar control by setting the standard properties of the ASP.NET Calendar control (inherited through the BasicCalendar). You can find more details on particular properties in the .NET Framework documentation for the Calendar class.

A common way to set the appearance of this control is to assign a skin through the SkinID property. Skins can be defined in .skin files under individual themes in the App_Themes folder. More information can be found in the .NET Skins and Themes documentation.

The design of day cells can be determined by the transformations specified by its transformation name properties or by the code of the template properties inherited from the BasicCalendar control.

1.8.6.2.5 CMSDataGrid

1.8.6.2.5.1 Overview

The CMSDataGrid control allows you to display document data from the Kentico CMS database in a customizable table without the need to write any additional code.

The content is specified using its Path, MaxRelativeLevel, ClassNames, CultureCode, WhereCondition and OrderBy properties. Data is retrieved using the SelectDocuments query of the specified document type. These queries can be found at Kentico CMS Site Manager -> Development -> Document types -> ... Edit specified document type ... -> Queries.
Please note
If you wish to display data using a custom query, please use the QueryDataGrid control.

The CMSDataGrid is derived from the BasicDataGrid control.

The standard DataGrid designer can be used to set up CMSDataGrid style and behaviour.

The portal engine equivalent of the CMSDataGrid control is the Listings and viewers -> Documents -> Grid web part.

The following topics are available to help you familiarize yourself with the CMSDataGrid control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

1.8.6.2.5.2 Getting started

The following is a step-by-step tutorial that will show you how to display a table that contains all products (CMS.Smartphone, CMS.Laptop, CMS.Software, CMS.Ebook, CMS.ITService and CMS.PaidMembership documents) from the products section of the sample Corporate Site using the CMSDataGrid control:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSDataGrid control from the toolbox onto the form and set its following properties:

   - **ClassNames**: cms.smartphone;cms.laptop;cms.software;cms.ebook;cms.itService;cms.paidMembership
   - **Path**: /products/%

   This tells the control which document types to read and specifies the Path to the products section (the default setting of /% would also display all products, but it is more effective to read only a section of the site).

3. Right-click the CMSDataGrid on the form, select AutoFormat... and choose a scheme.

4. Then right-click the control again, select Show Smart Tag and then Property Builder...; the CMSDataGrid1 Properties dialog will be displayed.

   On the General tab, check the Allow sorting box.

   Now switch to the Columns tab, where you can specify the columns that will be displayed, and uncheck the Create columns automatically at run time box.

   Add a new Bound Column from the Available columns list to the Selected columns list. Enter the following values into the appropriate fields:
• **Header text:** Name  
• **Data Field:** SKUName  
• **Sort expression:** SKUName

Add another **Bound column** from the **Available columns** list to the **Selected columns** list. Enter the following values in the appropriate fields:

• **Header text:** Price  
• **Data Field:** SKUPrice  
• **Sort expression:** SKUPrice

Click OK.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a table like this (depending on the chosen scheme):

<table>
<thead>
<tr>
<th>Name</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple MacBook Pro MC723LL/A</td>
<td>2199</td>
</tr>
<tr>
<td>HP EliteBook 8440p W7681AW</td>
<td>1899</td>
</tr>
<tr>
<td>Dell XPS 15z</td>
<td>1596.99</td>
</tr>
<tr>
<td>HTC Sensation</td>
<td>799.99</td>
</tr>
<tr>
<td>Apple iPhone 4</td>
<td>759.99</td>
</tr>
<tr>
<td>Samsung Google Nexus S</td>
<td>599.99</td>
</tr>
<tr>
<td>Motorola Atrix 4G</td>
<td>529.98</td>
</tr>
<tr>
<td>Apple iPad 2</td>
<td>510.99</td>
</tr>
<tr>
<td>Microsoft Office Professional 2010</td>
<td>499.99</td>
</tr>
<tr>
<td>BlackBerry Torch 9800</td>
<td>459.99</td>
</tr>
<tr>
<td>Apple iPhone 3GS</td>
<td>424.99</td>
</tr>
<tr>
<td>Microsoft Windows 7 Ultimate</td>
<td>319.99</td>
</tr>
<tr>
<td>1 Hour of Web Development Consulting</td>
<td>150</td>
</tr>
<tr>
<td>Gold partner membership for 1 year</td>
<td>100</td>
</tr>
<tr>
<td>Silver partner membership for 1 year</td>
<td>60</td>
</tr>
<tr>
<td>Operating System Installation</td>
<td>49.99</td>
</tr>
<tr>
<td>Kentico CMS Information Sources</td>
<td>1</td>
</tr>
</tbody>
</table>

### 1.8.6.2.5.3 Configuration

As it is inherited from the [BasicDataGrid](#) control, the CMSDataGrid control has all of its properties. These can be found in the **BasicDataGrid -> Configuration** topic.

In addition, it has all of the following properties that can be set or used in the API:

• **CMS controls - common properties**  
• **Displaying related documents**

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
</table>

© 2012 Kentico Software
### PageSize
The number of displayed items per page.

### SelectedItemTransformationName
Name of the transformation applied to the selected item in format `<document type code name>.<transformation name>`.

#### 1.8.6.2.5.4 Appearance and styling

You can modify the appearance of the CMSDataGrid control by setting the standard properties of the ASP.NET DataGrid control (inherited through the BasicDataGrid). You can find more details on particular properties in the .NET Framework documentation for the `DataGrid` class.

A common way to set the appearance of this control is to assign a skin through the `SkinID` property. Skins can be defined in `.skin` files under individual themes in the `App_Themes` folder. More information can be found in the .NET `Skins and Themes` documentation.

#### 1.8.6.2.6 CMSDataList

##### 1.8.6.2.6.1 Overview

The CMSDataList control allows you to display document data from the Kentico CMS database in a list based on transformations without the need to write any additional code.

The content is specified using its `Path`, `MaxRelativeLevel`, `ClassNames`, `CultureCode`, `WhereCondition` and `OrderBy` properties. Data is retrieved using the `SelectDocuments` query of the specified document type. These queries can be found at `Kentico CMS Site Manager -> Development -> Document types -> ... Edit specified document type ... -> Queries`.

Please note: If you wish to display data using a custom query, please use the `QueryDataList` control.

The CMSDataList is derived from the `BasicDataList` control.

Unlike the `CMSRepeater` control, the CMSDataList allows you to display data in several columns.

It supports nested controls, read more in the Using nested controls topic.

The portal engine equivalent of the CMSDataList control is the Listings and viewers -> Documents -> Datalist web part.

The following topics are available to help you familiarize yourself with the CMSDataList control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified
1.8.6.2.6.2 Getting started

The following is a step-by-step tutorial that will show you how to display a list that contains all smartphones, laptops and tablets (CMS.Smartphone and CMS.Laptop documents) from the products section of the sample Corporate Site using the CMSDataList control:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSDataList control from the toolbox onto the form and set its following properties:
   - **ClassNames**: cms.smartphone;cms.laptop
   - **OrderBy**: SKUName
   - **Path**: /products/%
   - **RepeatColumns**: 4
   - **TransformationName**: ecommerce.transformations.Product_SimplePreview
   - **SelectedItemTransformationName**: ecommerce.transformations.Product_Default

   This tells the control which document types to read, sets the OrderBy value, specifies the Path to the products section (the default setting of /% would also display all products, but it is more effective to read only a section of the site), determines the amount of displayed columns and assigns the transformations that should be used to display products.

3. Switch to the Source tab. The code of the CMSDataList control should look like this:

```xml
<cms:CMSDataList ID="CMSDataList1" runat="server" ClassNames="cms.smartphone;cms.laptop"
OrderBy="SKUName" Path="/products/%" RepeatColumns="4"
TransformationName="ecommerce.transformations.Product_SimplePreview"
SelectedItemTransformationName="ecommerce.transformations.Product_Default">
</cms:CMSDataList>
```

   It’s not necessary to define the standard ItemTemplate elements of the DataList control since the transformation names have already been specified.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should display a list like this:
1.8.6.2.6.3 Configuration

As it is inherited from the BasicDataList control, the CMSDataList control has all of its properties. These can be found in the BasicDataList -> Configuration topic.

In addition, it has all of the following properties that can be set or used in the API:

- CMS controls - common properties
- Displaying related documents

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingTransformationName</td>
<td>Name of the transformation applied to alternating items in format &lt;document type code name&gt;.&lt;transformation name&gt;.</td>
<td></td>
</tr>
<tr>
<td>DelayedLoading</td>
<td>Indicates whether data should be loaded during the load event instead of the default init event.</td>
<td></td>
</tr>
<tr>
<td>EnablePaging</td>
<td>Indicates whether the built-in DataPager control should be used to page the list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This property does not affect the UniPager control, which must be added separately if you wish to use it.</td>
<td></td>
</tr>
</tbody>
</table>
### Appearance and styling

You can modify the appearance of the CMSDataList control by setting the standard properties of the ASP.NET DataList control (inherited through the BasicDataList). You can find more details on particular properties in the .NET Framework documentation for the DataList class.

The design of list items can be determined by the transformations specified by the AlternatingTransformationName, TransformationName and SelectedItemTransformationName properties or by the code of the template properties inherited from the standard ASP.NET DataList control.

### CMSDocumentValue

#### Overview

This control allows you to display a specified value of the currently displayed Kentico CMS document. It can be useful if you need to display e.g. the current document name on the page.

This control can easily be placed into ASPX page templates, page layouts or transformation code.

The following topics are available to help you familiarize yourself with the CMSDocumentValue control:

- **Getting started** - contains a quick example of how this control can be used
- **Configuration** - describes and explains the properties that can be set for the control

#### Getting started

The following tutorial will show you how to display the document name of the currently selected document using the CMSDocumentValue control:

1. Create a new Web form and use it as a page template according to the guide in the Using ASPX page templates topic.
2. Switch to its **Design** tab, drag and drop a **CMSDocumentValue** control from the toolbox onto the form and set its following properties:

- **AttributeName**: DocumentName
- **FormattingString**: Document name: {0}

This tells the control which document value to display and sets the format that should be used.

The code of the control will look like this:

```
<cms:CMSDocumentValue ID="CMSDocumentValue1" runat="server" AttributeName="DocumentName" FormattingString="Document name: {0}" />
```

3. Save the changes to the web form. Now if you look at the page using the created template on some website, the name of the currently selected document will be displayed. This is only an example of how this control can be used and by itself isn't very useful. In a practical scenario, the code of the control from this example would be added to an existing ASPX page template, that has some other function, or to the code of a page layout when using the portal engine.

### 1.8.6.2.7.3 Configuration

The following properties of the CMSDocumentValue control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AttributeName</td>
<td>Name of the field to be displayed.</td>
<td>&quot;DocumentName&quot;</td>
</tr>
<tr>
<td>ClassNames</td>
<td>List of document types for which the value should be displayed, separated by a semicolon (;).</td>
<td>&quot;cms.article;cms.menuitem&quot;</td>
</tr>
<tr>
<td>FormattingString</td>
<td>.NET formatting expression used for displaying the value.</td>
<td>&quot;Name: {0}&quot;</td>
</tr>
<tr>
<td>StopProcessing</td>
<td>Indicates if processing of the control should be stopped and the control should not retrieve or display any data.</td>
<td></td>
</tr>
</tbody>
</table>

### 1.8.6.2.8 CMSRepeater

#### 1.8.6.2.8.1 Overview

The CMSRepeater control allows you to display document data from the Kentico CMS database in a list based on transformations without the need to write any additional code.

The content is specified using its **Path**, **MaxRelativeLevel**, **ClassNames**, **CultureCode**, **WhereCondition** and **OrderBy** properties. Data is retrieved using the **SelectDocuments** query of the specified document type. These queries can be found at **Kentico CMS Site Manager -> Development -> Document types -> ... Edit specified document type ... -> Queries**.
If you wish to display data using a custom query, please use the QueryRepeater control.

The CMSRepeater is derived from the BasicRepeater control.

It supports nested controls, read more in the Using nested controls topic.

The portal engine equivalent of the CMSRepeater control is the Listings and viewers -> Documents -> Repeater web part.

The following topics are available to help you familiarize yourself with the CMSRepeater control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

### 1.8.2.8.2 Getting started

The following is a step-by-step tutorial that will show you how to display a list of news items (CMS.News documents) using the CMSRepeater control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **CMSRepeater** control from the toolbox onto the form and set its following properties:

   - **ClassNames**: cms.news
   - **OrderBy**: NewsReleaseDate DESC
   - **TransformationName**: cms.news.preview
   - **SelectedItemTransformationName**: cms.news.default

   This tells the control which document types to read, sets the **OrderBy** value and assigns the transformations that should be used to display the news items.

3. Switch to the **Source** tab. The code of the CMSRepeater control should look like this:

   ```xml
   <cms:CMSRepeater ID="CMSRepeater1" runat="server" ClassNames="cms.news"
   OrderBy="NewsReleaseDate DESC" TransformationName="cms.news.preview"
   SelectedItemTransformationName="cms.news.default">
   </cms:CMSRepeater>
   ```

   It's not necessary to define the standard **ItemTemplate** elements of the Repeater control since the transformation names have already been specified.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a list like this:
1.8.6.2.8.3 Configuration

As it is inherited from the BasicRepeater control, the CMSRepeater control has all of its properties. These can be found in the BasicRepeater -> Configuration topic.

In addition, it has all of the following properties that can be set or used in the API:

- **CMS controls - common properties**
- **Displaying related documents**

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingTransformationName</td>
<td>Name of the transformation applied to alternating items in format <code>&lt;document type code name&gt;.&lt;transformation name&gt;</code></td>
<td></td>
</tr>
<tr>
<td>DataSourceControl</td>
<td>Object of the data source control.</td>
<td></td>
</tr>
<tr>
<td>DataSourceName</td>
<td>ID of the data source control.</td>
<td></td>
</tr>
<tr>
<td>DelayedLoading</td>
<td>Indicates whether data should be loaded during the <code>load</code> event instead of the default <code>init</code> event.</td>
<td></td>
</tr>
<tr>
<td>EnablePaging</td>
<td>Indicates whether the built-in DataPager control should be used to page the list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This property does not affect the UniPager control, which must be added separately if you wish to use it.</td>
<td></td>
</tr>
<tr>
<td>ItemSeparator</td>
<td>Separator between displayed items.</td>
<td>&quot;&lt;hr/&gt;&quot;</td>
</tr>
<tr>
<td>NestedControlsID</td>
<td>IDs of nested controls (CMSRepeater, CMSDataList...), separated by semicolons.</td>
<td>&quot;CMSRepeaterNested;CMSDataListNested&quot;</td>
</tr>
<tr>
<td>PageSize</td>
<td>The number of displayed items per page.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>PagerControl</td>
<td>This property can be used to set or get the pager control and its properties.</td>
<td></td>
</tr>
<tr>
<td>SelectedItemTransformationName</td>
<td>Name of the transformation applied to the selected item in format (&lt;document type code name&gt;.&lt;transformation name&gt;).</td>
<td></td>
</tr>
<tr>
<td>ShowEditDeleteButtons</td>
<td>Indicates if edit and delete buttons should automatically be shown for each displayed item in the edit mode of CMS Desk.</td>
<td></td>
</tr>
<tr>
<td>TransformationName</td>
<td>Name of the transformation applied to standard items in format (&lt;document type code name&gt;.&lt;transformation name&gt;).</td>
<td></td>
</tr>
</tbody>
</table>

1.8.6.2.8.4 Appearance and styling

You can modify the appearance of the CMSRepeater control by setting the standard properties of the ASP.NET Repeater control (inherited through the BasicRepeater). You can find more details on particular properties in the .NET Framework documentation for the Repeater class.

The design of list items can be determined by the transformations specified by the AlternatingTransformationName, TransformationName and SelectedItemTransformationName properties or by the code of the template properties inherited from the standard ASP.NET Repeater control.

1.8.6.2.9 CMSUniView

1.8.6.2.9.1 Overview

The CMSUniView control allows you to display document data from the Kentico CMS database in a hierarchical structure based on transformations without the need to write any additional code. Using hierarchical transformations, this control can be used to display documents with a varying design depending on their type and hierarchical level.

The content is specified using its Path, MaxRelativeLevel, ClassNames, CultureCode, WhereCondition and OrderBy properties. Data is retrieved using the SelectDocuments query of the specified document type. These queries can be found at Kentico CMS Site Manager -> Development -> Document types -> ... Edit specified document type ... -> Queries.

The CMSUniView is derived from the BasicUniView control.

It supports nested controls, read more in the Using nested controls topic.

The portal engine equivalent of the CMSUniView control is the Listings and viewers -> Documents -> Universal viewer web part.

The following topics are available to help you familiarize yourself with the CMSUniView control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Using hierarchical transformations** - contains a quick step-by-step tutorial demonstrating how
hierarchical transformations can be used by this control to display several different document types.
- **Appearance and styling** - describes how the design of the control can be modified

### 1.8.6.2.9.2 Getting started

The following is a step-by-step tutorial that will show you how to display all documents from the sample Corporate Site in a hierarchical structure using the CMSUniView control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **CMSUniView** control from the toolbox onto the form and set its **LoadHierarchicalData** property to **true**.

3. Switch to the **Source** tab and add the code marked by the **CMSUniView templates** comments between the `<cms:CMSUniView>` tags. The overall code of the CMSUniView control should look like this:

```xml
<cms:CMSUniView ID="CMSUniView1" runat="server" LoadHierarchicalData="True">
    <!-- CMSUniView templates -->
    <ItemTemplate>
        <![CDATA[<# HTMLHelper.HTMLEncode(Convert.ToString(Eval("NodeAliasPath"))) ]]>
    </ItemTemplate>
    <AlternatingItemTemplate>
        <![CDATA[<# HTMLHelper.HTMLEncode(Convert.ToString(Eval("NodeAliasPath"))) ]]>
    </AlternatingItemTemplate>
    <SeparatorTemplate>
        <![CDATA[</li>]]>
    </SeparatorTemplate>
    <HeaderTemplate>
        <![CDATA[<ul>]]>
    </HeaderTemplate>
    <FooterTemplate>
        <![CDATA[</li>]]>
    </FooterTemplate>
    <FirstItemTemplate>
        <![CDATA[<# HTMLHelper.HTMLEncode(Convert.ToString(Eval("NodeAliasPath"))) ]]>
    </FirstItemTemplate>
    <LastItemTemplate>
        <![CDATA[<# HTMLHelper.HTMLEncode(Convert.ToString(Eval("NodeAliasPath"))) ]]>
    </LastItemTemplate>
</cms:CMSUniView>
```
As you can see, this example uses **ItemTemplates** to determine the design of the displayed documents. An alternative way of doing this is to set the **TransformationName** properties of the CMSUniView, which causes the control to load the transformations from the database. A list of these properties can be found in the **Configuration** topic.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a hierarchical list like this:

```
*  / Home
   *  /Services
      *  /Services/Web-design
      *  /Services/Web-development
      *  /Services/Network-administration
    *  /Products
     *  /Products/Smartphones
        *  /Products/Smartphones/Apple-iPhone-3GS
        *  /Products/Smartphones/Apple-iPhone-4
        *  /Products/Smartphones/BlackBerry-Torch-9800
        *  /Products/Smartphones/HTC-Sensation
        *  /Products/Smartphones/Motorola-Atrix-4G
        *  /Products/Smartphones/Samsung-Google-Nexus-S
     *  /Products/Laptops-and-Tablets
        *  /Products/Laptops-and-Tablets/Apple-iPad-2
        *  /Products/Laptops-and-Tablets/Apple-MacBook-Pro-MC723LL-A
        *  /Products/Laptops-and-Tablets/Dell-XPS-15z
        *  /Products/Laptops-and-Tablets/HP-EliteBook-W7601AW
        *  /Products/Laptops-and-Tablets/Dell-XPS-15x-with-iPhone
     *  /Products/Software
        *  /Products/Software/Test-software
        *  /Products/Software/Microsoft-Windows-7-Ultimate
        *  /Products/Software/Microsoft-Windows-7-installation-package
     *  /Products/E-Books
        *  /Products/E-Books/Kentico-CMS-Information-Sources
     *  /Products/IT-Services
        *  /Products/IT-Services/Test-service
        *  /Products/IT-Services/Operating-System-Installation
     *  /Products/Membership
        *  /Products/Membership/Silver-partner-membership-for-1-year
        *  /Products/Membership/Gold-partner-membership-for-1-year
    *  /News
       *  /News/New-Consulting-Services
       *  /News/Apple-iPad-2-In-Stock
       *  /News/Company-Growth-Exceeds-Expectations
       *  /News/Community-Website-Section
```

1.8.6.2.9.3 **Configuration**

As it is inherited from the **BasicUniView** control, which is in turn derived from the **UniView** control, the CMSUniView control has all of their properties. These can be found in the **BasicUniView -> Configuration** and **UniView -> Configuration** topics.

In addition, it has all of the following properties that can be set or used in the API:

- **CMS controls - common properties**
• Displaying related documents

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataSourceControl</td>
<td>Object of the data source control.</td>
<td></td>
</tr>
<tr>
<td>DataSourceName</td>
<td>ID of the data source control.</td>
<td></td>
</tr>
<tr>
<td>DelayedLoading</td>
<td>Indicates whether data should be loaded during the <strong>load</strong> event instead of the default <strong>init</strong> event.</td>
<td></td>
</tr>
<tr>
<td>EnablePaging</td>
<td>Indicates whether the built-in UniPager control should be used to for paging. If you wish to use paging, please be sure to set <strong>LoadHierarchicalData</strong> to false, as hierarchical data cannot be paged.</td>
<td></td>
</tr>
<tr>
<td>ItemSeparatorValue</td>
<td>Separator between displayed items. This property has greater priority than the separator set in the transformation given in the <strong>SeparatorTransformationName</strong> property.</td>
<td>&quot;&lt;hr/&gt;&quot;</td>
</tr>
<tr>
<td>LoadHierarchicalData</td>
<td>Indicates whether data should be bound in the default format (flat structure) or changed to a hierarchical grouped dataset.</td>
<td></td>
</tr>
<tr>
<td>NestedControlsID</td>
<td>IDs of nested controls (CMSRepeater, CMSDataList...), separated by semicolons.</td>
<td>&quot;CMSRepeaterNested; CMSDataListNested&quot;</td>
</tr>
<tr>
<td>PageSize</td>
<td>The number of displayed items per page.</td>
<td></td>
</tr>
<tr>
<td>PagerControl</td>
<td>Gets the current UniPager control used for paging.</td>
<td></td>
</tr>
<tr>
<td>PagerPosition</td>
<td>The position of the pager relative to the paged data.</td>
<td>&quot;Bottom&quot; &quot;Top&quot; &quot;TopAndBottom&quot;</td>
</tr>
<tr>
<td>ShowEditDeleteButtons</td>
<td>Indicates if edit and delete buttons should automatically be shown for each displayed item in the edit mode of CMS Desk.</td>
<td></td>
</tr>
<tr>
<td>UseHierarchicalOrder</td>
<td>Indicates whether the default hierarchical order value should be used. The order is used only if <strong>LoadHierarchicalData</strong> is set to true. The default order value is &quot;NodeLevel, NodeOrder&quot;. The value of the <strong>OrderBy</strong> property is added to the end of the OrderBy expression.</td>
<td></td>
</tr>
</tbody>
</table>

Specifying transformations
The following properties can be filled to define which transformations should be used by the control. All transformations are specified in format:

<document type code name>.<transformation name>

The design of the listed items can alternatively be set by defining the ItemTemplate elements inherited from the UniView control between the tags of the CMSUniView control.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingTransformationName</td>
<td>Name of the transformation applied to items that have an even position in the listing order. Every level in the hierarchy has its own separate alternation pattern.</td>
<td></td>
</tr>
<tr>
<td>FirstTransformationName</td>
<td>Name of the transformation applied to the first item on every level in the hierarchy. Only works for levels that contain more than one item.</td>
<td></td>
</tr>
<tr>
<td>FooterTransformationName</td>
<td>Name of the transformation rendered at the end of every level (after the last item on the level). Can be used to close encapsulating elements from the Header.</td>
<td></td>
</tr>
<tr>
<td>HeaderTransformationName</td>
<td>Name of the transformation rendered at the beginning of every level (before the first item on the level). Provides a convenient way to visually separate or style individual levels.</td>
<td></td>
</tr>
<tr>
<td>HierarchicalTransformationName</td>
<td>Name of the used hierarchical transformation. Please see the Using hierarchical transformations topic for an example of how this property can be used.</td>
<td></td>
</tr>
<tr>
<td>LastTransformationName</td>
<td>Name of the transformation applied to the last item on every level in the hierarchy. Only works for levels that contain more than one item.</td>
<td></td>
</tr>
<tr>
<td>SelectedFooterTransformationName</td>
<td>Name of the transformation used for the footer of selected items.</td>
<td></td>
</tr>
<tr>
<td>SelectedHeaderTransformationName</td>
<td>Name of the transformation used for the header of selected items.</td>
<td></td>
</tr>
<tr>
<td>SelectedItemTransformationName</td>
<td>Name of the transformation applied to the currently selected item (i.e. the document that is being viewed).</td>
<td></td>
</tr>
<tr>
<td>SeparatorTransformationName</td>
<td>Name of the transformation rendered between items. If hierarchical data is loaded, the separator is</td>
<td></td>
</tr>
</tbody>
</table>
placed only between items on the same level
(i.e. not between a parent item and its child).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SingleTransformName</td>
<td>Name of the transformation applied in cases where there is only one item on a level in the hierarchy.</td>
</tr>
<tr>
<td>TransformationName</td>
<td>Name of the transformation applied to all displayed items that are not covered by a specialized transformation type (e.g. alternating items, first items etc.).</td>
</tr>
</tbody>
</table>

### Configuring the pager

The CMSUniView control has a built-in [UniPager](#) control which can be enabled by the [EnablePaging](#) property. The following templates can be defined within the tags of the CMSUniView control to determine the design of the pager. Please refer to the [UniPager -> Structure](#) topic to see what individual templates represent.

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PagerCurrentPageTemplate</td>
<td>Code of the template used for the current page in the pager. Use <code>&lt;%# Eval(&quot;Page&quot;) %&gt;</code> to get the current page number, <code>&lt;%# Eval(&quot;PageURL&quot;) %&gt;</code> to get page the URL or <code>&lt;%# Eval(&quot;PageLink&quot;) %&gt;</code> to get the page link.</td>
<td><code>&lt;strong&gt;</code>&lt;%# Eval(&quot;Page&quot;) %&gt;`&lt;/strong&gt;</td>
</tr>
<tr>
<td>PagerDirectPageTemplate</td>
<td>Code of the template used for direct page changing. Use a <a href="#">TextBox</a> or <a href="#">DropDownList</a> control with ID <code>directPageControl</code> to register the page change event.</td>
<td><code>&lt;asp:TextBox ID=&quot;DirectPageControl&quot; runat=&quot;server&quot; Style=&quot;width: 25px;&quot; /&gt;</code></td>
</tr>
<tr>
<td>PagerFirstPageTemplate</td>
<td>Code of the template used for the link to the first page in the pager. Use <code>&lt;%# Eval(&quot;FirstURL&quot;) %&gt;</code> to get the link to the first page.</td>
<td>`&lt;a href=&quot;&lt;%# Eval(&quot;FirstURL&quot;) %&gt;&quot;&gt;</td>
</tr>
<tr>
<td>PagerLastPageTemplate</td>
<td>Code of the template used for the link to the last page in the pager. Use <code>&lt;%# Eval(&quot;LastURL&quot;) %&gt;</code> to get the link to the last page.</td>
<td>`&lt;a href=&quot;&lt;%# Eval(&quot;LastURL&quot;) %&gt;&quot;&gt;&gt;</td>
</tr>
<tr>
<td>PagerLayoutTemplate</td>
<td>Code of the template used for the overall pager layout.</td>
<td></td>
</tr>
<tr>
<td>PagerNextGroupTemplate</td>
<td>Code of the template used for the link to the next group of pages. Use <code>&lt;%# Eval(&quot;NextGroupURL&quot;) %&gt;</code> to get the link to the next group.</td>
<td><code>&lt;a href=&quot;&lt;%# Eval(&quot;NextGroupURL&quot;) %&gt;&quot;&gt;...&lt;/a&gt;</code></td>
</tr>
<tr>
<td>PagerNextPageTemplate</td>
<td>Code of the template used for the link to the next page. Use <code>&lt;%# Eval(&quot;NextURL&quot;) %&gt;</code> to</td>
<td><code>&lt;a href=&quot;&lt;%# Eval(&quot;NextURL&quot;) %&gt;&quot;&gt;&amp;gt;&lt;/a&gt;</code></td>
</tr>
</tbody>
</table>
1.8.6.2.9.4 Using hierarchical transformations

The following is a step-by-step tutorial that will show you how the CMSUniView control can use a hierarchical transformation to display a hierarchical list of job openings (CMS.Job documents), offices (CMS.Office documents) and their categories (CMS.MenuItem documents) from the sample Corporate Site:

1. Create a new Web form somewhere in your web site installation directory.

2. Switch to its Design tab, drag and drop a CMSUniView control from the toolbox onto the form and set its following properties:

   - **ClassNames**: CMS.Office;CMS.Job;CMS.MenuItem
   - **Path**: /Company/%
   - **LoadHierarchicalData**: true
   - **HierarchicalTransformationName**: CMS.Job.HierarchicalJobsCareer

This tells the control which document types to read, specifies the Path that should be used, indicates that data should be bound in a hierarchical grouped dataset and assigns the hierarchical transformation that should be used to display the list. The hierarchical transformation contains individual transformations for all three document types. This is how it is defined in the CMS:
3. Switch to the **Source** tab. The code of the CMSUniView control should look like this:

```xml
<cms:CMSUniView ID="CMSUniView1" runat="server" ClassNames="CMS.Office;CMS.Job; CMS.MenuItem"
Path="/Company/%" LoadHierarchicalData="true" HierarchicalTransformationName="CMS.Job.HierarchicalJobsCareer" />
</cms:CMSUniView>
```

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should look like this:

**Careers**

**Web Developer**

We are currently looking for skilled web developers to join our web development team in the London Office. We need people who are enthusiastic and constantly looking for improvements. The ideal candidate will be new to the London Office, will be interested in working on demanding complex projects for top grade customers.

**Location:**

**London Office**

**Web Designer**

We are currently looking for skilled web designers to empower our London Office web design team. The position involves working with creative and technical people in an environment that offers challenging and rewarding work.

**Location:**

**London Office**

**Offices**

**London Office**

Old Street
London, England EC1Y 1BE

**New York Office**

Third Avenue
New York, NY 10022-7601

1.8.6.2.9.5 Appearance and styling

The appearance of the CMSUniView control is determined by the transformations specified by its **TransformationName** properties or by the code of the **ItemTemplates** inherited from the **UniView** control and by certain other properties. These are described in more detail in the **Configuration** topic.

1.8.6.2.10 CMSViewer

1.8.6.2.10.1 Overview

The CMSViewer control allows you to display document data from the Kentico CMS database based on XSLT transformations without the need to write any additional code.

The content is specified using its **Path**, **MaxRelativeLevel**, **ClassNames**, **CultureCode**, **WhereCondition** and **OrderBy** properties. Data is retrieved using the **SelectDocuments** query of the
specified document type. These queries can be found at Kentico CMS Site Manager -> Development -> Document types -> ... Edit specified document type ... -> Queries.

The portal engine equivalent of the CMSViewer control is the Listings and viewers -> Documents -> XSLT viewer web part.

The following topics are available to help you familiarize yourself with the CMSViewer control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

### 1.8.6.2.10.2 Getting started

The following is a step-by-step tutorial that will show you how to use the CMSViewer control to display a specific news item (CMS.News document) using an XSLT transformation:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSViewer control from the toolbox onto the form and set its following properties:

   - **ClassNames**: CMS.News
   - **Path**: /News/New-Consulting-Services
   - **TransformationName**: cms.news.default_xslt

   This tells the control which document types to read, specifies the **Path** to the news document and assigns the transformation that should be used.

   **Please note**

   The document types entered into the **ClassNames** property must be identical (it is case sensitive), to the value of the **match** property of the `<xsl:template>` element of the specified xslt transformation.

3. Switch to the Source tab. The code of the CMSViewer control should look like this:

   ```xml
   <cms:CMSViewer ID="CMSViewer1" runat="server" ClassNames="CMS.News" Path="/News/New-Consulting-Services" TransformationName="cms.news.default_xslt" />  
   ```

4. Save the changes to the web form. Now right-click it in the Solution explorer and select View in Browser. The resulting page should look like this:
1.8.6.2.10.3 Configuration

The following properties of the CMSViewer control can be set or used in the API:

All of the common properties from:

- CMS controls - common properties
- Displaying related documents

In addition, the following properties are available:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HideControlForZeroRows</td>
<td>Hides the control when no data is loaded. Default value is False.</td>
<td></td>
</tr>
<tr>
<td>SelectedItemTransformationName</td>
<td>Name of the XSLT transformation applied to the selected item in format \document type code name.&lt;transformation name&gt;.</td>
<td></td>
</tr>
<tr>
<td>TransformationName</td>
<td>Name of the used XSLT transformation in format \document type code name.&lt;transformation name&gt;.</td>
<td>&quot;cms.news.default_xslt&quot;</td>
</tr>
<tr>
<td>ZeroRowsText</td>
<td>Text to be shown when the control is hidden by the HideControlForZeroRows property.</td>
<td></td>
</tr>
</tbody>
</table>

1.8.6.2.10.4 Appearance and styling

The appearance and design of the displayed content is completely driven by the XSLT transformation specified in the TransformationName property.

1.8.6.3 Listings and viewers with a custom query

1.8.6.3.1 Overview

The controls in this section provide various ways to display document data from the Kentico CMS database.
Each of these controls inherits a corresponding control from the Basic Listings and viewers section and extends it to easily work with Kentico CMS documents and read and use predefined queries from the system.

The functionality of these controls is very similar to that of the controls in the Standard listings and viewers section, the main difference between them is that these controls use full database queries assigned through their QueryName property to determine the content they display. Only queries stored in the CMS_Query table of the Kentico CMS database can be selected, so if you wish to use a custom query, you must create it there or edit an existing one. The queries can be managed through the administration interface at Site Manager -> Development -> Document types / System tables / Custom tables -> ... Edit (edit) object ... -> Queries.

These controls also support the use of Transformations.

Since the controls in this section use pre-defined queries to read data, certain steps must be taken to keep the functionality of the usual properties that set query clauses, such as OrderBy etc. This must be taken into consideration when writing custom queries. For more information, please refer to the Using control properties to set query clauses topic.

Available controls:

- QueryDataGrid
- QueryDataList
- QueryRepeater
- QueryUniView

1.8.6.3.2 Using control properties to set query clauses

If you wish to maintain the functionality of the control properties that set query clauses when writing a custom query to be used by the controls in this section, you need to make sure it contains the appropriate macro expressions that are dynamically replaced with the values of the corresponding properties at run-time. The following table maps the query clause properties to their respective macro expression:

<table>
<thead>
<tr>
<th>Property</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>OrderBy</td>
<td>##ORDERBY##</td>
</tr>
<tr>
<td>SelectedColumns</td>
<td>##COLUMNS##</td>
</tr>
<tr>
<td>TopN</td>
<td>##TOPN##</td>
</tr>
<tr>
<td>WhereCondition</td>
<td>##WHERE##</td>
</tr>
</tbody>
</table>

So a query that selects page (menu item) documents would look like this:

```
SELECT ##TOPN## ##COLUMNS## FROM View_CONTENT_MenuItem_Joined WHERE (##WHERE##)
ORDER BY ##ORDERBY##
```

Dynamic insertion of WhereCondition parameters
The controls in this section also support dynamically inserted parameters into the **WhereCondition** property:

You can use context macro expressions that are resolved at run-time, such as the following:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{%currentaliaspath%}</td>
<td>Alias path of the current page.</td>
</tr>
<tr>
<td>{%currentculturecode%}</td>
<td>Culture code of the user's preferred content culture.</td>
</tr>
<tr>
<td>{%currentsiteid%}</td>
<td>SiteID value of the current site.</td>
</tr>
</tbody>
</table>

### 1.8.6.3.3 CMS Custom query - common properties

All of the Listings and viewers controls with a custom query have the following properties in common:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PageSize</td>
<td>The number of displayed items per page.</td>
<td></td>
</tr>
<tr>
<td>QueryName</td>
<td>Name of the used query in format <code>&lt;document type code name&gt;</code>. <code>&lt;transformation name&gt;</code>.</td>
<td>&quot;CMS.MenuItem. selectdocuments&quot;</td>
</tr>
<tr>
<td>QueryParameters</td>
<td>Gets or sets an array with query parameters.</td>
<td></td>
</tr>
</tbody>
</table>

### 1.8.6.3.4 QueryDataGrid

#### 1.8.6.3.4.1 Overview

The QueryDataGrid control displays document data from the Kentico CMS database in a customizable table without the need to write any extra code. Additionally, it allows you to specify the query used to retrieve data through its **QueryName** property. Only queries stored in the **CMS_Query** table of the Kentico CMS database can be selected, so if you wish to use a custom query, you must create it there or edit an existing one. The queries can be managed through the administration interface at **Site Manager -> Development -> Document types / System tables / Custom tables -> ... Edit (✓) object ... -> Queries**.

The QueryDataGrid is derived from the **BasicDataGrid** control.

The standard DataGrid designer can be used to set up QueryDataGrid style and behaviour.

Please refer to the **Using control properties to set query clauses** topic to find information about using properties such as **WhereCondition** with this control.

The portal engine equivalent of the QueryDataGrid control is the **Listings and viewers -> Grid with custom query** web part.

#### Please note
If you only wish to display data from a specific part of the content tree, please consider using the CMSDataGrid control instead.

The following topics are available to help you familiarize yourself with the QueryDataGrid control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

1.8.6.3.4.2  Getting started

The following is a step-by-step tutorial that will show you how to display a table that contains the latest news items (CMS.News documents) from the sample Corporate Site using the QueryDataGrid control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **QueryDataGrid** control from the toolbox onto the form and set its **QueryName** property to **cms.news.selectlatest**. This assigns the query that should be used to retrieve news documents and tells the control to ensure sorting.

3. Right-click the QueryDataGrid on the form, select **AutoFormat...** and choose a scheme.

4. Right-click the QueryDataGrid on the form, select **Show Smart Tag** and then **Property Builder...**; the **QueryDataGrid1 Properties** dialog will be displayed.

   On the **General** tab, check the **Allow sorting** box.

   Now switch to the **Columns** tab, where you can specify the columns that will be displayed, and uncheck the **Create columns automatically at run time** box.

   Add a new **Bound Column** from the **Available columns** list to the **Selected columns** list. Enter the following values into the appropriate fields:

   - **Header text**: News Title
   - **Data Field**: NewsTitle
   - **Sort expression**: NewsTitle

   Add another **Bound column** from the **Available columns** list to the **Selected columns** list. Enter the following values in the appropriate fields:

   - **Header text**: Release Date
   - **Data Field**: NewsReleaseDate
   - **Sort expression**: NewsReleaseDate

   Click **OK**.

5. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a table similar to the following (depending on the chosen scheme):
1.8.6.3.4.3 Configuration

As it is inherited from the BasicDataGrid control, the QueryDataGrid control has all of its properties. These can be found in the BasicDataGrid -> Configuration topic.

In addition, it has all of the following properties that can be set or used in the API:

- CMSBase - common properties
- CMS_Custom query - common properties

1.8.6.3.4.4 Appearance and styling

You can modify the appearance of the QueryDataGrid control by setting the standard properties of the ASP.NET DataGrid control (inherited through the BasicDataGrid). You can find more details on particular properties in the .NET Framework documentation for the DataGrid class.

A common way to set the appearance of this control is to assign a skin through the SkinID property. Skins can be defined in .skin files under individual themes in the App_Themes folder. More information can be found in the .NET Skins and Themes documentation.

1.8.6.3.5 QueryDataList

1.8.6.3.5.1 Overview

The QueryDataList control displays document data from the Kentico CMS database in a list based on transformations without the need to write any extra code. Additionally, it allows you to specify the query used to retrieve data through its QueryName property. Only queries stored in the CMS_Query table of the Kentico CMS database can be selected, so if you wish to use a custom query, you must create it there or edit an existing one. The queries can be managed through the administration interface at Site Manager -> Development -> Document types / System tables / Custom tables -> ... Edit ( apenas) object ... -> Queries.

The QueryDataList is derived from the BasicDataList control.

Unlike the QueryRepeater control, the QueryDataList allows you to display data in several columns.

Please refer to the Using control properties to set query clauses topic to find information about using properties such as WhereCondition with this control.

The portal engine equivalent of the QueryDataList control is the Listings and viewers -> Datalist with custom query web part.

Please note
If you only wish to display data from a specific part of the content tree, please consider using the CMSDataList control instead.

The following topics are available to help you familiarize yourself with the QueryDataList control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

### 1.8.6.3.5.2 Getting started

The following is a step-by-step tutorial that will show you how to display a list of all smartphones (CMS. Smartphone documents) from the sample Corporate Site using the QueryDataList control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **QueryDataList** control from the toolbox onto the form and set its following properties:

   - **QueryName**: cms.smartphone.selectdocuments
   - **RepeatColumns**: 3
   - **TransformationName**: ecommerce.transformations.Product_SimplePreview

   This assigns the query that should be used to retrieve smartphone documents, determines the amount of displayed columns and assigns the transformation that should be used.

3. Switch to the **Source** tab. The code of the QueryDataList control should look like this:

   ```xml
   <cms:QueryDataList ID="QueryDataList1" runat="server" QueryName="cms.smartphone.selectdocuments" RepeatColumns="3" TransformationName="ecommerce.transformations.Product_SimplePreview" />
   ```

   It's not necessary to define the standard **ItemTemplate** elements of the DataList control since the transformation names have already been specified.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a list like this:
1.8.6.3.5.3 Configuration

As it is inherited from the BasicDataList control, the QueryDataList control has all of its properties. These can be found in the BasicDataList -> Configuration topic.

In addition, it has all of the following properties that can be set or used in the API:

- CMSBase - common properties
- CMS Custom query - common properties

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingTransformationName</td>
<td>Name of the transformation applied to alternating items in format <code>&lt;document type code name&gt;.&lt;transformation name&gt;</code>.</td>
<td></td>
</tr>
<tr>
<td>EnablePaging</td>
<td>Indicates whether the built-in DataPager control should be used to page the list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This property does not affect the UniPager control, which must be added separately if you wish to use it.</td>
<td></td>
</tr>
<tr>
<td>IsSelected</td>
<td>Indicates whether the current data source contains the selected item.</td>
<td></td>
</tr>
<tr>
<td>PagerControl</td>
<td>This property can be used to set or get the pager control and its properties.</td>
<td></td>
</tr>
<tr>
<td>SelectedDatabaseColumnName</td>
<td>Gets or sets the column name that should be used to select items.</td>
<td></td>
</tr>
<tr>
<td>SelectedItemTransformationName</td>
<td>Name of the transformation applied to the selected item in format <code>&lt;document type code name&gt;.&lt;transformation name&gt;</code>.</td>
<td></td>
</tr>
</tbody>
</table>
### SelectedQueryStringKey

**Gets or sets the query string key name.** The presence of the key in a query string indicates, that some item should be selected. The item is determined by the value of the query string key.

### SelectedValidationType

**Gets or sets the validation type used for the query string key that determines which item is selected.**

- "int"
- "guid"
- "string"

### ShowEditDeleteButtons

**Indicates if edit and delete buttons should automatically be shown for each displayed item in the edit mode of CMS Desk.**

### TransformationName

**Name of the transformation applied to standard items in format `<document type code name>.<transformation name>`.**

### Appearance and styling

You can modify the appearance of the QueryDataList control by setting the standard properties of the ASP.NET DataList control (inherited through the BasicDataList). You can find more details on particular properties in the .NET Framework documentation for the DataList class.

The design of list items can be determined by the transformations specified by the `AlternatingTransformationName`, `TransformationName` and `SelectedItemTransformationName` properties or by the code of the template properties inherited from the standard ASP.NET DataList control.

### QueryRepeater

#### Overview

The QueryRepeater control displays document data from the Kentico CMS database in a list based on transformations without the need to write any extra code. Additionally, it allows you to specify the query used to retrieve data through its `QueryName` property. Only queries stored in the `CMS_Query` table of the Kentico CMS database can be selected, so if you wish to use a custom query, you must create it there or edit an existing one. The queries can be managed through the administration interface at Site Manager -> Development -> Document types / System tables / Custom tables -> ... Edit (✏) object ... -> Queries.

The QueryRepeater is derived from the BasicRepeater control.

If you only wish to display data from a specific part of the content tree, please consider using the CMSRepeater control instead.

Please refer to the Using control properties to set query clauses topic to find information about using properties such as `WhereCondition` with this control.

The portal engine equivalent of the QueryRepeater control is the Listings and viewers -> Repeater with custom query web part.
Please note

If you only wish to display data from a specific part of the content tree, please consider using the CMSRepeater control instead.

The following topics are available to help you familiarize yourself with the QueryRepeater control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

1.8.6.3.6.2 Getting started

The following is a step-by-step tutorial that will show you how to display a list of all laptops (CMS.Laptop documents) from the sample Corporate Site using the QueryRepeater control:

1. Create a new **Web form** somewhere in your website installation directory.

2. Switch to its **Design** tab, drag and drop a **QueryRepeater** control from the toolbox onto the form and set its following properties:
   
   - **QueryName**: cms.laptop.selectdocuments
   - **TransformationName**: ecommerce.transformations.Product_SimplePreview

   This assigns the query that should be used to retrieve laptop documents and the transformations that should be used to display them.

3. Switch to the **Source** tab. The code of the QueryRepeater control should look like this:

   ```xml
   <cms:QueryRepeater ID="QueryRepeater1" runat="server" QueryName="cms.laptop.selectdocuments" TransformationName="ecommerce.transformations.Product_SimplePreview" />
   ```

   It's not necessary to define the standard **ItemTemplate** elements of the Repeater control since the transformation names have already been specified.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a list like this:
1.8.6.3.6.3 Configuration

As it is inherited from the BasicRepeater control, the QueryRepeater control has all of its properties. These can be found in the BasicRepeater -> Configuration topic.

In addition, it has all of the following properties that can be set or used in the API:

- **CMSBase - common properties**
- **CMS Custom query - common properties**

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingTransformationName</td>
<td>Name of the transformation applied to alternating items in format <code>&lt;document type code name&gt;.&lt;transformation name&gt;</code>.</td>
<td></td>
</tr>
<tr>
<td>EnablePaging</td>
<td>Indicates whether the built-in DataPager control should be used to page the list. This property does not affect the UniPager control, which must be added separately if you wish to use it.</td>
<td></td>
</tr>
<tr>
<td>IsSelected</td>
<td>Indicates whether the current data source contains the selected item.</td>
<td></td>
</tr>
</tbody>
</table>
### Appearance and styling

You can modify the appearance of the QueryRepeater control by setting the standard properties of the ASP.NET Repeater control (inherited through the BasicRepeater). You can find more details on particular properties in the .NET Framework documentation for the Repeater class.

The design of list items can be determined by the transformations specified by the AlternatingTransformationName, TransformationName and SelectedItemTransformationName properties or by the code of the template properties inherited from the standard ASP.NET Repeater control.

| Property | Description | Value
|----------|-------------|------|
| ItemSeparator | Separator between displayed items. | "<hr/>"
| PagerControl | This property can be used to set or get the pager control and its properties. | |
| SelectedDatabaseColumnName | Gets or sets the column name that should be used to select items. | |
| SelectedItemTransformationName | Name of the transformation applied to the selected item in format `<document type code name>.<transformation name>`. | |
| SelectedQueryStringKeyName | Gets or sets the query string key name. The presence of the key in a query string indicates, that some item should be selected. The item is determined by the value of the query string key. | |
| SelectedValidationType | Gets or sets the validation type used for the query string key that determines which item is selected. | "int", "guid", "string"
| ShowEditDeleteButtons | Indicates if edit and delete buttons should automatically be shown for each displayed item in the edit mode of CMS Desk. | |
| TransformationName | Name of the transformation applied to standard items in format `<document type code name>.<transformation name>`. | |

### QueryUniView

#### Overview

The QueryUniView control displays document data from the Kentico CMS database in a hierarchical structure based on transformations without the need to write any additional code. Using hierarchical transformations, this control can be used to display documents with a varying design depending on their type and hierarchical level. Please see the Using hierarchical transformations topic under the CMSUniView control for an example of how this works.

Additionally, it allows you to specify the query used to retrieve data through its QueryName property. Only queries stored in the CMS_Query table of the Kentico CMS database can be selected, so if you wish to use a custom query, you must create it there or edit an existing one. The queries can be
managed through the administration interface at Site Manager -> Development -> Document types / System tables / Custom tables -> ... Edit (✓) object ... -> Queries.

The QueryUniView is derived from the BasicUniView control.

Please refer to the Using control properties to set query clauses topic to find information about using properties such as WhereCondition with this control.

The portal engine equivalent of the QueryUniView control is the Listings and viewers -> Universal viewer with custom query web part.

Please note

If you only wish to display data from a specific part of the content tree, please consider using the CMSUniView control instead.

The following topics are available to help you familiarize yourself with the QueryUniView control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - describes how the design of the control can be modified

1.8.6.3.7.2 Getting started

The following is a step-by-step tutorial that will show you how to display all pages (CMS.Menuitem documents) from the sample Corporate Site in a hierarchical structure using the QueryUniView control:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a QueryUniView control onto the form and set its following properties:

   - **LoadHierarchicalData**: true
   - **QueryName**: CMS.Menuitem.selectdocuments
   - **IDColumnName**: NodeID
   - **ParentIDColumnName**: NodeParentID
   - **LevelColumnName**: NodeLevel
   - **TransformationName**: CMS.Menuitem.ListItem
   - **HeaderTransformationName**: CMS.Menuitem.ListItemHeader
   - **FooterTransformationName**: CMS.Menuitem.ListItemFooter

   This tells the control to load data in a hierarchical grouped dataset, assigns the query that should be used to retrieve the page documents, sets the column names that should be used to determine the hierarchy structure of the pages and assigns the transformations that should be used to display them.

3. Switch to the Source tab. The code of the QueryUniView control should look like this:
It's not necessary to define the standard **ItemTemplate** elements of the UniView control since the transformation names have already been specified.

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should display a hierarchical list like this:

1.8.6.3.7.3   Configuration

As it is inherited from the **BasicUniView** control, which is in turn derived from the **UniView** control, the QueryUniView control has all of their properties. These can be found in the **BasicUniView** ->
In addition, it has all of the following properties that can be set or used in the API:

- **CMSBase - common properties**
- **CMS Custom query - common properties**

As well as:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DelayedLoading</td>
<td>Indicates whether data should be loaded during the load event instead of the default init event.</td>
<td></td>
</tr>
<tr>
<td>EnablePaging</td>
<td>Indicates whether the built-in UniPager control should be used to for paging. If you wish to use paging, please be sure to set LoadHierarchicalData to false, as hierarchical data cannot be paged.</td>
<td></td>
</tr>
<tr>
<td>IDColumnName</td>
<td>Gets or sets the name of the column that is used as a unique identifier for the displayed objects. It is used in a parent-child relationship with the column specified in the ParentIDColumnName property.</td>
<td>&quot;NodeID&quot;</td>
</tr>
<tr>
<td>IsSelected</td>
<td>Indicates whether the current data source contains the selected item.</td>
<td></td>
</tr>
<tr>
<td>ItemSeparatorValue</td>
<td>Separator between displayed items. This property has greater priority than the separator set in the transformation given in the SeparatorTransformationName property.</td>
<td>&quot;&lt;hr/&gt;&quot;</td>
</tr>
<tr>
<td>LevelColumnName</td>
<td>Gets or sets the name of the column that is used to determine the hierarchical level of items.</td>
<td>&quot;NodeLevel&quot;</td>
</tr>
<tr>
<td>LoadHierarchicalData</td>
<td>Indicates whether data should be bound in default format or changed to a hierarchical grouped dataset.</td>
<td></td>
</tr>
<tr>
<td>PagerControl</td>
<td>Gets the current UniPager control used for paging.</td>
<td></td>
</tr>
<tr>
<td>PagerPosition</td>
<td>The position of the pager relative to the paged data.</td>
<td>&quot;Bottom&quot; &quot;Top&quot; &quot;TopAndBottom&quot;</td>
</tr>
<tr>
<td>ParentIDColumnName</td>
<td>Gets or sets the name of the column that contains the unique identifier of an object's parent. It is used in a parent-child relationship with the column specified in the IDColumnName property.</td>
<td>&quot;NodeParentID&quot;</td>
</tr>
<tr>
<td>Property Name</td>
<td>Description</td>
<td>Sample Value</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>SelectedDatabaseColumnName</td>
<td>Gets or sets the column name that should be used to identify the currently selected item.</td>
<td>&quot;DocumentID&quot;</td>
</tr>
<tr>
<td>SelectedQueryStringKeyName</td>
<td>Gets or sets the query string key name. The presence of this key in a query string indicates that some item should be selected. The item is determined by the value of the query string key.</td>
<td></td>
</tr>
<tr>
<td>SelectedValidationType</td>
<td>Gets or sets the validation type used for the query string key that determines which item is selected.</td>
<td>&quot;int&quot; &quot;guid&quot; &quot;string&quot;</td>
</tr>
<tr>
<td>ShowEditDeleteButtons</td>
<td>Indicates if edit and delete buttons should automatically be shown for each displayed item in the edit mode of CMS Desk.</td>
<td></td>
</tr>
<tr>
<td>UseHierarchicalOrder</td>
<td>Indicates whether the default hierarchical order value should be used. The order is used only if LoadHierarchicalData is set to true. The default order value is &quot;NodeLevel, NodeOrder&quot;. The value of the OrderBy property is added to the end of the OrderBy expression. Enabling this property is only recommended when displaying documents.</td>
<td></td>
</tr>
</tbody>
</table>

### Specifying transformations

The following properties can be filled to define which transformations should be used by the control. All transformations are specified in format:

<document type code name>.<transformation name>

The design of the listed items can alternatively be set by defining the ItemTemplate elements inherited from the UniView control between the tags of the QueryUniView control.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternatingTransformationName</td>
<td>Name of the transformation applied to items that have an even position in the listing order. Every level in the hierarchy has its own separate alternation pattern.</td>
<td></td>
</tr>
<tr>
<td>FirstTransformationName</td>
<td>Name of the transformation applied to the first item on every level in the hierarchy. Only works for levels that contain more than one item.</td>
<td></td>
</tr>
<tr>
<td>FooterTransformationName</td>
<td>Name of the transformation rendered at the end of every level (after the last item on the level). Can be used to close encapsulating</td>
<td></td>
</tr>
<tr>
<td><strong>Template Name</strong></td>
<td><strong>Description</strong></td>
<td><strong>Sample Value</strong></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>PagerCurrentPageTemplate</td>
<td>Code of the template used for the current page in the pager. Use <code>&lt;%# Eval(&quot;Page&quot;) %&gt;</code> to get the current page number, <code>&lt;%# Eval(&quot;PageURL&quot;) %&gt;</code> to get page the URL or <code>&lt;%# Eval(&quot;PageLink&quot;) %&gt;</code> to get the page link.</td>
<td><code>&lt;strong&gt;</code>&lt;%# Eval(&quot;Page&quot;) %&gt;&lt;<code>&lt;/strong&gt;</code></td>
</tr>
<tr>
<td>PagerDirectPageTemplate</td>
<td>Code of the template used for direct page changing. Use a TextBox or DropDownList control with ID directPageControl to register the page change event.</td>
<td><code>&lt;asp:TextBox ID=&quot;DirectPageControl&quot; runat=&quot;server&quot; Style=&quot;</code></td>
</tr>
</tbody>
</table>
1.8.6.3.7.4 Appearance and styling

The appearance of the QueryUniView control is determined by the transformations specified by its **TransformationName** properties or by the code of the **ItemTemplates** inherited from the UniView control and by certain other properties. These are described in more detail in the Configuration topic.
1.8.7 Edit mode buttons

1.8.7.1 Overview

The controls in this section display buttons that allow Kentico CMS documents to quickly and easily be created, edited or deleted. These buttons are only displayed in the Edit mode of CMS Desk.

Available controls:

- CMSEditModeButtonAdd
- CMSEditModeButtonEditDelete

1.8.7.2 CMSEditModeButtonAdd

1.8.7.2.1 Overview

The CMSEditModeButtonAdd control displays a button that is shown in the Edit mode of CMS Desk and allows content editors to add a new document when they click it. It provides an intuitive way of creating new documents.

The following topics are available to help you familiarize yourself with the CMSEditModeButtonAdd control:

- Getting started - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control
- Appearance and styling - lists which CSS classes can be used with the control

1.8.7.2.2 Getting started

The following tutorial will show you how to display a button, that creates new news documents, on an ASPX page template using the CMSEditModeButtonAdd control:

1. Create a new Web form and prepare it to be an ASPX page template according to the guide found in the Using ASPX page templates topic.

2. Switch to its Design tab, drag and drop a CMSEditModeButtonAdd control from the toolbox onto the form and set its following properties:

   - ClassName: CMS.News
   - Path: /News/

   This tells the control what type of documents it should create and sets the path to the document under which they should be added.

   The code of the control will look like this:

```xml
<cms:CMSEditModeButtonAdd ID="CMSEditModeButtonAdd1" runat="server" Path="/News/" ClassName="CMS.News" />
```

3. Switch to the code behind of the page and make sure it has the following references at the beginning of the code:
4. Now add the following code to the `Page_Load` method:

[C#]

```csharp
// Register edit mode buttons script
if (CMSContext.ViewMode != ViewModeEnum.LiveSite)
{
    ScriptHelper.RegisterClientScriptBlock(this, typeof(string), ScriptHelper.EDIT_DOCUMENT_SCRIPT_KEY, ScriptHelper.EditDocumentScript);
}
```

This is necessary if you wish to use the control individually on an ASPX page template.

5. Save the changes to the web form. Now if you look at the page using the created template on some website in the *Edit* mode of CMS Desk, a button like the one in the following image will be displayed:

![Add new](image)

If you press the button, it will redirect you to the form used to create new news documents under the `/News` page.

### 1.8.7.2.3 Configuration

The following properties of the CMSEditModeButtonAdd control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClassName</td>
<td>Document type that specifies the type of the document that should be created.</td>
<td>&quot;cms.article&quot;</td>
</tr>
<tr>
<td>Path</td>
<td>Alias path of the parent document under which the new document should be created. If omitted, the document is added under the currently selected document.</td>
<td>&quot;/whitepapers&quot;</td>
</tr>
<tr>
<td>StopProcessing</td>
<td>Indicates if processing of the control should be stopped and the control should not retrieve or display any data.</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>Custom caption of the button. If not set, the default text &quot;Add new&quot; is displayed.</td>
<td>&quot;Add new article&quot;</td>
</tr>
</tbody>
</table>
1.8.7.4 Appearance and styling

The appearance of the CMSEditModeButtonAdd control is determined by the CSS class it uses.

You can use the following CSS class to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSEditModeButtonAdd</td>
<td>CSS style of the &lt;A&gt; element.</td>
</tr>
</tbody>
</table>

The recommended place to define this class is in a stylesheet in the Kentico CMS administration interface at Site Manager -> Development -> CSS stylesheets. These stylesheets can be applied to individual documents (pages) that contain the control in CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet.

1.8.7.3 CMSEditModeButtonEditDelete

1.8.7.3.1 Overview

The CMSEditModeButtonEditDelete control displays a pair of buttons that are shown in the Edit mode CMS Desk and allow content editors to edit or delete documents when they click it. It provides an intuitive way of editing/deleting documents.

Many CMS listing controls (and web parts), such as the CMS Repeater (Repeater) have the ShowEditDeleteButtons (Show Edit and Delete buttons) property, which causes this control to automatically be shown next to every displayed document. The path of these controls will automatically be set to that of the corresponding displayed document.

The following topics are available to help you familiarize yourself with the CMSEditModeButtonEditDelete control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - lists which CSS classes can be used with the control

1.8.7.3.2 Getting started

The following tutorial will show you how to display a pair of buttons, that can edit or delete a specific news document, on an ASPX page template using the CMSEditModeButtonEditDelete control:

1. Create a new Web form and prepare it to be an ASPX page template according to the guide found in the Using ASPX page templates topic.

2. Switch to its Design tab, drag and drop a CMSEditModeButtonEditDelete control from the toolbox onto the form and set its Path property to /News/New-Consulting-Services.

This sets the path to the document that the control should edit or delete.

The code of the control will look like this:
3. Switch to the code behind of the page and make sure it has the following references at the beginning of the code:

[C#]
```
using CMS.UIControls;
using CMS.CMSHelper;
using CMS.PortalEngine;
using CMS.GlobalHelper;
```

4. Now add the following code to the `Page_Load` method:

[C#]
```
// Register edit mode buttons script
if (CMSContext.ViewMode != ViewModeEnum.LiveSite)
{
    ScriptHelper.RegisterClientScriptBlock(this, typeof(string), ScriptHelper.EDIT_DOCUMENT_SCRIPT_KEY, ScriptHelper.EditDocumentScript);
}
```

This is necessary if you wish to use the control individually on an ASPX page template.

5. Save the changes to the web form. Now if you look at the page using the created template on some website in the **Edit** mode of **CMS Desk**, a pair of buttons as seen in the following image will be displayed:

![Edit Delete](image)

If you press the **Edit** button, it will redirect you to the form used to edit the `/News/Your-first-news` document. If you click the **Delete** button, the same document will be deleted.

**Use in transformations**

If you wish to use this control in the code of a **transformation**, you can do so by adding code similar to the following:

```xml
<cms:CMSEditModeButtonEditDelete runat="server" id="btnEditDelete" Path='"%Eval ("NodeAliasPath") %' />
```

The path will automatically be set to that of the currently transformed document.
1.8.7.3.3 Configuration

The following properties of the CMSEditModeButtonEditDelete control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeleteText</td>
<td>Custom caption of the delete button. If not set, the default text &quot;Delete&quot; is displayed.</td>
<td>&quot;Delete article&quot;</td>
</tr>
<tr>
<td>EditText</td>
<td>Custom caption of the edit button. If not set, the default text &quot;Edit&quot; is displayed.</td>
<td>&quot;Edit article&quot;</td>
</tr>
<tr>
<td>Path</td>
<td>Alias path of the document to be edited/deleted.</td>
<td>&quot;/whitepapers/myfirstpaper&quot;</td>
</tr>
</tbody>
</table>

1.8.7.3.4 Appearance and styling

The appearance of the CMSEditModeButtonEditDelete control is determined by the CSS classes it uses.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSEditModeButtonEdit</td>
<td>CSS style of the edit button &lt;A&gt; element.</td>
</tr>
<tr>
<td>CMSEditModeButtonDelete</td>
<td>CSS style of the delete button &lt;A&gt; element.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at Site Manager -> Development -> CSS stylesheets. These stylesheets can be applied to individual documents (pages) that contain the control in CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet.

1.8.8 Editable regions for ASPX page templates

1.8.8.1 Overview

The controls in this section allow the creation of editable regions that can be used by editors to fill in content. They provide editing dialogs in the Edit mode of CMS Desk and once some content is entered into them, it is displayed on the live site. They are only compatible with Kentico CMS ASPX page templates.

Please note:

If you wish to have this kind of functionality on Portal engine templates, use the Editable text and Editable image web parts instead.

Available controls:
The CMSEditableImage control displays an editable region in the Edit mode of CMS Desk that allows content editors to select an image. The chosen image is then displayed without the selection interface on the live version of the website.

Please note

This control is compatible only with ASPX page templates. On portal engine pages, use the Text -> Editable image web part instead of this control.

This control requires either the CMSPageManager or CMSPortalManager control to regulate the flow of data to/from the editable region, it doesn't communicate with the database directly. There only has to be one Manager control for any number of CMSEditableImage controls.

The following topics are available to help you familiarize yourself with the CMSEditableImage control:

- Getting started - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control

1.8.8.2.2 Getting started

The following is a step-by-step tutorial that will show you how to display a region which can be used to select and display images using the CMSEditableImage control:

1. Create a new Web form in your website installation directory under the CMSTemplates/CorporateSite folder and check the Select master page box.
2. The Select a Master Page dialog appears. Choose the folder `CMSTemplates/CorporateSite` and choose the `root.master` file and click OK.

3. Follow the remaining steps of the guide found in the Using ASPX page templates topic.

4. Switch to the Design tab and drag and drop a CMSEditableImage control from the toolbox onto the form and set its ImageTitle property to Image Example.

5. Switch to the Source tab. The code of the CMSEditableImage control should look like this:

```
<cms:CMSEditableImage ID="CMSEditableImage1" runat="server" ImageTitle="Image Example" />
```

It's not necessary to add the CMSPageManager control onto the web form, as there is already a CMSPortalManager control on the root.master master page.

6. Save the changes to the web form. Now if you look at the page using the created template on some website, it will display an image selection dialog in the Edit mode of CMS Desk similar to the following:

Now if you select an image and press the Save button, the image will be displayed on the live site version of the page without the selection dialog.

1.8.8.2.3 Configuration

The following properties of the CMSEditableImage control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlternateText</td>
<td>ALT text of the image displayed on the website.</td>
<td></td>
</tr>
<tr>
<td>DisplaySelectorTextBox</td>
<td>Indicates whether a textbox with the image path should be displayed in Edit mode.</td>
<td></td>
</tr>
<tr>
<td>ImageControl</td>
<td>Returns the instance of the used Image control.</td>
<td></td>
</tr>
<tr>
<td>ImageCSSClass</td>
<td>Sets or gets the name of the image CSS class.</td>
<td></td>
</tr>
<tr>
<td>ImageHeight</td>
<td>Image height in pixels - the image will be resized to this height.</td>
<td></td>
</tr>
<tr>
<td>ImageStyle</td>
<td>Sets or gets the style of the image.</td>
<td></td>
</tr>
<tr>
<td>ImageTitle</td>
<td>Title displayed above the image in Edit mode.</td>
<td></td>
</tr>
<tr>
<td>ImageWidth</td>
<td>Image width in pixels - the image will be resized to this width.</td>
<td></td>
</tr>
</tbody>
</table>
1.8.8.3 CMSEditableRegion

1.8.8.3.1 Overview

The CMSEditableRegion control displays an editable region in the Edit mode of CMS Desk that allows website editors to enter a wide range of content. It then displays its content without the editing interface on the live version of the website.

Please note

This control is compatible only with ASPX page templates. On portal engine pages, use the Text -> Editable text web part instead of this control.

This control requires either the CMSPageManager or CMSPortalManager control to regulate the flow of data to/from the editable region, it doesn't communicate with the database directly. There only has to be one Manager control for any number of CMSEditableRegion controls.

The following topics are available to help you familiarize yourself with the CMSEditableRegion control:

- **Getting started** - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - lists which CSS classes can be used with the control and how its appearance can be modified

1.8.8.3.2 Getting started

The following is a step-by-step tutorial that will show you how to display an editable region, which works as an HTML editor, using the CMSEditableRegion control:

1. Create a new Web form in your website installation directory under the CMSTemplates/CorporateSite folder and check the Select master page box.

2. The Select a Master Page dialog appears. Choose the folder CMSTemplates/CorporateSite and choose the root.master file and click OK.

3. Follow the remaining steps of the guide found in the Using ASPX page templates topic.

4. Switch to the Design tab and drag and drop a CMSEditableRegion control from the toolbox onto the form and set its following properties:

- **RegionTitle**: Region Example
- **DialogHeight**: 200
- **RegionType**: HTMLEditor
- **HTMLAreaToolbarLocation**: In

This specifies the height of the editable region, tells the control that the region should act as an HTML editor and that the toolbar of the editor should be displayed directly above the region.
5. Switch to the **Source** tab. The code of the CMSEditableRegion control should look like this:

```xml
<cms:CMSEditableRegion ID="CMSEditableRegion1" runat="server" RegionTitle="Region Example"
DialogHeight="200" RegionType="HTMLEditor" HtmlAreaToolbarLocation="In" />
```

It's not necessary to add the CMSPageManager control onto the web form, as there is already a CMSPortalManager control on the *root.master* master page.

6. Save the changes to the web form. Now if you look at the page using the created template on some website, it will display an editable region in the **Edit** mode of **CMS Desk** similar to the following:

![Editable Region Example](image)

Now if you enter some content and press the **Save** button, it will be displayed on the live site version of the page without the editor.

### 1.8.8.3.3 Configuration

The following properties of the CMSEditableRegion control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DialogHeight</td>
<td>Height of the displayed region in pixels.</td>
<td></td>
</tr>
<tr>
<td>DialogWidth</td>
<td>Width of the displayed region in pixels.</td>
<td></td>
</tr>
<tr>
<td>HtmlAreaToolbar</td>
<td>Name of the HTML editor toolbar set. This is only used if the RegionType property is set to HtmlEditor.</td>
<td>&quot;Default&quot;</td>
</tr>
<tr>
<td>HtmlAreaToolbarLocation</td>
<td>Determines the location of the HTML editor toolbar. This is only used if the RegionType property is set to HtmlEditor.</td>
<td>&quot;In&quot; for inline - directly above the region &quot;Out:CKToolbar&quot; for shared - at the top of the page</td>
</tr>
<tr>
<td>InheritContent</td>
<td>Indicates if the content of the editable region should be inherited from the parent page (menu item) document.</td>
<td></td>
</tr>
<tr>
<td>MaxLength</td>
<td>Maximum length of the content (in number of</td>
<td></td>
</tr>
</tbody>
</table>
### 1.8.8.3 Appearance and styling

The appearance of the CMSEditableRegion control is determined by the CSS classes it uses and by some of its properties.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSEditableRegionEdit</td>
<td>Style of the main <code>&lt;TABLE&gt;</code> element.</td>
</tr>
<tr>
<td>CMSEditableRegionTitle</td>
<td>Style of the <code>&lt;TD&gt;</code> element containing the error title.</td>
</tr>
<tr>
<td>CMSEditableRegionError</td>
<td>Style of the <code>&lt;TD&gt;</code> element containing the error message.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at **Site Manager -> Development -> CSS stylesheets**. These stylesheets can be applied to individual documents (pages) that contain the control in **CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet**.

### 1.8.8.4 CMSPageManager

#### 1.8.8.4.1 Overview

The CMSPageManager control is required for pages with editable regions, as it manages the flow of data to/from the CMSEditableRegion and CMSEditableImage controls. It ensures that the content of editable regions is loaded from and saved to the database. It also displays the "Save" dialog.

**Please note**

The CMSPageManager control is obsolete. It is still supported for the purposes of backward compatibility, but we recommend using the CMSPortalManager instead, which provides all of the same functionality and more. Further information can be found...
Data Source

Content is loaded from the nearest Page (menu item) document in the alias path specified through the URL or through the **DefaultPageAliasPath** property. The content is stored in the following format:

```xml
<content>
  <region id="ID of the CMSEditableRegion control related to this content section">
    <![CDATA[ content of the editable region ]]> 
  </region>
  <region id="...">
    <![CDATA[ content of the editable region ]]> 
  </region>
</content>
```

The following topics are available to help you familiarize yourself with the CMSEditableRegion control:

- **Getting started** - describes the basics of using the control
- **Configuration** - describes and explains the properties that can be set for the control
- **Appearance and styling** - lists which CSS classes can be used with the control

1.8.8.4.2 Getting started

To use the CMSPageManager control, simply drag and drop it from the toolbox onto an ASPX page template that contains CMSEditableImage or CMSEditableRegion controls. A common place to have the control is on the **master page**, as this allows it to manage editable regions on all page templates that use this master page.

1.8.8.4.3 Configuration

The following properties of the CMSPageManager control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
</table>
| CacheDependencies  | List of the cache keys on which the cached data depends. When the cache item changes, the cache of the control is cleared. Each item (dependency) must be on one line.  
                      If you leave this property empty, default dependencies will be used.                                                                                           | cms.user|all |
<p>| CachefItemName     | Name of the cache item the control will use. By setting this name dynamically, you can achieve caching based on a URL parameter or some other variable - simply enter the                                                                 | &quot;homepage_pagemanager&quot;          |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value of the parameter.</td>
<td>If no value is set, the control stores its content in the item named &quot;URL</td>
</tr>
<tr>
<td>CacheMinutes</td>
<td>Number of minutes the retrieved content is cached for.</td>
</tr>
<tr>
<td></td>
<td>Zero indicates that the content will not be cached.</td>
</tr>
<tr>
<td></td>
<td>-1 indicates that the site-level settings should be used.</td>
</tr>
<tr>
<td></td>
<td>This parameter allows you to set up caching of content so that it doesn't have to be retrieved from the database each time a user requests the page.</td>
</tr>
<tr>
<td>CheckPermissions</td>
<td>Allows you to specify whether to check permissions of the current user. If the value is 'false' (default value) no permissions are checked.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, only nodes for which the user has read permission can be selected.</td>
</tr>
<tr>
<td>CMSEditableControls</td>
<td>Returns an array containing the managed editable controls (CMSEditableImage or CMSEditableRegion).</td>
</tr>
<tr>
<td>CombineWithDefaultCulture</td>
<td>Indicates if the results should be combined with default language versions in case the translated version is not available.</td>
</tr>
<tr>
<td></td>
<td>This property is applied only if you do not set the TreeProvider property manually.</td>
</tr>
<tr>
<td>CultureCode</td>
<td>Culture code of documents to be selected, such as en-us. If not specified, it's read from the user's session or the default value is used.</td>
</tr>
<tr>
<td>DefaultPageAliasPath</td>
<td>Default path that is used if no alias path is provided in the query string or through a friendly URL.</td>
</tr>
<tr>
<td>ErrorMessage</td>
<td>Gets or sets the error message string.</td>
</tr>
<tr>
<td>InfoMessage</td>
<td>Gets or sets the information message string.</td>
</tr>
<tr>
<td>IsAuthorized</td>
<td>Is true if the current user is authorized for the current document.</td>
</tr>
<tr>
<td>PageAliasPath</td>
<td>The alias path of the current page.</td>
</tr>
<tr>
<td>PreserveContent</td>
<td>Allows you to specify whether the content of non-existing or not visible regions should be preserved when the content is saved.</td>
</tr>
<tr>
<td>SaveChanges</td>
<td>Is true if the current changes to the page should be saved.</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>SiteName</td>
<td>Specifies the site code name.</td>
</tr>
<tr>
<td>TagKey</td>
<td>Overrides the generation of the SPAN tag with a custom tag.</td>
</tr>
<tr>
<td>TreeProvider</td>
<td>Tree provider instance used to access data. If no TreeProvider is assigned, a new TreeProvider instance is created automatically.</td>
</tr>
<tr>
<td>ViewMode</td>
<td>Gets or sets the current page mode.</td>
</tr>
</tbody>
</table>

The appearance of the CMSPageManager control is determined by the CSS classes it uses.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSPageManagerError</td>
<td>Style of the error label.</td>
</tr>
<tr>
<td>CMSPageManagerLabel</td>
<td>Style of the standard label.</td>
</tr>
<tr>
<td>CMSPageManagerTextLink</td>
<td>Style of the link.</td>
</tr>
<tr>
<td>CMSPageManagerTDLabel</td>
<td>Style of the TD element that contains text with save confirmation message.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at Site Manager -> Development -> CSS stylesheets. These stylesheets can be applied to individual documents (pages) that contain the control in CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet.

### 1.8.9 Search Controls

#### 1.8.9.1 Overview

The controls in this section provide the capability to search through the content of the Kentico CMS database. They use the SQL search engine, which uses standard SQL queries to search for a given expression. It runs a separate query for each document type. You can find the search query for a given document type in Site Manager -> Development -> Document types -> ... select document type ... -> Queries -> Edit ( Modi the searchtree query.

Common fields (such as document name) are searched using the cms.root.searchdocuments query.

Uploaded files are searched using the cms.root.searchattachments query. If you want to search uploaded files, you need to configure the system as described at Developer’s Guide -> Installation and deployment -> Additional configuration tasks -> Configuration of full-text search in files. In this case, the files are searched using the Microsoft SQL Server Search Engine.
Please note

Current Kentico CMS versions contain Smart search capability. The Smart search engine is index based and has significantly better performance than the SQL search engine.

To learn more about it, please refer to Developer's Guide -> Modules -> Smart search.

Available controls:

- CMSSearchDialog
- CMSSearchResults

1.8.9.2 CMSSearchDialog

1.8.9.2.1 Overview

The CMSSearchDialog control allows users to enter expressions that are then searched for in the Kentico CMS database. The user can also (optionally) specify the search scope (where to search) and search mode (how to search).

CMSSearchDialog can easily be used with the CMSSearchResults control to display search results. Both controls can be used separately.

The CMSSearchDialog control is not connected to any data source - it only communicates with the user. The search method in the CMSSearchResults dialog uses the pre-defined searchtree queries stored in document type definitions. It combines all results and returns them as one table.

The portal engine equivalent of the CMSSearchDialog control is the Full-text search -> SQL Search dialog web part.

The following topics are available to help you familiarize yourself with the CMSSearchDialog control:

- Getting started - contains a step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control
- Structure - continues the tutorial from Getting started, shows a more advanced example of how the control can be configured and demonstrates what individual template properties affect
- Appearance and styling - lists which CSS classes can be used with the control and how its appearance can be modified

1.8.9.2.2 Getting started

The following is a step-by-step tutorial that will show you how to create a working search dialog using the CMSSearchDialog and CMSSearchResults controls:

1. Create a new Web form somewhere in your website installation directory.

2. Switch to its Design tab, drag and drop a CMSSearchDialog control from the toolbox onto the form.
3. Now drag and drop a **CMSSearchResults** control form the toolbox onto the form below the CMSSearchDialog and set its **CMSSearchDialogID** property to **CMSSearchDialog1**.

The code of the two controls should look like this:

```xml
<cms:CMSSearchDialog ID="CMSSearchDialog1" runat="server" />
<cms:CMSSearchResults ID="CMSSearchResults1" runat="server" CMSSearchDialogID="CMSSearchDialog1">
</cms:CMSSearchResults/>
```

4. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page will contain a functional search dialog that will allow you to search the sample Corporate Site:

```html
Search for: Office  Go
```

Continue this tutorial in the **Structure** topic to see how to create a more advanced search dialog.

1.8.9.2.3  Configuration

The following properties of the CMSSearchDialog control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CustomQueryStringData</td>
<td>Gets or sets a custom query string which is placed after search querystring data, do not use &amp; or ? at the start of the custom query string.</td>
<td></td>
</tr>
<tr>
<td>SearchExpression</td>
<td>Entered word(s) to be searched for.</td>
<td></td>
</tr>
<tr>
<td>SearchMode</td>
<td>Search mode - any word, all words or exact phrase.</td>
<td>&quot;AllWords&quot; &quot;AnyWord&quot; &quot;ExactPhrase&quot;</td>
</tr>
<tr>
<td>SearchScope</td>
<td>Indicates whether all content or only the current section should be searched.</td>
<td>&quot;SearchAllContent&quot; &quot;SearchCurrentSection&quot;</td>
</tr>
</tbody>
</table>
ShowSearchMode | Indicates whether search mode settings should be displayed.
---|---
ShowSearchScope | Indicates whether search scope settings should be displayed.
StopProcessing | Indicates if processing of the control should be stopped and the control should not retrieve or display any data.

**CMSSearchDialog Events**

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DoSearch</td>
<td>Occurs when a user submits the dialog.</td>
</tr>
</tbody>
</table>

The CMSSearchDialog contains the following controls. Refer to the **Structure** topic to see what individual controls represent. They can be accessed in your code behind through the following properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SearchButton</td>
<td>Search submit button.</td>
</tr>
<tr>
<td>SearchForLabel</td>
<td>SearchFor label control.</td>
</tr>
<tr>
<td>SearchForTextBox</td>
<td>SearchFor textbox.</td>
</tr>
<tr>
<td>SearchModeLabel</td>
<td>SearchMode label.</td>
</tr>
<tr>
<td>SearchModeList</td>
<td>SearchMode drop-down list.</td>
</tr>
<tr>
<td>SearchScopeLabel</td>
<td>SearchScope label.</td>
</tr>
<tr>
<td>SearchScopeList</td>
<td>SearchScope drop-down list.</td>
</tr>
</tbody>
</table>

**1.8.9.2.4 Structure**

This topic shows an example of how the CMSSearchDialog control looks when its **ShowSearchMode** and **ShowSearchScope** properties are enabled. If you wish to create this example for yourself, please follow the tutorial in the **Getting started** topic, then continue with the following steps:

1. Make sure that the following properties of the CMSSearchDialog are set:
   - **ShowSearchMode**: True
   - **ShowSearchScope**: True

   The code of the CMSSearchDialog control should now look like this:

   ```xml
   <cms:CMSSearchDialog ID="CMSSearchDialog1" runat="server" ShowSearchMode="True" ShowSearchScope="True" />
   ```

2. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in**
Browser. The resulting page should look like the following diagram (without the descriptions), which shows the structure of the CMSSearchDialog control:

Individual areas correspond with the controls the dialog is composed of.

1.8.9.2.5 Appearance and styling

The appearance of the CMSSearchDialog control is determined by the CSS classes it uses and by some of its properties.

You can use the following CSS classes to modify the design of the control:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSSearchDialogSearchButton</td>
<td>CSS class of the search button.</td>
</tr>
<tr>
<td>CMSSearchDialogSearchForLabel</td>
<td>CSS class of the &quot;Search for:&quot; label.</td>
</tr>
<tr>
<td>CMSSearchDialogSearchForTextBox</td>
<td>CSS class of the search expression text box.</td>
</tr>
<tr>
<td>CMSSearchDialogSearchModeDropDownList</td>
<td>CSS class of the search mode drop down list.</td>
</tr>
<tr>
<td>CMSSearchDialogSearchModeLabel</td>
<td>CSS class of the &quot;Search mode:&quot; label.</td>
</tr>
<tr>
<td>CMSSearchDialogSearchScopeDropDownList</td>
<td>CSS class of the search scope drop down list.</td>
</tr>
<tr>
<td>CMSSearchDialogSearchScopeLabel</td>
<td>CSS class of the &quot;Search Scope:&quot; label.</td>
</tr>
</tbody>
</table>

The recommended place to define these classes is in a stylesheet in the Kentico CMS administration interface at Site Manager -> Development -> CSS stylesheets. These stylesheets can be applied to individual documents (pages) that contain the control in CMS Desk -> Content -> Edit -> Properties -> General -> CSS stylesheet.

The design can also be modified in your code behind files by configuring individual controls contained in the CMSSearchDialog. The properties that can be used to access them are listed in the Configuration topic.
1.8.9.3 CMSSearchResults

1.8.9.3.1 Overview

The CMSSearchResults control is used to display search results according to parameters provided from the CMSSearchDialog control.

It can also receive search results using the CMS.TreeEngine.TreeProvider.Search() method.

The displayed search results can be formatted using the built-in DataPager control.

The portal engine equivalent of the CMSSearchResults control is the Full-text search -> SQL Search results web part.

The following topics are available to help you familiarize yourself with the CMSSearchResults control:

- CMSSearchDialog -> Getting started - contains a quick step-by-step tutorial that allows you to learn the basics of using the control
- Configuration - describes and explains the properties that can be set for the control
- Structure - demonstrates what individual templates and transformations affect
- Appearance and styling - describes how the design of the control can be modified

1.8.9.3.2 Configuration

The following properties of the CMSSearchResults control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CacheDependencies</td>
<td>List of the cache keys on which the cached data depends. When the cache item changes, the cache of the control is cleared. Each item (dependency) must be on one line. If you leave this property empty, default dependencies will be used.</td>
<td>cms.user</td>
</tr>
<tr>
<td>CacheItemName</td>
<td>Name of the cache item the control will use. By setting this name dynamically, you can achieve caching based on a URL parameter or some other variable - simply enter the value of the parameter. If no value is set, the control stores its content in the item named &quot;URL</td>
<td>ControlID&quot;.</td>
</tr>
<tr>
<td>CacheMinutes</td>
<td>Number of minutes the retrieved content is cached for. Zero indicates that the content will not be cached.</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>-1</td>
<td>Indicates that the site-level settings should be used.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This parameter allows you to set up caching of content so that it doesn't have to be retrieved from</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the database each time a user requests the page.</td>
<td></td>
</tr>
<tr>
<td>CheckPermissions</td>
<td>Allows you to specify whether to check permissions of the current user. If the value is 'false'</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(default value) no permissions are checked. Otherwise, only nodes for which the user has read</td>
<td></td>
</tr>
<tr>
<td></td>
<td>permission are selected.</td>
<td></td>
</tr>
<tr>
<td>ClassNames</td>
<td>Specifies which document type should be selected. Several values separated by a semicolon can be</td>
<td>&quot;cms.news&quot; or</td>
</tr>
<tr>
<td></td>
<td>entered.</td>
<td>&quot;cms.news;cms.article&quot;</td>
</tr>
<tr>
<td>CMSSearchDialogID</td>
<td>You can use this property to specify the ID of the source <a href="#">CMSSearchDialog</a> control that provides</td>
<td>&quot;CMSSearchDialog1&quot;</td>
</tr>
<tr>
<td></td>
<td>search parameters.</td>
<td></td>
</tr>
<tr>
<td>CombineWithDefaultCulture</td>
<td>Indicates whether documents from the default culture version should be used if they are not available</td>
<td></td>
</tr>
<tr>
<td></td>
<td>in the selected culture.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This property is applied only if you do not set the <a href="#">TreeProvider</a> property manually.</td>
<td></td>
</tr>
<tr>
<td>CultureCode</td>
<td>Culture code of documents to be selected, such as en-us. If not specified, it's read from the user's</td>
<td>&quot;en-us&quot;</td>
</tr>
<tr>
<td></td>
<td>session or the default value is used.</td>
<td></td>
</tr>
<tr>
<td>DataSource</td>
<td>Gets or sets a DataSet containing values used to fill the items of the control.</td>
<td></td>
</tr>
<tr>
<td>EnablePaging</td>
<td>Enables the paging of search results. True by default.</td>
<td></td>
</tr>
<tr>
<td>FilterControl</td>
<td>Gets or sets the appropriate filter control used to limit the data read by this control.</td>
<td></td>
</tr>
<tr>
<td>FilterName</td>
<td>Gets or sets the code name of the appropriate filter control used to limit the data read by this</td>
<td></td>
</tr>
<tr>
<td></td>
<td>control.</td>
<td></td>
</tr>
<tr>
<td>FilterOutDuplicates</td>
<td>Indicates if duplicated (linked) documents should be filtered out from the data.</td>
<td></td>
</tr>
<tr>
<td>IgnoreTransformations</td>
<td>Indicates whether the <a href="#">TransformationName</a> property should be ignored and the templates for</td>
<td></td>
</tr>
<tr>
<td></td>
<td>direct access (described further below) used instead.</td>
<td></td>
</tr>
<tr>
<td>NoResultsLabel</td>
<td>The label control that should be displayed when there are no results.</td>
<td></td>
</tr>
</tbody>
</table>
The CMSSearchResults control accepts the following querystring (URL) parameters:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>searchtext</td>
<td>Searched text</td>
<td>products</td>
</tr>
<tr>
<td>searchmode</td>
<td>Search mode</td>
<td>allwords, exactphrase, anyword (default value)</td>
</tr>
</tbody>
</table>
This topic shows an example of how the CMSSearchResults control can be configured. If you wish to create this example for yourself, please follow the tutorial in the CMS Search Dialog -> Getting started topic, then continue with the following steps:

1. Add the code marked by the **CMSSearchResults templates** comments between the `<cms:CMSSearchResults>` tags. The overall code of the CMSSearchResults control should look like this:

```
<cms:CMSSearchResults ID="CMSSearchResults1" runat="server" CMSSearchDialogID ="CMSSearchDialog1">
  <%-- CMSSearchResults templates -------------------------------------------------- -->
  <HeaderTemplate>
    <hr/>
  </HeaderTemplate>
  <FooterTemplate>
    <hr/>
  </FooterTemplate>
  <%-- CMSSearchResults templates -------------------------------------------------- -->
</cms:CMSSearchResults>
```

2. Save the changes to the web form. Now right-click it in the Solution explorer and select **View in Browser**. The resulting page should look like the following diagram (without the descriptions), which shows the structure of the CMSSearchResults control. Individual areas are described below.
SearchDialog - the `CMSSearchDialog` control specified by the `CMSSearchDialogID` property.

HeaderTemplate - this area is defined by the code between the `<HeaderTemplate>` tags.

Search Result Items - this area is used to display the search results. It is defined by the transformation specified by the `TransformationName` property (`cms.root.searchresults` by default) or by the code between the `<ItemTemplate>` tags if the `IgnoreTransformations` property is enabled.

FooterTemplate - this area is defined by the code between the `<FooterTemplate>` tags.

Pager - the built-in `DataPager` control, which is used for the paging of search results unless the `EnablePaging` property is set to `false`. It can be accessed through the `PagerControl` property.

### Appearance and styling

The appearance of the CMSSearchResults control is determined by the transformation specified in its `TransformationName` property or by its templates.

The following templates can be defined:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FooterTemplate</td>
<td>Code of the template used for the footer.</td>
<td><code>&lt;hr /&gt;</code></td>
</tr>
<tr>
<td>HeaderTemplate</td>
<td>Code of the template used for the header.</td>
<td><code>&lt;hr /&gt;</code></td>
</tr>
<tr>
<td>ItemTemplate</td>
<td>Code of the template applied to search result items.</td>
<td></td>
</tr>
</tbody>
</table>
1.9 UI Controls

1.9.1 Overview

UI Controls are user controls that provide the functionality of standard user interface elements, but offer a higher degree of versatility and customization, and also support additional useful features. Many examples of these controls can be found in the administration interface of Kentico CMS.

Available controls:

- UniGrid
- UniSelector

1.9.2 UniGrid

1.9.2.1 Overview

The UniGrid is a user control that can be used to display data in a highly customizable and flexible table. It also supports many additional features such as paging, sorting, filtering, row selection and action buttons. It is used extensively in the user interface of Kentico CMS.

Although this control may only be used within a Kentico CMS project, it can display data from an external data source.

Please be aware that using the UniGrid control beyond its most basic functions requires some knowledge of coding and Kentico CMS API.

The following topics are available to help you familiarize yourself with the UniGrid control:

- Getting started - contains a step-by-step tutorial that allows you to learn the basics of using the control.
- Implementing custom functionality - contains a tutorial showing how custom modifications can be added via code.
- Configuration - describes and explains the properties that can be set for the control.
- UniGrid definition - describes the format of the special configuration options used to determine the structure and behaviour of the UniGrid control.

1.9.2.2 Getting started

The following is a step-by-step tutorial that will show you how to display a list of all users from the Kentico CMS Database in a table and implement a simple action button using the UniGrid user control:

1. Create a new Web form called User_UniGrid.aspx somewhere in your website installation directory.

2. Add the following directive to the beginning of the page code to register the UniGrid control:

```xml
<%@ Register src="~/CMSAdminControls/UI/UniGrid/UniGrid.ascx" tagname="UniGrid"
tagprefix="cms" %>
<%@ Register Namespace="CMS.UIControls.UniGridConfig" TagPrefix="ug" Assembly ="CMS.UIControls" %>
```
3. Modify the `<%@ Page %>` directive at the top of the code as in the following example:

```csharp
```

The Theme attribute was added with its value set to "Default", which specifies the default theme used to style the UniGrid control. Please keep in mind that the value of the Inherits attribute depends on the location of the web form, so the example above will not match your code exactly.

4. Now add the following code into the content area of the page (by default between the `<div>` tags inside the `<form>` element):

```csharp
<ajaxToolkit:ToolkitScriptManager ID="manScript" runat="server" EnableViewState="false" />
<asp:Label runat="server" ID="lblInfo" EnableViewState="false" Visible="false" />
<cms:UniGrid ID="UserGrid" runat="server" GridName="User_UniGrid.xml" OrderBy="UserName" />
```

This adds a standard label control, that will be used to display information messages, and the UniGrid control itself. The label is not necessary for the functioning of the UniGrid, but it can be very convenient, for example to display error messages.

The ToolkitScriptManager control is required by the UniGrid control. It is only there to ensure that the example is functional by itself and will usually be included on your website's master page, so you do not have to add it in real-world scenarios.

5. Now create a new XML file called User_UniGrid.xml in the same location as the web form. It will be used as the configuration file for the UniGrid control and as you can see, it is already specified in the GridName property. Now copy the following into the XML file and save it:

```xml
<?xml version="1.0" encoding="utf-8" ?>
<grid>
  <actions>
    <action name="edit" caption="$General.Edit$" icon="Edit.png" />
  </actions>
  <columns>
    <column source="UserName" caption="$general.username$" width="100%" />
  </columns>
  <query name="cms.user.selectall" columns="UserID, UserName" />
</grid>
```

The basic example above defines only a single action (edit) and one column containing user names without any additional configuration settings. This example uses a query to retrieve the user data. For more details and a full account of the settings that can be set though the UniGrid's XML configuration file, please see the UniGrid definition topic.

6. Switch to the code behind of the User_UniGrid.aspx web form and add the following code into it.
Please keep in mind that the name of the class will be different according to the location of your web form.

[C#]

```csharp
using CMS.SiteProvider;
using CMS.GlobalHelper;

public partial class UniGridExample_User_UniGrid : System.Web.UI.Page
{
    protected void Page_Load(object sender, EventArgs e)
    {
        // Assigns a handler for the OnAction event
        UserGrid.OnAction += userGrid_OnAction;
    }

    /// <summary>
    /// Handles the UniGrid's OnAction event.
    /// </summary>
    protected void userGrid_OnAction(string actionName, object actionArgument)
    {
        // Defines the code used to implement the edit action
        if (actionName == "edit")
        {
            // Sets an integer to the value of the actionArgument argument (UserID)
            int userId = ValidationHelper.GetInteger(actionArgument, 0);

            // Gets a UserInfo object of the user with the given ID
            UserInfo ui = UserInfoProvider.GetUserInfo(userId);

            // If user exists
            if (ui != null)
            {
                // Sets the information label to display the full name of the edited user
                lblInfo.Visible = true;
                lblInfo.Text = "Edited user: " + HTMLHelper.HTMLEncode(ui.FullName);
            }
        }
    }
}
```

This code demonstrates how the task that should be performed when an action is used can be implemented. The parameters of `OnAction` event handlers are explained below:

- **string actionName** - is used to identify which action raised the event; this example only has one action, but the UniGrid control often contains more in real scenarios. The name passed into this parameter is defined in the configuration XML file in the `name` attribute of individual `<action>` elements.

- **object actionArgument** - is used to pass the value of a data source column from the UniGrid row for which the action was used. The used column can be specified in the configuration XML file in the `commandargument` attribute of individual `<action>` elements, otherwise the first column in the data source is used by default.

This example only displays the full name of the "edited" user in the label above the UniGrid when the edit
button is clicked, but any required action can be implemented in a similar fashion.

7. Save the changes to all files. Now right-click the web form in the Solution explorer and select **View in Browser**. The resulting page should display a table containing user names and edit action buttons. If you click one of the edit buttons, the full name of the user on the same row will be displayed above the grid, similar to the following:

![User Table Example](image)

### 1.9.2.3 Implementing custom functionality

This tutorial follows up on the one from the **Getting started** topic and will demonstrate how custom functionality can be added to action buttons and columns using the handler of the **OnExternalDataBound** event:

1. Open the web form from the previous tutorial as well as its code behind and XML configuration files.

2. Modify the XML configuration file like in the following code:

```xml
<?xml version="1.0" encoding="utf-8" ?>
<grid>
  <actions>
    <action name="edit" caption="$General.Edit$" icon="Edit.png" externalsourcename="edit_modify" />
  </actions>

  <columns>
    <column source="UserName" caption="$general.username$" width="100%" externalsourcename="user_modify" />
  </columns>

  <query name="cms.user.selectall" columns="UserID, UserName" />
</grid>
```

This defines the **externalsourcename** attributes used to identify the action or column in the **OnExternalDataBound** handler, where the required functionality can be implemented.

3. Switch to the code behind file, and add the sections marked in the following code:

```
[C#]
```
using System.Data;
using CMS.SiteProvider;
using CMS.GlobalHelper;

public partial class UniGridExample_User_UniGrid : System.Web.UI.Page
{
    protected void Page_Load(object sender, EventArgs e)
    {
        // Assigns a handler for the OnAction event
        UserGrid.OnAction += userGrid_OnAction;

        // Assigns a handler for the OnExternalDataBound event
        UserGrid.OnExternalDataBound += userGrid_OnExternalDataBound;
    }

    /// <summary>
    /// Handles the Unigrid's OnExternalDataBound event.
    /// </summary>
    protected object userGrid_OnExternalDataBound(object sender, string sourceName, object parameter)
    {
        switch (sourceName)
        {
            case "edit_modify":
                string userName = ValidationHelper.GetString(((DataRowView)((GridViewRow)parameter).DataItem).Row["UserName"], "");

                if (userName == "administrator")
                {
                    //Gets the ImageButton object of the edit action that is being processed
                    ImageButton button = ((ImageButton)sender);

                    //Disables the button and changes its icon
                    button.ImageUrl = "~/App_Themes/Default/Images/Design/Controls/UniGrid/Actions/Editdisabled.png";
                    button.Enabled = false;
                }
                break;

            case "user_modify":
                break;
        }
    }
}
//Returns modified user names to be displayed in the UniGrid
return Convert.ToString(parameter) + " - modified";

return parameter;

/// <summary>
/// Handles the UniGrid's OnAction event.
/// </summary>
protected void userGrid_OnAction(string actionName, object actionArgument)
{
    //Defines the code used to implement the edit action
    if (actionName == "edit")
    {
        //Sets an integer to the value of the actionArgument parameter (UserID)
        int userId = ValidationHelper.GetInteger(actionArgument, 0);

        //Gets a UserInfo object of the user with the given ID
        UserInfo ui = UserInfoProvider.GetUserInfo(userId);

        //If user exists
        if (ui != null)
        {
            //Sets the information label to display the full name of the
            //Edited user
            lblInfo.Visible = true;
            lblInfo.Text = "Edited user: " + HTMLHelper.HTMLEncode(ui.FullName);
        }
    }
}

This code demonstrates how custom functionality can be handled for actions and columns. The parameters of OnExternalDataBound event handlers are explained below:

- **object sender** - is used to pass the ImageButton object of the current action. For columns, it contains a DataRowView of the current row.
- **string sourceName** - is used to identify the action or column for which the functionality is implemented. The name passed into this parameter is defined in the UniGrid's definition in the externalsourcename attribute of individual <action> or <column> elements.
- **object parameter** - is used to pass the value in the current row of a column. For actions, it contains a DataRowView of the current row.

This example modifies the edit action to be disabled for the UniGrid row containing the user named administrator, and also alters the values displayed in the UserName column. Any custom functionality required for actions or columns can be implemented in a similar fashion.

4. Save the changes to all files. Now right-click the web form in the Solution explorer and select View in Browser. The resulting page should display a table just like in the example before, but all the values in the User name column will be modified, and the edit action for the administrator user will be grayed out and won't be functional:
1.9.2.4 Configuration

The following properties of the UniGrid control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Specifies the columns that should be loaded from the data source specified in the DataSource property.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>By default, the values of the first column are passed as the actionArgument parameter of the OnAction event handler. This can be overridden in the definition by specifying a column name in the commandargument attribute of individual &lt;action&gt; elements.</td>
<td></td>
</tr>
<tr>
<td>CompleteWher eCondition</td>
<td>Can be used to get the used WHERE clause including any modifications applied by the filter.</td>
<td></td>
</tr>
<tr>
<td>DataSource</td>
<td>Can be used to gets or set an object (DataSet or DataTable) containing the data to be displayed by the UniGrid control.</td>
<td></td>
</tr>
<tr>
<td>DelayedReload</td>
<td>If enabled, data will not be loaded automatically during the Load event of the page and the ReloadData() method must be called manually instead.</td>
<td></td>
</tr>
<tr>
<td>FilterDirectory</td>
<td>Path to the control (.ascx file) that should be used instead of the default filter. The default relative path is ~/CMSAdminControls/UI/UniGrid/Filters/.</td>
<td></td>
</tr>
<tr>
<td>FilteredZeroRo wsText</td>
<td>Text to be shown when no rows are displayed after the filter is applied.</td>
<td></td>
</tr>
<tr>
<td>FilterLimit</td>
<td>Determines the minimum amount of rows that must be displayed in the UniGrid before a filter is shown. The default value is read from the CMSDefaultListingFilterLimit web.config key.</td>
<td></td>
</tr>
<tr>
<td>GridName</td>
<td>Contains the name of an external XML file that defines the structure and behaviour of the UniGrid control. For more information, please refer to the UniGrid definition topic.</td>
<td></td>
</tr>
<tr>
<td><strong>GridView</strong></td>
<td>Can be used to access the GridView control encapsulated by the UniGrid.</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>HideControlForZeroRows</strong></td>
<td>Indicates whether the control should be hidden when no rows are loaded. The control is not hidden if the filter causes zero rows to be displayed.</td>
<td></td>
</tr>
<tr>
<td><strong>ImageDirectoryPath</strong></td>
<td>Path to the directory that contains images used by the control. The default value is <code>~/App_Themes/Default/Images/Design/Controls/UniGrid/Actions</code>.</td>
<td></td>
</tr>
<tr>
<td><strong>NamedColumns</strong></td>
<td>Gets a dictionary mapping custom names to <code>DataControlField</code> objects that represent the columns of the UniGrid. The names of columns can be specified in the UniGrid's definition through the <code>name</code> attribute of individual <code>&lt;column&gt;</code> elements. This can be used to access the grid's columns in your code. For example:</td>
<td></td>
</tr>
<tr>
<td><strong>[C#]</strong></td>
<td><code>UniGrid.NamedColumns[&quot;column1&quot;].Visible = false;</code></td>
<td></td>
</tr>
<tr>
<td><strong>ObjectType</strong></td>
<td>Can be used to define the data class of the objects that should be loaded as the data source and displayed by the UniGrid control. A list of all available data classes and related information can be found in the <code>CMS_Class</code> database table. Alternatively, the same can be defined in the UniGrid's definition through the <code>&lt;objecttype&gt;</code> element as described in the following topic. Please note that this approach is not supported for classes representing document types (i.e. those whose value in the <code>ClassIsDocumentType</code> column is 1). In these cases, you can load the required data by specifying an appropriate query through the <code>Query</code> property.</td>
<td></td>
</tr>
<tr>
<td><strong>OrderBy</strong></td>
<td>The ORDER BY clause used to determine how the UniGrid rows are sorted when the page is first loaded.</td>
<td></td>
</tr>
<tr>
<td><strong>Pager</strong></td>
<td>Can be used to access the UniGridPager control used for paging.</td>
<td></td>
</tr>
<tr>
<td><strong>PageSize</strong></td>
<td>This setting can be used to override the default values offered by the page size selection drop-down list. Values must be separated by commas.</td>
<td></td>
</tr>
</tbody>
</table>
The ##ALL## macro can be used as a value to indicate that all rows should be displayed. The default value is "25,50,100,##ALL##".

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query</td>
<td>Can be used to specify the name of the query that should be used to retrieve data from the Kentico CMS database to be displayed by the UniGrid control. The name is entered in format <code>&lt;class name&gt;.&lt;query name&gt;</code>. Alternatively, the same can be defined in the definition through the <code>&lt;query&gt;</code> element as described in the following topic.</td>
</tr>
<tr>
<td>SelectedItems</td>
<td>Gets (as an ArrayList) or sets the currently selected rows from the UniGrid.</td>
</tr>
<tr>
<td>ShowActionsMenu</td>
<td>Indicates whether the header of the actions column should contain a context menu that provides the option to export the data displayed in the grid into various other formats (Excel, CSV or XML).</td>
</tr>
<tr>
<td>ShowObjectMenu</td>
<td>Indicates if an action providing a context menu with object actions should automatically be added to the displayed grid. This requires the data source of the UniGrid to be an object type, specified either through the <code>&lt;objecttype&gt;</code> element or the <code>ObjectType</code> property. This menu provides options that can be used to Export, Backup, Restore or Destroy individual listed objects. Some types of objects may not have all menu options available. This action is not added if there is another action specified that has a <code>contextmenu</code> attribute or in cases where there are no actions at all defined for the grid. The default value is <code>true</code>.</td>
</tr>
<tr>
<td>SortDirect</td>
<td>The ORDER BY clause reflecting the current row sorting being used by the UniGrid.</td>
</tr>
<tr>
<td>TopN</td>
<td>Specifies the maximum amount of rows that should be selected.</td>
</tr>
<tr>
<td>WhereCondition</td>
<td>Can be used to get the used WHERE clause without modifications applied by the filter.</td>
</tr>
<tr>
<td>ZeroRowsText</td>
<td>Text to be shown when the control is hidden by the <code>HideControlForZeroRows</code> property.</td>
</tr>
</tbody>
</table>

The following events of the UniGrid control are available:

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OnAction</td>
<td>Occurs when one of the actions of the control is used. The name of the</td>
</tr>
</tbody>
</table>
given action is passed as a parameter to the handlers of the event. An example of how it is used can be found in the [Getting started](#) topic.

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OnExternalDataBound</td>
<td>Occurs after data is loaded. It is used to implement a custom design or functionality for UniGrid columns, including the action column. An example of how it is used can be found in the <a href="#">Implementing custom functionality</a> topic.</td>
</tr>
<tr>
<td>OnBeforeDataReload</td>
<td>This event can be used to perform any actions before the <code>ReloadData()</code> method is executed.</td>
</tr>
<tr>
<td>OnAfterDataReload</td>
<td>This event can be used to perform any actions after the <code>ReloadData()</code> method is executed.</td>
</tr>
</tbody>
</table>

### 1.9.2.5 UniGrid definition

Many configuration options that determine the behavior, design and content of the UniGrid control must be specifically defined. This can either be done either in an external XML configuration file, which is then assigned to the control through its `GridName` property, or directly within the definition of the control in the ASPX markup of the page or user control where the UniGrid is placed.

When using an external XML file, it must be organized according to the structure shown below (some elements are optional):

```xml
<?xml version="1.0" encoding="utf-8" ?>
<grid>
    <actions>
        <action />
        <separator />
        ...
    </actions>
    <columns>
        <column>
            <tooltip />
            <filter />
            ...
        </column>
        ...
    </columns>
    <objecttype />
    <query>
        <parameter />
        ...
    </query>
    <pager>
        <key name="DefaultPageSize" value="10" />
        ...
    </pager>
</grid>
```
Please note

If you use an external XML configuration file to specify the UniGrid's definition, the names of elements and their attributes used must be written in **lower case** to be recognized correctly, since it is case sensitive.

To define the UniGrid directly in the ASPX markup, it is first necessary to register the following namespace at the start of the code (in addition to the UniGrid control):

```xml
<%@ Register Namespace="CMS.UIControls.UniGridConfig" TagPrefix="ug" Assembly="CMS.UIControls" %>
```

Then you can simply add elements under the control according to the following structure:

```xml
<cms:UniGrid runat="server" ID="UniGrid" ...

    <GridActions>
        <ug:Action />
        <ug:ActionSeparator />
        ...
    </GridActions>

    <GridColumn>
        <ug:Column>
            <Tooltip />  
            <Filter />  
            ...
        </ug:Column>
        ...
    </GridColumn>

    <PagerConfig DisplayPager="true" ...

    <GridOptions DisplayFilter="true" ... />

</cms:UniGrid>
```

When using this approach, the data source of the control must be specified directly through the UniGrid's properties (Query, ObjectType or DataSource). An advantage of this option is that you may use the IntelliSense in Visual Studio to help find the appropriate elements and attributes.

Individual elements that can be defined for the UniGrid and their attributes are described below:
<actions> (<GridActions>):

This element is used to define a column that contains various possible actions (e.g. Edit, Delete, View...) represented by icons for every row of the UniGrid. Individual actions must be defined by child <action> elements.

The following attributes of the <actions> element are available:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>cssclass</td>
<td>Specifies the name of a CSS class from the assigned stylesheet to be used to style the appearance of the actions column.</td>
<td>&quot;UniGridCustomActionsColumn&quot;</td>
</tr>
<tr>
<td>parameters</td>
<td>A list of columns separated by semicolons that will be usable as parameters in the onclick or menuparameter attributes of child &lt;action&gt; elements.</td>
<td>&quot;AttachmentGUID; AttachmentFormGUID&quot;</td>
</tr>
<tr>
<td>showheader</td>
<td>Indicates whether the header of the actions column should be displayed. The default value is true.</td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>Determines the width of the actions column in the UniGrid.</td>
<td>&quot;30%&quot; &quot;100px&quot;</td>
</tr>
</tbody>
</table>

This element may contain <action> and <separator> child elements.

<action> (<ug:Action>):

This element is used to define individual actions. The implementation of individual actions is handled during the OnAction event of the UniGrid control. Any advanced features of individual action buttons, such as defining when a button should be functional, can be implemented in the handler of the OnExternalDataBound event.

The following attributes are available:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>caption</td>
<td>Specifies the text used as the tooltip of the image defined in the icon attribute. You can enter the name of a resource string if you start and end it with the $ character.</td>
<td>&quot;$General.Delete$&quot;</td>
</tr>
<tr>
<td>commandargument</td>
<td>The name of the column whose value should</td>
<td></td>
</tr>
<tr>
<td>be passed as the <strong>actionArgument</strong> parameter of the <strong>OnAction</strong> event handler.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If not defined, the first column of the data source will be used.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>confirmation</strong></td>
<td>The text used in a JavaScript confirmation for the action. Most commonly used as a confirmation for delete type actions. You can enter the name of a resource string if you start and end it with the $ character.</td>
<td></td>
</tr>
<tr>
<td>&quot;$General.ConfirmDelete$&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>contextmenu</strong></td>
<td>The relative path to a control (.ascx file) that implements a context menu for the action. Controls created for this purpose must inherit from the <strong>CMS.ExtendedControls.CMSContextMenuControl</strong> class.</td>
<td></td>
</tr>
<tr>
<td>&quot;~/CMSAdminControls/UI/UniGrid/Controls/ObjectMenu.ascx&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>externalsourcename</strong></td>
<td>Name of the action that is passed as the <strong>sourceName</strong> parameter of the <strong>OnExternalDataBound</strong> event handler.</td>
<td></td>
</tr>
<tr>
<td>&quot;deletefile&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>icon</strong></td>
<td>Name of the image that should be used as the icon of the action. The image must be located in the folder defined by the <strong>ImageDirectoryPath</strong> property of the UniGrid.</td>
<td></td>
</tr>
<tr>
<td>&quot;delete.png&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>menuparameter</strong></td>
<td>Contains an array of parameters passed to the control implementing the action's context menu (the path to this control must be specified in the <strong>contextmenu</strong> attribute). These parameters may be retrieved in the control's code using the <strong>GetContextMenuParameter</strong> JavaScript function. The columns defined in the <strong>parameters</strong> attribute of the <strong>&lt;actions&gt;</strong> element may be entered as parameters using the following expressions:</td>
<td></td>
</tr>
<tr>
<td>&quot;new Array('cms.site', '{0}')&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>mousebutton</strong></td>
<td>Specifies which mouse button causes the action's context menu to appear (if a context menu is enabled via the <strong>contextmenu</strong> attribute). If not defined, both mouse buttons open the context menu.</td>
<td></td>
</tr>
<tr>
<td>&quot;left&quot; &quot;right&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>Name of the action. This is passed to the handler of the <strong>OnAction</strong> event as the <strong>actionName</strong> parameter.</td>
<td>&quot;delete&quot;</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>onclick</td>
<td>The JavaScript OnClick function for the given action. It may use the columns defined in the <strong>parameters</strong> attribute of the <strong>&lt;actions&gt;</strong> element as parameters, which can be called by using the following expressions:</td>
<td>&quot;alert('{0}');&quot;</td>
</tr>
<tr>
<td></td>
<td>{0} - first parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>{1} - second parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and so forth.</td>
<td></td>
</tr>
</tbody>
</table>

**Action security**

<table>
<thead>
<tr>
<th>modulename</th>
<th>This attribute (and the two listed below) may be specified to leverage the security model of Kentico CMS to make the action usable only by a limited group of users. Enter the code name of the module related to the action. You can find information about modules, their permissions and UI elements in the <strong>Site Manager -&gt; Development -&gt; Modules</strong> interface.</th>
<th>&quot;cms.ecommerce&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>permissions</td>
<td>Sets the code name of the permission that users must have to be allowed to perform the action. The permissions must belong to the module specified in the <strong>modulename</strong> attribute.</td>
<td>&quot;modifyorders&quot;</td>
</tr>
<tr>
<td>uielements</td>
<td>If specified, users will need to be allowed to view the given UI element in order to perform the action. The given user interface element must belong to the module specified in the <strong>modulename</strong> attribute.</td>
<td>&quot;orders.general&quot;</td>
</tr>
<tr>
<td>hideifnotauthorized</td>
<td>Indicates if the action should be hidden for users who are not allowed to perform it (as defined by the attributes above).</td>
<td></td>
</tr>
</tbody>
</table>

**Default object menu action**

If your UniGrid control uses an object type data source (specified either through the **<objecttype>** definition element or the **ObjectType** property), then an action providing a context menu will automatically be added to the displayed grid.

This menu provides options that can be used to Export, Backup, Restore or Destroy
the listed objects. Some types of objects may not have all menu options available.

This does not occur if you manually specify another action with a `contextmenu` attribute or in cases where there are no actions at all defined for the grid. You can also disable this action by setting the `ShowObjectMenu` property of the UniGrid to `false`.

<separator> (**ug:ActionSeparator**):

This element is used to define a separator between actions. The following attribute is available for it:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>text</td>
<td>Text to be generated in the Literal control between actions.</td>
<td><code>&lt;span class=&quot;UniGridActionSeparator&quot;&gt; &lt;/span&gt;</code></td>
</tr>
</tbody>
</table>

<columns> (**GridColumns**):

This element represents the main section of the UniGrid. The `<columns>` element itself has no attributes as each column can have its own settings. Individual columns are defined by child `<column>` elements.

<column> (**ug:Column**):

This element is used to define columns. Any advanced functionality of the cells in the given column can be implemented in the handler of the `OnExternalDataBound` event.

The following attributes are available for it:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>action</td>
<td>Can be used to set the name of an action that will be performed when the content of this column's cells is clicked. An action with this name must be defined for the UniGrid via the <code>name</code> attribute of an <code>&lt;action&gt;</code> element.</td>
<td></td>
</tr>
<tr>
<td>allowsorting</td>
<td>Indicates whether the column can be used to sort the rows of the UniGrid.</td>
<td></td>
</tr>
<tr>
<td>caption</td>
<td>Specifies the text used as the header for the column. You can enter the name of a resource string if you start and end it with the <code>$</code> character.</td>
<td><code>$general.name$</code></td>
</tr>
<tr>
<td>commandargument</td>
<td>The name of the column whose value should be passed as the <code>actionArgument</code> parameter of the <code>OnAction</code> event handler</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>cssclass</td>
<td>Specifies the name of a CSS class from the assigned stylesheet to be used to style the appearance of the given column.</td>
<td>&quot;UniGridCustomColumn&quot;</td>
</tr>
<tr>
<td>externalsourcename</td>
<td>Sets a name for the column that will be passed as the sourceName parameter of the OnExternalDataBound event handler. Used for implementing custom functionality in the cells of the given column. You can use the following values to call built-in functions of the UniGrid to format the content of the column without having to write any code:</td>
<td></td>
</tr>
<tr>
<td>href</td>
<td>If a URL is entered here, a link to this URL is generated around the content of the cells in this column. Macros {0}, {1}, ... can be used to access parameters defined by the parameters attribute.</td>
<td>&quot;~/page.aspx&quot;</td>
</tr>
<tr>
<td>icon</td>
<td>Name of an image that should be added into the column cells after the loaded data. The image must be located in the folder defined by the ImageDirectoryPath property of the UniGrid.</td>
<td>&quot;edit.png&quot;</td>
</tr>
<tr>
<td>istext</td>
<td>Indicates whether the content of the column is of type Text or nText. This is used to generate a special OrderBy clause of the query, so it must be set if sorting is enabled.</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>localize</td>
<td>Indicates whether localization should be enabled for string values in the column.</td>
<td></td>
</tr>
<tr>
<td>maxlen</td>
<td>Sets the maximum number of characters that can be displayed in the column's cells. The last 3 characters will be replaced by periods.</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>Can be used to set a custom name for the column, which will be used in the column dictionary accessible through the <code>NamedColumns</code> property of the UniGrid control.</td>
<td></td>
</tr>
<tr>
<td>parameters</td>
<td>Names of the columns used as parameters of the URL generated by the <code>Href</code> attribute. Separated by semicolons.</td>
<td></td>
</tr>
<tr>
<td>source</td>
<td>Name of the column from the data source of the UniGrid that is used as the source for the content of this column. The special macro <code>##ALL##</code> can be used to specify all columns.</td>
<td></td>
</tr>
<tr>
<td>sort</td>
<td>Used to define the column name to be used for sorting if the <code>##ALL##</code> macro is used in the <code>source</code> attribute.</td>
<td></td>
</tr>
<tr>
<td>style</td>
<td>The style used for the entire column.</td>
<td></td>
</tr>
<tr>
<td>visible</td>
<td>Indicates whether the column should be visible.</td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>Determines the width of the column.</td>
<td></td>
</tr>
<tr>
<td>wrap</td>
<td>Indicates whether word wrapping is used in the column.</td>
<td></td>
</tr>
</tbody>
</table>

The column element may contain child `<tooltip>` and `<filter>` elements.

**<tooltip>**:

When this element is added, a tooltip is displayed when the mouse hovers over the content of the cells in this column. If an icon is present in the cell, the tooltip is displayed over the icon instead of the text. The content of the tooltip can be defined and configured by the following attributes:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>encode</td>
<td>Indicates whether the output of the tooltip should be encoded.</td>
<td></td>
</tr>
</tbody>
</table>
externalsourcename | Name used in the OnExternalDataBound event for changing the appearance of the tooltip. This can be used to create complex tooltips including images, panels etc. |
|---|

source | Name of the column from the data source of the UniGrid that is used as the source of the tooltip. |

width | Determines the width of the tooltip. |

<filter>:

When this element is added, the given column will be used in the UniGrid filter. The following attributes are available to configure the filter:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>format</td>
<td>Can be used to define a custom WHERE clause format to be generated by the default filter. The following expressions can be used: &lt;br&gt; ( {0} ) - is resolved into the column name &lt;br&gt; ( {1} ) - is resolved into the operator selected in the drop-down list of the default filter &lt;br&gt; ( {2} ) - is resolved into the value entered into the textbox of the default filter</td>
<td>&quot; [[0]] {1} {2}&quot;</td>
</tr>
<tr>
<td>size</td>
<td>Determines the maximum amount of characters that can be entered into the textbox of the default filter. Available for Text, Integer and Double filter types. The default value is 1000.</td>
<td></td>
</tr>
<tr>
<td>source</td>
<td>Name of the column used in the WHERE clause generated by the filter.</td>
<td></td>
</tr>
<tr>
<td>path</td>
<td>Path to the control (.ascx file) that should be used instead of the default filter for the column. If filled, the type attribute is ignored. The default relative path is ~/CMSAdminControls/UI/UniGrid/Filters/.</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>The filter type that should be created for the given column.</td>
<td>&quot;Text&quot; &quot;Bool&quot; &quot;Integer&quot; &quot;Double&quot;</td>
</tr>
</tbody>
</table>

<objecttype>:

This element can be used to define the data class of the objects that should be loaded as the data source and displayed by the UniGrid control. A list of all data classes and related information can be found in the CMS_Class database table. Please note that this approach is not supported for classes...
representing document types (those whose value in the `ClassIsDocumentType` column is `1`).

If this element isn't used, a data source must be retrieved by means of the `<query>` element or assigned through the UniGrid control's `DataSource` property before its `ReloadData()` method is called. Alternatively, the `ObjectType` property of the UniGrid control can be used for the same purpose.

The following attributes can be used to define the object type:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>columns</td>
<td>Names of the columns that should be retrieved separated by commas. If empty, all columns will be retrieved. By default, the values of the first column are passed as the <code>actionArgument</code> parameter of the <code>OnAction</code> event handler. This can be overridden for actions by specifying a column name in the <code>commandargument</code> attribute of individual <code>&lt;action&gt;</code> elements.</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>Code name of the used data class.</td>
<td>&quot;cms.user&quot;</td>
</tr>
</tbody>
</table>

`<query>`:

This element can be used to specify the system query that will retrieve data from the Kentico CMS database to be displayed by the UniGrid control. If it isn't used, an external data source must be assigned through the UniGrid control's `DataSource` property before its `ReloadData()` method is called. Alternatively, the `Query` property of the UniGrid control can be used for the same purpose.

The following attributes can be used to define the query:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>columns</td>
<td>Names of the columns that should be retrieved by the query separated by commas. If empty, all database columns will be retrieved. By default, the values of the first column are passed as the <code>actionArgument</code> parameter of the <code>OnAction</code> event handler. This can be overridden for actions by specifying a column name in the <code>commandargument</code> attribute of individual <code>&lt;action&gt;</code> elements.</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>Code name of the used system query in format <code>&lt;class name&gt;.&lt;query name&gt;</code>.</td>
<td>&quot;cms.site.selectsitelist&quot;</td>
</tr>
</tbody>
</table>

The query element may contain `<parameter>` child elements:

`<parameter>`:
This element can be used to define the value of a parameter inside the specified query.

The following attributes must be filled to define the parameter:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Name of the parameter. Parameters are placed into queries using the following syntax: @&lt;paramater name&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, if the specified query looked like this:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SELECT TOP @customTop FROM CMS_User</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Then entering customTop into this attribute would cause the value of this element to be used by the query instead of the @customTop expression.</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>The type of the parameter.</td>
<td>&quot;String&quot; &quot;Int&quot; &quot;Double&quot; &quot;Bool&quot;</td>
</tr>
<tr>
<td>value</td>
<td>The value of the parameter.</td>
<td></td>
</tr>
</tbody>
</table>

<pager> (<PagerConfig>):

This element is used to define the behaviour of the UniGrid pager. You can either add the settings as child <key> elements in the XML configuration file, or as attributes of the <PagerConfig> element when defined directly in the code. The following are available:

<table>
<thead>
<tr>
<th>Key name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayPager</td>
<td>Indicates if a pager should be included below the UniGrid. True by default.</td>
<td>&lt;key name=&quot;DisplayPager&quot; value=&quot;false&quot; /&gt;</td>
</tr>
<tr>
<td>DefaultPageSize</td>
<td>Defines the default amount of rows displayed on one UniGrid page.</td>
<td>&lt;key name=&quot;DefaultPageSize&quot; value=&quot;10&quot; /&gt;</td>
</tr>
<tr>
<td>PageSizeOptions</td>
<td>This setting can be used to override the default values offered by the page size selection drop-down list. Values must be separated by commas.</td>
<td>&lt;key name=&quot;PageSizeOptions&quot; value=&quot;10,20,##ALL##&quot; /&gt;</td>
</tr>
<tr>
<td></td>
<td>The ##ALL## macro can be used as a value to indicate that all rows should be displayed.</td>
<td></td>
</tr>
</tbody>
</table>
ShowDirectPageControl | Indicates whether a drop-down list used for direct page selection should be displayed. | `<key name="ShowDirectPageControl" value="true" />`

ShowFirstLastButtons | Indicates whether the buttons that link to the first and last page should be displayed. | `<key name="ShowFirstLastButtons" value="false" />`

ShowPageSize | Indicates whether the page size selection drop-down list should be displayed. | `<key name="ShowPageSize" value="false" />`

ShowPreviousNextButtons | Indicates whether the buttons that link to the previous and next page page should be displayed. | `<key name="ShowPreviousNextButtons" value="false" />`

ShowPreviousNextPageGroup | Indicates whether the buttons that link to the next group of page links should be displayed. | `<key name="ShowPreviousNextPageGroup" value="false" />`

VisiblePages | Determines the amount of displayed page links in one group. | `<key name="VisiblePages" value="5" />`

### `<options>` `<GridOptions>`:

This element is used to define additional settings and special features of the UniGrid control. You can either add the settings as child `<key>` elements in the XML configuration file, or as attributes of the `<GridOptions>` element when defined directly in the code. The following are available:

<table>
<thead>
<tr>
<th>Key name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayFilter</td>
<td>Indicates whether a filter should be displayed above the UniGrid. If the amount of displayed rows is lower than the value of the FilterLimit key, the filter will be hidden despite this setting.</td>
<td><code>&lt;key name=&quot;DisplayFilter&quot; value=&quot;true&quot; /&gt;</code></td>
</tr>
<tr>
<td>FilterLimit</td>
<td>Determines the minimum amount of rows that must be displayed in the UniGrid before a filter is shown. The default value is read from the CMSDefaultListingFilterLimit web.config key.</td>
<td><code>&lt;key name=&quot;FilterLimit&quot; value=&quot;10&quot; /&gt;</code></td>
</tr>
<tr>
<td>ShowSelection</td>
<td>Indicates whether a column allowing the selection of rows should be displayed on the left of the UniGrid. This can be used to perform mass actions affecting multiple rows. The selected rows can be accessed through the <code>SelectedItems</code> property of the UniGrid.</td>
<td><code>&lt;key name=&quot;ShowSelection&quot; value=&quot;true&quot; /&gt;</code></td>
</tr>
<tr>
<td>SelectionColumn</td>
<td>Name of the column used as an item in the array of selected rows which can be accessed through the <code>SelectedItems</code> property of the UniGrid. By default the first</td>
<td><code>&lt;key name=&quot;SelectionColumn&quot; value=&quot;SiteName&quot; /&gt;</code></td>
</tr>
</tbody>
</table>
1.9.3 UniSelector

1.9.3.1 Overview

The UniSelector is a user control that can be used to make a selection from a list of objects of a specified data class, such as users, sites etc. Several different selection modes are supported, as is extensive customization. This control can be found in many places within the user interface of Kentico CMS.

Another advantage provided by the UniSelector over standard selection controls, such as the DropDownList, is greater performance and scalability, since it is optimized to handle very large amounts of objects.

Please be aware that using the UniSelector control beyond its most basic functions requires some knowledge of coding and Kentico CMS API, because when a selection is made, the control only stores the values of the selected objects. Any additional functionality, such as database changes, must be implemented in the handlers of the control's events or using the Click event of a Button control used for confirmation. A basic example can be found in the next topic.

The following topics are available to help you familiarize yourself with the UniSelector control:

- **Getting started** - contains a step-by-step tutorial that allows you to learn the basics of using the control
- **Configuration** - describes the properties and events available for the control

1.9.3.2 Getting started

The following is a step-by-step tutorial that will show you how to use the UniSelector user control to allow the selection of users from the system and perform a basic task with the selected user:


2. Add the following directive to the beginning of the page code to register the UniSelector control:

   ```csharp
   <%@ Register src="~/CMSAdminControls/UI/UniSelector/UniSelector.ascx" tagname="UniSelector" tagprefix="cms" %>
   ```

3. Modify the `<%@ Page %>` directive at the top of the code as in the following example:

   ```csharp
   ```

The **Theme** attribute was added with its value set to "Default", which specifies the default theme used to
4. Now add the following code into the content area of the page (by default between the `<div>` tags inside the `<form>` element):

```xml
<ajaxToolkit:ToolkitScriptManager ID="manScript" runat="server" EnableViewState="false" />
<table>
<tr>
    <td>
        <cms:UniSelector ID="UserSelector" runat="server" ObjectType="cms.user" SelectionMode="SingleDropDownList" ReturnColumnName="UserName" />
    </td>
</tr>
<tr>
    <td>
        <asp:Button runat="server" ID="OKButton" onclick="OKButton_Click" CssClass="SubmitButton" Text="OK" />
    </td>
</tr>
<tr>
    <td>
        <asp:Label runat="server" ID="lblButton" Visible="false" />
    </td>
</tr>
</table>
```

This adds the UniSelector control, which is configured to allow the selection of user objects from a drop-down list and to use the content of the UserName column in its value. For more information about the available properties of the control, please refer to the Configuration topic. The code also contains a Button and Label control, organized in a basic table layout, which will be used to demonstrate how a basic task can be performed with the value of the UniSelector.

The ToolkitScriptManager control is required by the UniSelector control. It is only there to ensure that the example is functional by itself and will usually be included on your website's master page, so you do not have to add it in real-world scenarios.

5. Switch to the code behind of the User_UniSelector.aspx web form and add the following code into it. Please keep in mind that the name of the class will be different according to the location of your web form.

[C#]

```csharp
using CMS.GlobalHelper;

public partial class UniSelectorExample_User_UniSelector : System.Web.UI.Page
{
    /// <summary>
    /// Handles the Click event of the submit button.
    /// </summary>
    protected void OKButton_Click(object sender, EventArgs e)
```
This code causes the user name of the selected user to be displayed when the button on the page is clicked. This code would also work if the UniSelector control used a `SelectionMode` that allowed the selection of multiple users, the user names would all be displayed separated by semicolons.

This example only serves as a demonstration and the selection has no permanent effect, however, any required functionality, such as changes in the database, can be implemented using the Kentico CMS API in a similar fashion. Another option is to use handlers of the UniSelector events listed in the `Configuration` topic.

6. Save the changes to both files. Now right-click the web form in the Solution explorer and select `View in Browser`. The resulting page should display a drop-down list containing user names and an `OK` button like in the following image:

![Drop-down list](none)

If you select a user and click the button, the user name of the user will be displayed below:

![User name](Andrew Jones)

1.9.3.3 Configuration

The following properties of the UniSelector control can be set or used in the API:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AdditionalColumns</td>
<td>Contains the names of columns that should be loaded with the objects of the specified data class in addition to those required by default.</td>
<td></td>
</tr>
<tr>
<td>AllowAll</td>
<td>Indicates whether the selector allows the <code>all</code> value.</td>
<td></td>
</tr>
<tr>
<td>AllowEditTextBox</td>
<td>Indicates whether the value of the TextBox displayed in <code>SingleTextBox</code> or <code>MultipleTextBox</code> <code>SelectionMode</code> can be manually edited.</td>
<td></td>
</tr>
<tr>
<td>AllowEmpty</td>
<td>Indicates whether the selector allows an</td>
<td></td>
</tr>
</tbody>
</table>
empty value.

If enabled, the (none) value is available in `SingleDropDownList SelectionMode` and the **Clear** button is displayed in `SingleTextBox` and `MultipleTextBox` mode.

When an empty value is used, the **Value** of the control is by default 0 in `SingleDropDownList SelectionMode` or an empty string in the remaining modes.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllRecordValue</td>
<td>Contains the value used when the (all) item is selected in <code>SingleDropDownList SelectionMode</code>. The default value is -1.</td>
</tr>
<tr>
<td>ButtonImage</td>
<td>Can be used to enter a path to an image. If specified, the selection button is displayed as a <code>LinkButton</code> using this image. Only applies if the <code>SelectionMode</code> is <code>SingleButton</code> or <code>MultipleButton</code>.</td>
</tr>
<tr>
<td>CacheMinutes</td>
<td>Number of minutes that the content of the control is cached for, so that it doesn't have to be retrieved from the database each time a user requests the page.</td>
</tr>
<tr>
<td></td>
<td>Zero indicates that caching will not be used.</td>
</tr>
<tr>
<td></td>
<td>-1 indicates that the site-level settings should be used.</td>
</tr>
<tr>
<td></td>
<td>Please refer to the [Caching][1] topic to learn more.</td>
</tr>
<tr>
<td>DialogWindowHeight</td>
<td>Determines the default height of the opened selection window.</td>
</tr>
<tr>
<td>DialogWindowName</td>
<td>Can be used to specify the name of the selection window to prevent conflicts between multiple UniSelector controls.</td>
</tr>
<tr>
<td>DialogWindowWidth</td>
<td>Determines the default width of the opened selection window.</td>
</tr>
<tr>
<td>DisplayNameFormat</td>
<td>Used to modify the format of the display names of objects in the selection list.</td>
</tr>
<tr>
<td></td>
<td>To correctly display values dependant on individual objects, macro expressions in format <code>{%ColumnName%}</code> must be used here. The columns required by the used macros are loaded automatically.</td>
</tr>
<tr>
<td>EditItemPageUrl</td>
<td>Can be used to specify the URL of a custom</td>
</tr>
</tbody>
</table>
A page that handles the editing of the selected object. If a value is entered, an edit button that links to the specified URL is displayed. Only available for `SingleTextBox` and `SingleDropDownList SelectionMode`.

The URL may contain macros in format `##<ITEM>ID##`, which will be resolved into the value of the selected object's ID column. For example, `<url>?userid=##USERID##` would contain the ID of the currently selected user for a UniSelector set to use the `cms.user ObjectType`.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>EditWindowName</code></td>
<td>Can be used to specify the name of the object editing window to prevent conflicts between multiple UniSelector controls.</td>
</tr>
<tr>
<td><code>EmptyReplacement</code></td>
<td>Contains a string that is used in the selection list as a replacement value for objects whose display name column is empty.</td>
</tr>
<tr>
<td><code>Enabled</code></td>
<td>Indicates whether the control is enabled.</td>
</tr>
<tr>
<td><code>EnabledColumnName</code></td>
<td>Can be used to specify the name of the column that determines if the selected object is enabled.</td>
</tr>
<tr>
<td><code>FilterControl</code></td>
<td>Path to the filter control (.ascx file; must inherit from the <code>CMSAbstractBaseFilterControl</code> class) that will be used for custom filtering of objects in the selection window.</td>
</tr>
<tr>
<td><code>GridName</code></td>
<td>Path to the XML configuration file of the <code>UniGrid</code> control used to display and select objects in <code>Multiple SelectionMode</code>.</td>
</tr>
<tr>
<td><code>IconPath</code></td>
<td>Can be used to enter the path to the image used in the title of the selection window.</td>
</tr>
<tr>
<td><code>ItemsPerPage</code></td>
<td>Can be used to set the maximum amount of displayed selected items per page in <code>Multiple SelectionMode</code>.</td>
</tr>
<tr>
<td><code>LocalizeItems</code></td>
<td>Indicates whether localization macros should be resolved in the control.</td>
</tr>
<tr>
<td><code>MaxDisplayedItems</code></td>
<td>Determines the maximum amount of items displayed in the list in <code>SingleDropDownList SelectionMode</code> if the number of selectable objects is higher than the value of the <code>MaxDisplayedTotalItems</code> property. The remaining objects can be selected in a dialog opened through the <code>(more...) list...</code></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MaxDisplayedTotalItems</td>
<td>If the total number of selectable objects is lower than the value of this property, all of them will be available in the list in <code>SingleDropDownList SelectionMode</code>. If there are more items, the length of the list will match the value of the <code>MaxDisplayedItems</code> property and the <code>(more..)</code> option will be included. The default value is 50. You can also set this value globally for all UniSelectors in your project through the <code>CMSSelectorMaxDisplayedTotalItems</code> key that can be added to the <code>&lt;appSettings&gt;</code> section of your <code>web.config</code>.</td>
</tr>
<tr>
<td>NewItemPageUrl</td>
<td>Can be used to specify the URL of a custom page that handles the creation of new objects. If a value is entered, a new button that links to the specified URL is displayed. Only available for <code>SingleTextBox SelectionMode</code>.</td>
</tr>
<tr>
<td>NoneRecordValue</td>
<td>Contains the value used when the <code>(none)</code> item is selected in <code>SingleDropDownList SelectionMode</code>. The default value is 0.</td>
</tr>
<tr>
<td>ObjectType</td>
<td>Specifies the data class of the objects to be selected.</td>
</tr>
<tr>
<td>OrderBy</td>
<td>Contains the ORDER BY clause used to determine the order of objects. Also affects the order in the selection window.</td>
</tr>
<tr>
<td>RemoveConfirmation</td>
<td>Can be used to specify the text displayed in the confirmation message displayed when removing selected items from the UniSelector. Entering an empty string disables the confirmation message.</td>
</tr>
<tr>
<td>ResourcePrefix</td>
<td>Determines the prefix that is used in the full names of resource strings (Keys) containing the labels of the various interface elements displayed by the UniSelector. This can be used to assign custom strings to the control. Custom strings can be created at <code>CMS Site Manager -&gt; Development -&gt; UI cultures -&gt; ... edit (승) a UI culture ... -&gt; Strings</code>. The keys of these strings must use the prefix specified here.</td>
</tr>
<tr>
<td>Option</td>
<td>The default value is 25.</td>
</tr>
</tbody>
</table>
The following string names are available for the UniSelector:

- **additems** - text caption of the add items button used to open the selection window in **Multiple** mode
- **all** - name of the list item representing the selection of all available objects in **SingleDropDownList** mode
- **clear** - text caption of the clear button used in **TextBox** modes
- **edit** - text caption of the edit button used in **SingleTextBox** and **SingleDropDownList** mode
- **empty** - name of the list item representing an empty selection in **SingleDropDownList** mode
- **itemname** - header text of the column containing the names of objects in the selection window and the UniGrid displaying selected objects in **Multiple** mode
- **moreitems** - name of the list item that opens the selection window if the maximum amount of list items is exceeded in **SingleDropDownList** mode
- **new** - text caption of the new button used in **SingleTextBox** mode
- **newitem** - name of the list item that opens the new item page in **SingleDropDownList** mode
- **nodata** - text message displayed in **Multiple** mode if no objects are selected and the **ZeroRowsText** property is not defined
- **pleaseselectitem** - text of the JavaScript alert displayed when the edit button is used when no object is selected
- **removeall** - text caption of the button used to deselect all objects in **Multiple** mode
- **removeselected** - text caption of the button used to deselect the specified objects in **Multiple** mode
- **select** - text caption of the select button used to open the selection window in **TextBox** and **Button** modes
- **selectitem** - text of the labels associated with the action elements used by the
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>UniSelector</td>
<td>This is also used to set the title of the selection window</td>
<td></td>
</tr>
<tr>
<td>ReturnColumnName</td>
<td>Specifies the name of the column used for the values of selected objects by the UniSelector. If empty, the ID column is used. To ensure correct functionality of the control, the column must be a unique identifier for the given object type.</td>
<td></td>
</tr>
<tr>
<td>SelectionMode</td>
<td>Determines the design of the selection dialog displayed by the control. The value of this property affects the behaviour of many of the other properties of the UniSelector control. The following modes are available:</td>
<td>&quot;SingleTextBox&quot; &quot;MultipleTextBox&quot; &quot;SingleDropDownList&quot; &quot;Multiple&quot; &quot;SingleButton&quot; &quot;MultipleButton&quot;</td>
</tr>
<tr>
<td>SpecialFields</td>
<td>Can be used to get or set a two dimensional string array that contains custom items to be displayed in SingleDropDownList SelectionMode. The first value in the array is the name of the item in the list, the second represents the value of that item when it is selected.</td>
<td></td>
</tr>
<tr>
<td>UseDefaultNameFilter</td>
<td>Indicates whether the default name filter should be used in the selection window. Can be used todisable the default filter if a custom filter is specified through the</td>
<td></td>
</tr>
</tbody>
</table>
The following events of the UniSelector control are available:

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OnItemsSelected</td>
<td>Occurs when an object or objects are selected in SingleButton and MultipleButton Selection Mode. This event is not raised in other modes.</td>
</tr>
<tr>
<td>OnSelectionChanged</td>
<td>Occurs when the set of selected objects is changed. The event is not raised in SingleButton or MultipleButton SelectionMode and may not always be triggered in TextBox modes depending on how the selection is changed. This event is usually used to perform tasks with selected objects in Multiple mode without the need for a confirmation button.</td>
</tr>
</tbody>
</table>
Index

- B -
Basic controls - Listings and viewers
  BasicCalendar 47
  BasicDataGrid 50
  BasicDataList 53
  BasicRepeater 57
  BasicUniView 61
Basic controls - Navigation
  BasicTabControl 42

- C -
CMS controls - Buttons
  CMSEditModeButtonAdd 153
  CMSEditModeButtonEditDelete 155
CMS controls - Editable regions
  CMSEditableImage 158
  CMSEditableRegion 160
  CMSPageManager 162
CMS controls - Listings and viewers
  CMSCalendar 115
  CMSDataGrid 117
  CMSDataList 120
  CMSDocumentValue 123
  CMSRepeater 124
  CMSUniView 127
  CMSViewer 134
CMS controls - Listings and viewers - Custom query
  QueryDataGrid 138
  QueryDataList 140
  QueryRepeater 143
  QueryUniView 146
CMS controls - Navigation
  CMSBreadCrumbs 77
  CMSListMenu 80
  CMSMenu 86
  CMSSiteMap 91
  CMSTabControl 95
  CMSTreeMenu 98
  CMSTreeView 103
CMS controls - Search
  CMSSearchDialog 166

- G -
Generic controls
  UniView 17
Generic controls - Pagers
  DataPager 24
  TemplateDataPager 28
  UniPager 32

- U -
UI controls
  UniGrid 175
  UniSelector 196